Understanding and Using Winstone® 96 Version 1.0

�LICENSE AGREEMENT FOR ZIFF-DAVIS’ WINSTONE® 96 VERSION 1.0

READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE EMBODIED IN THE WINSTONE® 96 VERSION 1.0 CD�ROM OR, IF PRELOADED ON YOUR HARD DISK, DOWNLOADED OR IF PROVIDED AS PART OF A COLLECTION, THE PRELOADED, DOWNLOADED OR COLLECTED FILE(S) (the “Media”). Embodied in the Winstone 96 Media is the Winstone 96 computer program and related documentation (the “Winstone 96 Program”) and application programs and related documentation (the “Application Programs”). The Winstone 96 Program and the Application Programs are collectively referred to herein as the “Software.” Ziff-Davis Publishing Company, having a place of business at One Park Avenue, New York, New York 10016 (“Ziff-Davis”) is the licensor under this Agreement and you are the licensee. By using the Software, in whole or in part, you agree to be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, promptly return the Software to the Ziff-Davis Benchmark Operation at 1001 Aviation Parkway, Suite 400, Morrisville, North Carolina 27560 (or, if downloaded or preloaded on your hard disk, delete the Software, or if provided as part of a collection, cease use of the Software). Title to the Winstone 96 Program and all copyrights, trade secrets and other proprietary rights therein are owned by Ziff-Davis. All rights therein, except those expressly granted to you in this Agreement, are reserved by Ziff-Davis. Title to each of the Application Programs, and all copyright, trade secrets and other proprietary rights therein, are owned by the publishers of the Application Programs. All rights in the version of each Application Program embodied in the CD-ROM (or if preloaded on your hard disk or downloaded or if provided as part of a collection, in the preloaded, downloaded or collected files(s)), except those expressly granted to you in this Agreement and to Ziff-Davis, are reserved by the publisher of that Application Program. 

1.	Limited License

This Agreement grants you only limited rights to use the Software. Ziff-Davis grants you a non-exclusive, non-transferable license to use the Software on a single dedicated computer or on a file server networked with multiple PC computers for the sole purpose of conducting benchmark tests to measure the performance of computer hardware and operating system configurations. You have the right to make a single copy of the Software for archival purposes and the right to transfer a copy of the Software across an internal local area network only to the PC computers attached to such network; provided, however, that all such copies are considered Software hereunder, that all uses of such copies are governed by the terms and conditions of this Agreement and that you shall be responsible for all uses of such copies in violation of the terms and conditions of this Agreement. The only right you are granted with respect to the use of the Application Programs is the right to use such Application Programs only in conjunction with the Winstone 96 Program and only when the Winstone 96 Program is running.

Any and all other uses and reproductions (except for the making of an archival copy of Winstone 96) of such Application Programs as part of the Software are outside the scope of the license granted to you hereunder and are prohibited under the terms and conditions hereof. By way of example only, and without limiting any of the foregoing, you do not have the right (by electronic transfer or by any other means) to directly or indirectly (or to permit other persons or entities to directly or indirectly) (a) make a copy of any of the Application Programs or part thereof (except for an archival copy as provided above), (b) run, operate or use any of the Application Programs or any portion of any Application Program independently of the Winstone 96 Program, or (c) publish or distribute any of the Application Programs or any portion of any Application Program (except as required in a network environment as provided above). Ziff-Davis hereby grants you the right to publish, except in any country where a third party claims during the term of this license that such distribution infringes that party’s proprietary rights, benchmark test results obtained by you from your use of the Software provided that with the publication of each such result you: 

A.	Identify Ziff-Davis, the name and version number of the benchmark Software used (i.e., Ziff-Davis’ Winstone® 96 ver. 1.0);

B.	Identify the specific Winstone 96 score(s) being reported and in all cases include the Winstone 96 overall score.

C.	Identify the exact name, processor speed and type, amount of RAM, amount of secondary RAM cache, if any, hard disk model, type of hard disk controller, and size of hardware hard disk cache, if any, of the PC used for the test (e.g., WXY Corp. Model 466 with 66�MHz Intel�SYMBOL 226 \f "Symbol"� 486DX2�66 CPU, 8MB of RAM, 64KB RAM cache, 200MB hard disk, IDE controller, and no hardware disk cache); 

D.	Identify the exact graphics adapter name, amount and type of RAM on it, graphics driver name and date, refresh rate, Microsoft�SYMBOL 210 \f "Symbol"� Video for Windows�SYMBOL 210 \f "Symbol"� version, and CODEC version that produced the result (e.g., XYZ Corp. XYZ Graphics adapter with 2MB VRAM with XYZ.DRV version 1.1 driver, a refresh rate of 72 Hz, Microsoft Video for Windows version 1.1e, and Intel Indeo�SYMBOL 228 \f "Symbol"� Video version 3.2 CODEC); 

E.	Identify the exact CD-ROM drive model, CD-ROM controller model, CD-ROM controller RAM cache size (if any), and CD-ROM-specific software cache and size (if any) that produced the result (e.g., XYZ Corp. XYZ CD-ROM Quad-Speed drive, XYZ Corp. CD-ROM controller, with no controller RAM cache and no CD-ROM specific software cache); 

F. 	Identify the operating system version (e.g., MS�DOS�SYMBOL 210 \f "Symbol"� 5.0 and Microsoft Windows 3.1), size and type of software disk cache, if any (e.g., SMARTDRV 2MB cache), graphics resolution and color depth (e.g., 800 by 600 pixels with 256 colors), and any other special conditions used to achieve the result (e.g., disk compression utility ABC version 1.0 enabled); 

G.	State that all products used in the test were shipping versions available to the general public;

H.	State that the test was performed without independent verification by Ziff-Davis and that Ziff-Davis makes no representations or warranties as to the result of the test; and 

I.	Follow proper trademark usage and acknowledge Ziff-Davis' trademark rights (e.g., “[ ] achieved an overall score of X Winstone® 96 ver. 1.0 units. Winstone is a registered trademark or trademark of Ziff-Davis Publishing Company in the U.S. and other countries.”). 

This Agreement and your rights hereunder shall automatically terminate if you fail to comply with any provision of this Agreement. Upon such termination, you agree to cease all use of the Software, cease the transfer of any copies of the Software and cease the publication of benchmark test results obtained by you from use of the Software. Further you agree to delete the Software and to destroy all tangible copies of the Software and other materials related to the Software in your possession or under your control, or, if downloaded or preloaded on your hard drive or if provided as part of a collection, to cease use of and to destroy any and all copies of the Software in your possession or under your control.

2.	Additional Restrictions

A.	You shall not (and shall not permit other persons or entities to) rent, lease, sell, sublicense, assign, or otherwise transfer the Software or this Agreement. Any attempt to do so shall be void and of no effect.

B. 	You shall not (and shall not permit other persons or entities to) reverse engineer, decompile, disassemble, merge, modify, include in other software or translate the Software, or use the Software for any commercial purposes, except for the publication of test results, as provided above.

C.	You shall not (and shall not permit other persons or entities to) remove or obscure Ziff-Davis’ copyright, trademark or other proprietary notices or legends from any of the materials contained in this package or downloaded.

D.	You acknowledge that the Software contains Ziff-Davis’ trade secret information and you agree not to disclose or disseminate such information other than as provided herein.

3.	Limited Warranty and Limited Liability

THE SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU, AND ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS ASSUME NO RESPONSIBILITY FOR THE ACCURACY OR APPLICATION OF OR ERRORS OR OMISSIONS IN THE SOFTWARE. IN NO EVENT SHALL ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS HAVE BEEN ADVISED OF THE LIKELIHOOD OF SUCH DAMAGES OCCURRING. ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS SHALL NOT BE LIABLE FOR ANY LOSS, DAMAGES OR COSTS, ARISING OUT OF, BUT NOT LIMITED TO, LOST PROFITS OR REVENUE, LOSS OF USE OF THE SOFTWARE, LOSS OF DATA OR EQUIPMENT, THE COSTS OF RECOVERING SOFTWARE, DATA OR EQUIPMENT, THE COST OF SUBSTITUTE SOFTWARE OR DATA, CLAIMS BY THIRD PARTIES, OR OTHER SIMILAR COSTS.

THE ONLY WARRANTY MADE BY ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS IS THAT THE ORIGINAL PHYSICAL MEDIA IN WHICH THE SOFTWARE IS EMBODIED AND WHICH IS DISTRIBUTED BY ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS SHALL BE FREE OF DEFECTS IN MATERIALS AND WORKMANSHIP. ZIFF-DAVIS’ ENTIRE LIABILITY AND THE USER’S EXCLUSIVE REMEDY SHALL BE LIMITED TO THE REPLACEMENT OF THE ORIGINAL PHYSICAL MEDIA IF DEFECTIVE. THE WARRANTIES AND REMEDIES SET FORTH HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. NO ZIFF-DAVIS DISTRIBUTOR, AGENT OR EMPLOYEE, OR THIRD PARTY, IS AUTHORIZED TO MAKE ANY MODIFICATION OR ADDITION TO THIS WARRANTY.

SOME STATES DO NOT ALLOW EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES OR LIMITATION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES; SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU.

4.	U.S. Government Restricted Rights

The Software is licensed subject to RESTRICTED RIGHTS. Use, duplication or disclosure by the Government or any person or entity acting on its behalf is subject to restrictions as set forth in subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS (48 CFR 252.227-7013) for DoD contracts, in paragraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights clause in the FAR (48 CFR 52.227-19) for civilian agencies, or in the case of NASA, in Clause 18-52.227-86(d) of the NASA Supplement to the FAR, or in other comparable agency clauses. The contractor/manufacturer is the Ziff-Davis Benchmark Operation, 1001 Aviation Parkway, Suite 400, Morrisville, North Carolina 27560.

5.	General Provisions

Nothing in this Agreement constitutes a waiver of Ziff-Davis’ rights under U.S. copyright laws or any other Federal, state, local or foreign law. You are responsible for installation, management, and operation of the Software. This Agreement shall be construed, interpreted and governed under New York law. If any provision of this Agreement shall be held by a court of competent jurisdiction to be illegal, invalid or unenforceable, the remaining provisions shall remain in full force and effect.

Trademarks

MacBench®, NetBench®, ServerBench®, WinBench®, and Winstone® are registered trademarks of Ziff�Davis Publishing Company.

Adobe™ and PageMaker™ are trademarks of Adobe Systems Incorporated.

Borland®, dBASE®, and Paradox® are registered trademarks of Borland International, Inc.

CorelDRAW!™ is a trademark of Corel Corporation.

Dell® is a registered trademark of Dell Computer Corporation.

Intel® is a registered trademark and Pentium™ is a trademark of Intel Corporation.

Lotus®, 1-2-3®, and Ami Pro® are registered trademarks of Lotus Development Corporation.

Microsoft®, Microsoft Access®, MS-DOS®, PowerPoint®, and Windows® are registered trademarks and Windows NT™ is a trademark of Microsoft Corporation.

NetWare®, Novell®, WordPerfect®, and Quattro® are registered trademarks of Novell, Inc.

OS/2® is a registered trademark of International Business Machines Corporation.

Copyrights
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CorelDRAW! version 5.0E2 © 1994, Corel Corporation. All rights reserved.
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This is the reference manual for Winstone® 96. This manual provides information on installing and using Winstone 96 as well as information on interpreting results.

NOTE:	Before you do anything with the software, you need to read the license agreement at the front of this manual. (The same license agreement appears on the PC’s screen the first time you start Winstone 96.)

This section lists the different parts of this manual, the conventions the manual uses, and other available Winstone 96 documentation.

Finding the information you need

There are several ways you can find the information you need in this manual. In addition to the Table of Contents and Index, you’ll find a reading path chart at the beginning of this manual (just after the license agreement pages). If you’re uncertain which chapters or sections you need to read, you can consult that chart for a reading path that may be appropriate for you.

To make it easier to find the information you need, this manual includes the following parts:

Part 1:	� REF Part1GettingtoKnow \* MERGEFORMAT �Getting to Know Winstone 96��Provides an introduction to the benchmark.

Part 2:	� REF Part2InstallingandSettingUpWS \* MERGEFORMAT �Installing and Setting Up Winstone 96��Explains how to install and setup the Winstone 96 software.

Part 3:	� REF Part3RunningWS \* MERGEFORMAT �Running Winstone 96��Discusses things you need to know before you run Winstone 96, explains how to run Winstone 96’s suites and save scores, and provides information on the benchmark’s Disclosure.

Part 4:	� REF Part4AnalyzingResults \* MERGEFORMAT �Analyzing Results��Explains how to use the results database, discusses what the numbers mean about a PC’s performance and can affect a PC’s results, and tells what information you must include about a PC if you publish its Winstone 96 scores.

Part 5:	Looking Under the Hood—How Winstone 96 Works�Explains what went into the benchmark’s development, what the suites do when you run them, and how the benchmark calculates its scores.

Part 6:	� REF Part6IfYouHaveaProblem \* MERGEFORMAT �If You Have a Problem��Provides troubleshooting information and explains how to contact Ziff-Davis if you have a problem with the benchmark.

This manual also includes the following appendices:

Appendix A:	� REF AppendixADatabaseFiles \* MERGEFORMAT �The Database Files��Lists and describes all the database files Winstone 96 creates when you save results to a database.

Appendix B:	� REF AppendixBCustomConfigFile \* MERGEFORMAT �The Custom Configuration File��Explains in detail how to build a custom configuration file.

Conventions this manual uses

� XE "Manual conventions" �� XE "Winstone 96:Manual conventions" �This manual uses a few general conventions. For example, it:

Uses the pronoun “we” to refer in general to either the Ziff-Davis Benchmark Operation (ZDBOp) or Ziff-Davis.

Uses bold type face for DOS and Windows commands, file names, and directory names. For example, you’ll see sentences similar to the following:

“The WS96REF.DOC file is in the \ZDBENCH\DOCS\WS96\REF directory on the CD�ROM.”

Uses a monospace or typewriter font for information you must enter verbatim from the command line. The manual also displays system responses that appear on the PC’s screen in the same font. For example:

D:\ZDBENCH\WS96\SETUP.EXE

Uses the terms “select” and “choose” in the same way Windows documentation uses these terms. In Windows documentation, the terms “select” and “choose” have different, and specific, meanings. When you select an item, you mark it with the selection cursor, and the selection appears as a highlight, a dotted rectangle, or both. You also select check boxes in dialog boxes. Selecting alone doesn’t initiate an action.

You choose an item to carry out an action. For example, when you choose the Winstone 96 icon, Winstone 96 opens its main window. You can also choose an item from a menu or choose a command button in a dialog box. You often need to select an item before you can choose it.

Available Winstone 96 documentation� XE "Winstone 96:Documentation, what’s available" �� XE "Documentation:What’s available" �

This document:�Is located in the:�And contains:��README.WRI�\ZDBENCH\WS96 directory on the CD�ROM.�The license agreement, a list of new features, and a list of known problems as of the CD�ROM’s release.��Winstone® 96 Version 1.0 Tester’s Handbook�(WS96HBK.*)�\ZDBENCH\DOCS\WS96\HANDBOOK directory on the CD�ROM. The CD�ROM may include three different formats of the handbook (.DOC, .TXT, and .RTF).�The minimum information you need to install Winstone 96, run the tests, and analyze the results.

The on�line help contains most of the information in the tester’s handbook.��Understanding and Using Winstone® 96 Version 1.0�(WS96REF.*)�\ZDBENCH\DOCS\WS96\REF directory on the CD�ROM. The CD�ROM may include three different formats of the manual (.DOC, .TXT, and .RTF).�The Winstone 96 reference manual. (This is the document you’re reading now.)��End of About this Manual
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�Part 1: �Getting to Know Winstone 96

Chapter 1:	� REF Chapter1IntroducingWS \* MERGEFORMAT �Introducing Winstone 96��Provides an introduction to the Winstone 96 basics.

Chapter 2:	� REF Chapter2WhatsNew \* MERGEFORMAT �What’s New in This Release��Lists the improvements and changes for this release of Winstone.

Chapter 3:	� REF Chapter3KeyConcepts \* MERGEFORMAT �Winstone 96 Key Terms��Briefly explains the general Winstone 96 terms and concepts this manual uses.

�Chapter 1: �Introducing Winstone 96

This chapter provides a brief description of Winstone 96 and gives an overview of what the benchmark does when you run it.

Sections in this chapter

� REF _Ref298231824 \* MERGEFORMAT �Winstone 96 in a nutshell�

� REF _Ref333890045 \* MERGEFORMAT �Why you should use Winstone 96�

� REF _Ref333718569 \* MERGEFORMAT �What Winstone 96 does�

� REF _Ref333718577 \* MERGEFORMAT �Using other ZD benchmarks�

Winstone 96 in a nutshell

� XE "Winstone 96:In a nutshell" �Winstone 96 is a benchmark that runs test suites of Windows®-based applications. In developing Winstone 96’s suites, we did extensive research into which applications are leaders in today’s software market. We also did usability surveys and tests to determine how typical users work with these applications. The result of this research is an accurate and repeatable benchmark you can use to determine a PC’s overall performance when running today’s top-selling Windows�based applications.

Winstone 96 doesn’t mimic applications; it actually runs applications. When you choose one of Winstone 96’s test suites, it runs the application scripts associated with that suite. Each application script starts its application, performs tasks within that application, and exits the application. Winstone 96 times how long it takes each application script to complete and then computes a single, relative score for that test suite. You can compare a PC’s score with the scores of other PCs—higher scores mean faster overall performance.

Why you should use Winstone 96

� XE "Winstone 96:Why use it" �Like previous versions of the benchmark, Winstone 96 uses “market-centered” tests. It aims to measure the level of performance typical users will achieve while performing common operations with leading applications.

The results Winstone 96 produces will be useful to the vast majority of users, because most of spend a great deal of computing time working with the same basic classes of applications.

That’s not to say, however, that Winstone 96’s results will apply equally well to everyone or to every computing situation. If you spend all your time running CAD programs, Winstone 96’s results will not reflect your work. Even if you are such a user, however, you can use Winstone 96’s companion benchmark, WinBench 96®� XE "WinBench 96" �. (WinBench 96 comes on the CD-ROM with Winstone 96.) WinBench 96 provides literally hundreds of analysis tests that can help you gauge specific aspects of a PC’s performance.

Winstone 96 is an “application-based” benchmark. It runs real applications through a series of scripted activities and uses the time a PC requires to complete those activities to produce its performance scores.

The industry changes, and Ziff-Davis’ benchmarks must change to reflect it. New versions of applications have appeared, and those versions put different performance demands on PCs than previous versions. These changes make the upgrade to Winstone 96 even more critical.

What Winstone 96 does� XE "Winstone 96:What it does" �

With Winstone 96, you can run either all of Winstone 96’s application scripts (Overall Winstone 96 suite) or a subset of those scripts (a category suite).

The � XE "Winstone 96:Overall Winstone 96" �� XE "Overall Winstone 96" �Overall Winstone 96 suite provides a measure of a PC’s overall performance when running Windows�based applications.

Each� XE "Winstone 96:Category suite" �� XE "Category suite" � category suite provides a measure of how well a PC runs the applications within that category.

Running a Winstone 96 suite is like putting the program on automatic pilot. You select the suite you want to run, choose the Run button, and then Winstone 96 does the rest. Once Winstone 96 finishes a suite, it automatically displays its score in the Chart of Results.

�Winstone 96 includes the following suites:

This suite:�Runs the scripts for:��Overall Winstone 96�All of Winstone 96’s applications. (Our publications use the Overall Winstone 96 score when they evaluate a PC’s performance.)��Business Graphics/DTP�The business graphics and desktop publishing applications.��Database�The database applications.��Spreadsheet�The spreadsheet applications.��Word Processing�The word processing applications.��� XE "Winstone 96:Market research" �Market research indicates these four application categories have the largest percentage of the Windows�based application unit market share for today’s PC market.

Computer Intelligence/InfoCorp (CII),� XE "Computer Intelligence/InfoCorp (CII)� XE "InfoCorp" \t "See Computer Intelligence/InfoCorp (CII)" �� XE "CII" \t "See Computer Intelligence/InfoCorp (CII)" �" � a leading market research company, supplied the research data that determined the actual and projected unit market shares for the categories and the applications within the categories.

How Winstone 96 uses scripts in its testing� XE "Scripts:How Winstone 96 uses them" �� XE "Winstone 96:Scripts" �� XE "Application scripts" �

Winstone 96’s scripts execute commands within each application Winstone 96 runs. ZDBOp created these scripts using Microsoft Test� XE "Microsoft Test" � for Windows 3.0a, a general�purpose commercial scripting tool for Windows�based applications that writes, records, and plays back user actions.

Winstone 96 runs one script for each application. When Winstone 96 runs a script, it:

Copies the necessary files for the application from a base directory into a work directory to run the suite. (The base directory contains all the Winstone 96 files.)

Starts the application and sends commands to the application that perform tasks similar to those typical users perform while running the application.

Sends an exit command to the application.

Deletes the application files from the work directory.

ZDBOp used survey data and usability tests to define the specific tasks and task sequences typical users perform within each application.

As each script completes, Winstone 96 stores the time it took the PC to execute the commands within that application. Once all the applications have run, Winstone 96 uses the elapsed run time for each application in calculating its final score.

Using other ZD benchmarks

The CD-ROM that contains Winstone 96 also includes WinBench® 96. WinBench 96� XE "WinBench 96" � is a subsystem-level benchmark that measures the performance of a PC’s graphics, disk, processor, video, and CD-ROM subsystems in a Windows-based environment.

You can use ZD’s PC benchmarks to assess both overall PC performance and the performance of individual PC subsystems. Such a combination could be particularly helpful if your work relies heavily on the performance of a particular subsystem (such as CD-ROM, disk, graphics, or video). Taken together, these different benchmark scores provide a broad set of information on both overall performance and the performance of the PC’s subsystems.

For example, you may want to use Winstone 96 and WinBench 96 as a team. Winstone 96 measures the performance of a PC as a whole and the effect of component changes on overall system performance, whereas WinBench 96 returns data on the performance of the PC’s graphics, disk, processor, video, and CD-ROM subsystems.

In addition to the PC benchmarks, ZD has benchmarks for servers and Mac™ OS computers. To request a ZD benchmark, see the form at the back of this manual.

End of Chapter

�Chapter 2: �What’s New in This Release

Each year, we release a new generation of our PC benchmarks. During the year, we spend our time generally improving the benchmarks and fixing problems.

This chapter tells you about the changes and improvements we’ve made to Winstone 96 version 1.0. It also includes a list of the problems with Winstone 95 that Winstone 96 fixes.

Sections in this chapter

� REF _Ref298310679 \* MERGEFORMAT �How Winstone 96 has changed�

� REF _Ref334408503 \* MERGEFORMAT �Problems Winstone 96 fixes�

How Winstone 96 has changed

� XE "Winstone 96:New features" \r "WhatsNew" �This section briefly explains what has changed with this year’s benchmark.

�Updated applications

Winstone 96 includes the most current available versions of all the applications it uses in its tests. Here’s a list of Winstone 96’s categories, applications� XE "Applications, a list of" �, and application version numbers.� XE "Winstone 96:Application list" �� XE "Application list" �

Business Graphics/DTP:	Adobe™ PageMaker™ 5.0a for Windows�Corel Corporation CorelDRAW!® 5.0E2�Microsoft PowerPoint® 4.0c for Windows

Database:	Borland® dBASE® 5.0 for Windows�Borland Paradox® 5.0 for Windows�Microsoft Access® 2.0c for Windows�Microsoft Works 3.0b for Windows*

Spreadsheet:	Lotus® 1-2-3® Release 5 for Windows�Microsoft Excel 5.0c for Windows�Microsoft Works 3.0b for Windows*�Novell® Quattro® Pro 6.01 for Windows

Word Processing:	Lotus Ami Pro® Release 3.1 for Windows�Microsoft Word 6.0c for Windows�Microsoft Works 3.0b for Windows*�Novell WordPerfect® 6.1 for Windows

Configuration check before test runs

� XE "Winstone 96:Configuration check" �� XE "Winstone 96:Configuration Information window" �� XE "Configuration Information window" �Winstone 96 checks the PC under test to make sure it meets a minimum set of requirements before a test run begins. If Winstone 96 finds any areas that may cause the test to fail, it reports those areas in the new Configuration Information window. (For information on disabling the configuration check, see page � PAGEREF _Ref327694563 �41�.)

�NOTE:	You can open the Configuration Information window from the Run menu on the main window menu bar without running a test suite.

You can also use the Configuration Information window to compare the test PC with either a pre-set list of optimization tips or a custom configuration file you create.

The Configuration Information window has three sections:

Potential Problems. � XE "Winstone 96:Configuration check:Potential Problems" �� XE "Winstone 96:Configuration check:Potential Problems" �� XE "Configuration Information window:Potential Problems" �Lists any area of the PC’s setup and configuration that doesn’t meet the minimum test requirements.

Optimization Tips. � XE "Winstone 96:Configuration check:Optimization Tips" �� XE "Optimization Tips" �� XE "Configuration Information window:Optimization Tips" �Compares the PC’s setup and configuration to a pre-set list of optimization tips.

Custom Configuration File. � XE "Winstone 96:Configuration check:Custom Configuration File" �� XE "Custom Configuration File" �� XE "Configuration Information window:Custom Configuration File" �Compares the PC’s setup and configuration to a custom configuration file. For information on using a custom configuration file, see page � PAGEREF _Ref327694797 �40�.

For more information on this new feature, see Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�, beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37�.

Improved cleanup program

� XE "Winstone 96:Cleanup program" �As with previous versions of Winstone, when you exit the benchmark program, it restores the test PC to its original state. However, Winstone 96 includes an improved cleanup program that automatically restores the PC to its pretest state even when there are problems with the benchmark’s test run.

For example, if you need to interrupt a Winstone 96 test run, or if Winstone 96 halts, stops, or hangs the PC and you must exit Winstone 96 in any way other than clicking the Exit button, all you need to do is restart Windows. Winstone 96’s cleanup program will automatically run when you restart Windows and restores the PC’s system files.

�Disclosure fields for multimedia

� XE "Winstone 96:Disclosure:Multimedia fields" �� XE "Disclosure:Multimedia fields" �Winstone 96 includes new Disclosure fields for multimedia. The following table lists the new fields as they appear in the WST_SYS.DBF� XE "WST_SYS.DBF" � results file.� XE "Winstone 96:Results:Files" �

NOTE:	The following list shows the fields exactly as they appear in the results file. If you use a .DBF�compatible application to view the file, the fields may appear in a different order.

Result:�Result field name:�Field type:�Width (bytes):��CD-ROM drive description�CD_DRV_DES�Character�80��CD-ROM controller description�CD_CONT_DE�Character�80��CD-ROM controller RAM �CD_CONT_RA�Character�10��CD-ROM software cache description�CD_SCH_DES�Character�80��CD-ROM software cache size�CD_SCH_SZ�Character�10��Sound adapter description�SND_ADP_DE�Character�80��Video for Windows version �VFW_VER�Character�20��Win32s version�WIN32S_VER�Character�20��Windows drivers�WIN_DRVS�Memo���If you’d like more information on the database files Winstone 96 uses, see page � PAGEREF _Ref302352875 �95�, or Appendix A, “� REF AppendixADatabaseFiles \* MERGEFORMAT �The Database Files�” beginning on page � PAGEREF AppendixADatabaseFiles �149�.

Error messages log file

� XE "Winstone 96:Messages:ERRORS.TXT" �� XE "Messages:ERRORS.TXT" �� XE "ERRORS.TXT" �� XE "Error messages log file" �Winstone 96 logs all error messages in a file named ERRORS.TXT in the parent directory where you installed the benchmark (probably \ZDBENCH). (Winstone 96 shares this log file with WinBench® 96.) The automatic logging feature frees you from having to keep track of any error messages Winstone 96 may display during a test run.

NOTE:	The error message included in Winstone 96’s ERRORS.TXT file do not include errors from the applications or application scripts Winstone 96 uses.

You can view the ERRORS.TXT file with any text editor.

Problems Winstone 96 fixes

� XE "Problems Winstone 96 fixes" �� XE "Winstone 96:Problems fixed in this release" �The following lists the problems with Winstone 95 that Winstone 96 fixes.

1.	Winstone 96 does not limit the PC Emulation Info in the Software page of the Questionnaire to three characters.

2.	In Winstone 95, the directory list box and the drives list box in the Database browser dialogs did not correctly paint the directory and drive icons when you ran with a monochrome graphics driver. Winstone 96 does not have this problem.

3.	Winstone 96 does not cause a GPF if you cancel batch mode during a batch mode message and then double-click in the Disclosure window’s drop-down list of results.

4.	Winstone 96 automatically sets up the printer it needs to print to a file on Windows 95.

5.	Winstone 95 encountered a problem printing from its Microsoft Word script under Windows 95 if the Spooler line in the [Windows] section of the WIN.INI file wasn’t set to yes. Winstone 96 automatically makes this change.*

6.	Winstone 95 encountered a problem with the FileMaker Pro script when the PC had QTIM.DLL (a Quicktime library) installed. Because Winstone 96 doesn’t include FileMaker Pro, the benchmark no longer encounters this problem.

7.	In Winstone 95, some users had trouble with the WinCIM communications package or Excel after running the benchmark. The Winstone 96 cleanup program completely restores the PC’s WIN.INI file; therefore, this is no longer a problem.

8.	Winstone 95 had problems with read-only files and the WordPerfect 6.0 script. Winstone 96 uses WordPerfect version 6.1, and no longer has this problem.

9.	The NOCPUCHECK command line option works correctly in Winstone 96.

10.	On some PCs with over 64MB of RAM, Winstone 95 incorrectly reported the total amount of RAM. Winstone 96’s new Configuration Information window correctly reports the test PC’s RAM.

End of Chapter

�Chapter 3: �Winstone 96 Key Terms

Before you run any of Winstone 96’s suites, it would help to understand a few basic terms. This chapter provides an overview of the key terms you should know to best understand how to run Winstone 96 and understand its results.

NOTE:	You can also consult the Glossary at the end of this manual.

Sections in this chapter

� REF _Ref337613495 \* MERGEFORMAT �Base machine�

� REF _Ref333724441 \* MERGEFORMAT �Category suite�

� REF _Ref333724443 \* MERGEFORMAT �Chart of Results�

� REF _Ref333724446 \* MERGEFORMAT �Disclosure�

� REF _Ref333724448 \* MERGEFORMAT �Disclosure Questionnaire�

� REF _Ref337868456 \* MERGEFORMAT �Functions window�

� REF _Ref333724451 \* MERGEFORMAT �Main suite�

� REF _Ref333724453 \* MERGEFORMAT �Main window�

� REF _Ref333724455 \* MERGEFORMAT �Table of Results�

�Base machine

You can gauge the overall performance of a PC by comparing its Winstone 96 scores to the scores of the base machine. The base machine for Winstone 96 is a Dell® PC with a 25�MHz Intel® 486 SX CPU running Microsoft Windows version 3.1 in enhanced mode. For the vital statistics on the base machine, see page � PAGEREF FactsAboutBaseMachine �106�.

The base machine’s score for Winstone 96’s main suite is 10.0 units. A faster PC will have a higher score on the main suite, while a slower PC will have a lower score. For example, if a PC receives a Winstone 96 score of 20.0 units on the main suite, its overall Windows-based applications performance will be twice that of the base machine.

To avoid any confusion with the overall score, each category suite score for the base machine is 1.0 unit. Again, a faster PC will have a higher score on a category suite, while a slower PC will have a lower score. For example, if a PC receives a Winstone 96 score of 2.0 units on one of the category suites, its overall performance on that type of Windows�based application is twice that of the base machine.

Category suite

When you run a category suite, Winstone 96 runs just the applications within that category. Winstone 96 has four category suites:  Business Graphics/DTP, Database, Spreadsheet, and Word Processing.

For detailed information on what a Winstone 96 suite does when you run it, see Chapter 18, “� REF Chapter18WhattheSuitesDo \* MERGEFORMAT �What the Suites Do�” beginning on page � PAGEREF Chapter18WhattheSuitesDo �127�.

Chart of Results

When you run any of Winstone 96’s suites, it automatically displays its scores in the Chart of Results.

Winstone 96 displays the name of the suite and a horizontal bar graph showing its score.

You can also add scores for other machines to the Chart of Results. If you do this, then Winstone 96 displays a horizontal bar graph for each machine in the chart. The Chart of Results groups scores together suite by suite. You can display up to five sets of comparison results in this chart.

Disclosure

The Disclosure window displays information about a PC’s configuration. You can also view system information about comparison machines from the Disclosure window. To open this window, choose its icon or the Disclosure option from the Window menu.

Disclosure Questionnaire

When you need to edit Disclosure information, you use Winstone 96’s Disclosure Questionnaire window. This window lets you edit information about a PC’s configuration. To open this window, choose Disclosure Questionnaire... from the Edit menu in the Winstone 96 main menu bar.

Functions window

The Functions window is the portion of Winstone 96’s main window that contains the function buttons. The section “� REF _Ref298751138 \* MERGEFORMAT �Using the Functions buttons�” on page � PAGEREF _Ref298751138 �77� explains what each function button does when you choose it.

Main suite

Winstone 96’s main suite is called “Overall Winstone 96.” When you choose this suite, Winstone 96 runs all its application scripts.

Main window

Winstone 96’s main window is the window that appears when you first start Winstone 96. The Functions window is inside the main window. Winstone 96 also displays its Disclosure and the Chart and Table of Results icons in its main window.

Table of Results

When you run one of Winstone 96’s tests, it includes the result for that test in the Table of Results. Winstone 96 doesn’t, however, automatically display the Table of Results as it does the Chart of Results. To open this window, choose its icon in the Winstone 96 main window or the Table of Results option in the Window menu.

Information in the Table of Results is in a column format grouped into sets of results by test.

You can add up to five sets of comparison results to the Table of Results. If you do this, Winstone 96 displays the PC’s current results in the first column. Winstone 96 displays results for the comparison machines in the columns that follow the current results. You may need to use the scroll bars to view all the comparison results in the table.

End of Chapter

�Part 2: �Installing and Setting Up Winstone 96

Chapter 4:	� REF Chapter4SettingUp \* MERGEFORMAT �Setting Up the Test PC��List the minimum requirements to run Winstone 96 and explains what you should think about before you install the benchmark’s files.

Chapter 5:	� REF Chapter5Installing \* MERGEFORMAT �Installing the Winstone 96 Files��Explains how to install the benchmark.

Chapter 6:	� REF Chapter6Licensing \* MERGEFORMAT �Licensing and Registering Winstone 96��Tells you how to license and register your copy of the software. (You must license and register Winstone 96 before you can run any of its tests.)

�Chapter 4: �Setting Up the Test PC

This chapter lists the minimum requirements to run Winstone 96. It also explains what you need to think about and do before you run any suites.

Sections in this chapter

� REF _Ref333726159 \* MERGEFORMAT �Minimum requirements�

� REF _Ref335469566 \* MERGEFORMAT �Think about how you want to run Winstone 96�

� REF _Ref333726164 \* MERGEFORMAT �Check the PC’s system files and applications�

Minimum requirements

� XE "Winstone 96:Minimum requirements" �� XE "Installing:Minimum requirements" �� XE "Minimum requirements" �� XE "Requirements" �If the PC doesn’t meet Winstone 96’s minimum requirements, Winstone 96 won’t be able to run the tests properly. The chart on the next page lists the minimum requirements to install and run Winstone 96.

�

Windows 3.1 or 3.11* or Windows for Workgroups 3.1 or 3.11*�Windows 95��MS-DOS® (or compatible) version 5.0 or later or Novell® DOS 7�N/A��Microsoft CD Extension software or equivalent�N/A��8MB of RAM��130MB of free disk space for a full install �(if you’re not running Winstone 96 from the CD-ROM or network).

Winstone 96 requires 90MB of free space for the base directory, and an additional 40MB (whether you’re running Winstone 96 from the CD�ROM, the hard disk, or a network drive) of free space for the working directory.† ��80386 (or compatible) or higher processor��CD-ROM drive��A swapfile for Windows at least 6MB in size.��A temporary directory with 2MB or more of available space.��VGA resolution (640x480) or higher graphics adapter��Think about how you want to run Winstone 96

Winstone 96 measures the performance of a PC by executing actual Windows�based applications. The CD-ROM that includes Winstone 96 in its \ZDBENCH\WS96 directory also contains all the files and application portions Winstone 96 needs; therefore, you don’t need to install any applications to run Winstone 96.

When you run Winstone 96, it copies the files it needs from a base directory to a work directory. The base directory holds all Winstone 96’s application files, and the work directory holds the files Winstone 96 creates when you run a suite.

You can set these directories to any path you want, but the work directory should be on the hard disk of the PC you plan to test. (For example, the base directory could be on a network drive, F:\ZDBENCH\WS96, and the work directory could be on the test PC’s hard disk, C:\ZDBENCH\WS96\WORK.)

NOTE:	The location of the base directory doesn’t affect a PC’s scores.

Figure 4-1 illustrates the different ways you can run Winstone 96 and the amount of free disk space you need for each option.

Figure 4-1:  Options for running Winstone 96

�

Check the PC’s system files and applications� XE "Winstone 96:Installing:Modifying system files" �� XE "System files:Modifying" �� XE "Installing:Modifying system files" �

Before you install Winstone 96, you may need to modify some of the PC’s system configuration files. By making changes to these files, you’ll ensure Winstone 96 runs without problems, and you’ll probably see improved scores.

�NOTE:	Before you modify the system files, make backup copies of the original files (you can use file names such as CONFIG.SAV, WIN.SAV, and AUTOEXEC.SAV).

	After you modify these system files, you’ll need to exit Windows (if you edited these files under Windows) and reboot the PC for the changes you made to take effect. You can reboot the PC by pressing Ctrl�Alt�Del, by pressing the PC’s reset button (if there is one), or by turning off the power to the PC and restarting it.

The following lists things you may need to do.

1.	Remove any extraneous drivers from the CONFIG.SYS and AUTOEXEC.BAT� XE "AUTOEXEC.BAT" �� XE "System files:AUTOEXEC.BAT" � � XE "System files:CONFIG.SYS" �� XE "CONFIG.SYS" �files. For example, if you’re running Winstone 96 from a local drive or CD-ROM, make sure those drivers are the only ones listed in these file.

2.	Remove any options from the load= and run= statements in the [windows] section of the Windows WIN.INI file. For example, if the [windows] section of the PC’s WIN.INI file looks like this:� XE "WIN.INI" �� XE "System files:WIN.INI" �

[windows]�load=nwpopup.exe�run=

Then you would comment out the load= line that contains options using a semicolon (;) and then add an empty load= line like this:

[windows]�;load=nwpopup.exe�load=�run=

3.	Create a temporary directory for Winstone 96’s temporary files by adding or modifying the SET TEMP= line in the PC’s AUTOEXEC.BAT� XE "System files:AUTOEXEC.BAT" �� XE "AUTOEXEC.BAT" � file. For example, you may use a line similar to:

SET TEMP=C:\DOS

The drive that holds the temporary directory must have a least 2MB of free disk space.

4.	Remove any applications from the PC’s Windows StartUp group.

�5.	If the PC is not using Program Manager, select it as the Windows manager by using the command Shell=PROGMAN.EXE in the SYSTEM.INI� XE "SYSTEM.INI" �� XE "System files:SYSTEM.INI" � file.

6.	Disable any screen savers until after you’ve run Winstone 96.

7.	Disable any menu bars until after you’ve run Winstone 96.

End of Chapter

�Chapter 5: �Installing the Winstone 96 Files

To install the benchmark, you execute SETUP.EXE from the \ZDBENCH\WS96 directory. The setup program displays a series of screens and dialog boxes in which you enter information such as the directory where you want Winstone 96 to install its files. Each of these screens contains text explaining what you should do.

If you’re an experienced PC user, you may not need to read this chapter. It explains step�by�step how to install the Winstone 96 files.

Sections in this chapter

� REF _Ref333726896 \* MERGEFORMAT �Installing Winstone 96�

� REF _Ref334500230 \* MERGEFORMAT �Installing Winstone 96’s files to a network file server�

Installing Winstone 96

� XE "Winstone 96:Installing" �� XE "Installing" �To install Winstone 96, execute SETUP.EXE� XE "SETUP.EXE" � from the \ZDBENCH\WS96 directory on the CD-ROM or from a network file server.

NOTE:	If you received Winstone 96 on CD-ROM, that CD-ROM may contain the Ziff�Davis PC Benchmarks Installer program� XE "Ziff�Davis:PC Benchmarks Installer program" �� XE "PC Benchmarks Installer program" �� XE "Installer program" �. With this installer program, you can install both Winstone 96 and WinBench 96, as well as other programs WinBench 96 requires, at one time. If you’re running Windows 95, the installer program starts automatically if the CD-ROM is in the CD-ROM drive. If you need to start the installer program, execute INSTALL.EXE� XE "INSTALL.EXE" � from the CD-ROM’s root directory using the File | Run command under Windows.

The setup program displays a series of screens and dialog boxes in which you enter information such as the directory where you want Winstone 96 to install its files. Each of these screens contains text explaining what you should do.

NOTE:	Although you don’t have to install Winstone 96’s files to the default directory, \ZDBENCH\WS96, you should choose the default directory for compatibility with other Ziff-Davis benchmarks.

When the setup program begins installing the files, it displays a status bar to let you know how it is doing. After installation is complete, Winstone 96 displays a message telling you it’s done.

Installing Winstone 96’s files to a network file server

If you want to create a base directory on a network file server, you don’t need to run the setup program from the CD-ROM. Instead, you can copy the \ZDBENCH\WS96 directory from the CD-ROM to the file server. Then, to install Winstone 96 to a local PC’s hard disk, you run SETUP.EXE from the directory on the file server.

End of Chapter

�Chapter 6: �Licensing and Registering Winstone 96

You must license and register the software before you use it. If for any reason you don’t agree to the terms and conditions of the license agreement, return the CD-ROM and anything that came with it to the following address:

Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, North Carolina 27560

Sections in this chapter

� REF _Ref296749961 \* MERGEFORMAT �Licensing Winstone 96�

� REF _Ref296750256 \* MERGEFORMAT �Registering Winstone 96�

Licensing Winstone 96

Before you can run any of Winstone 96’s suites, you must license and register your copy of the software. The first time you start Winstone 96, it prompts you with its licensing screen.

By licensing Winstone 96, you agree to the requirements and terms of the license agreement displayed on the screen. (You’ll find the same license agreement at the front of this manual and in the README.WRI file.) You should read the license agreement carefully before continuing.

NOTE:	The Winstone 96 license agreement specifically states you can’t use the application programs that come with Winstone 96 except in conjunction with the Winstone 96 program and then only when Winstone 96 is running. Any other use or reproduction (except as part of archive copies of Winstone 96) of the application program files is a violation of the license agreement.

To license Winstone 96:

1.	Start Winstone 96 by choosing Winstone 96 from the Ziff-Davis Benchmarks program group. The first time you run Winstone 96, it displays the licensing information.

2.	Read the licensing information. You can use the scroll bar to the right of the license screen to view all the licensing information.

Once you have read the license agreement, you can:

a.	Choose Proceed to continue with the licensing procedure. You must scroll to the end of the license agreement before you can choose Proceed.

b.	Choose Exit to leave the program without licensing Winstone 96.

Registering Winstone 96

If you agree to the terms of the license agreement and choose to continue, Winstone 96 displays its registration window.

To register Winstone 96:

1	Enter your name in the Registration window. You must enter your name to register the software. If you don’t, the program won’t continue.

NOTE:	You can enter a name in the Organization field of this dialog box if you like. The Organization field is optional.

2.	Select Yes to license and register your copy of Winstone 96.

NOTE:	If you don’t agree to the terms of the license agreement, select No. You must then delete all copies of Winstone 96 and return the CD�ROM and any other materials that came with it.

	If you’d like to reread the license agreement, select the Reread License button.

Winstone 96 only prompts you with the license and registration information the first time you run it. The next time you start the program, you won’t need to license and register it again.

End of Chapter

�Part 3: �Running Winstone 96

Chapter 7:	� REF Chapter7BeforeYouRun \* MERGEFORMAT �Before You Run a Suite��Lists the things you need to know before you run any Winstone 96 suites.

Chapter 8:	� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window��Explains Winstone 96’s configuration check and how to use the Configuration Information window.

Chapter 9:	� REF Chapter9QuickStart \* MERGEFORMAT �Quick Start—Running the Main Suite and Saving Results��Contains step-by-step, quick instructions on running the main suite and getting some results.

Chapter 10:	� REF Chapter10RunningSuites \* MERGEFORMAT �Running Winstone 96’s Suites��Explains in detail how to run Winstone 96.

Chapter 11:	� REF Chapter12ButtonsandMenus \* MERGEFORMAT �What Do All These Buttons and Menus Do?��Includes information on how to use each function button and menu in Winstone 96.

Chapter 12:	� REF Chapter12WorkingwithDisclosure \* MERGEFORMAT �Working with Disclosure Information��Explains how to view and edit Disclosure information.

�Chapter 7: �Before You Run a Suite

Running Winstone 96’s suites can take quite a while. This chapter lists facts you need to know before you start running any suites. Understanding these caveats can save you time later. This chapter also explains how to change Winstone 96’s base or work directory before you run suites.

Sections in this chapter

� REF _Ref298748781 \* MERGEFORMAT �Don’t get stung by gotchas:  Read these caveats!� 

� REF _Ref299166580 \* MERGEFORMAT �Changing the base or work directory�

Don’t get stung by gotchas:  Read these caveats!

� XE "Winstone 96:Caveats" �Winstone 96, like any other software, requires the PC to meet certain conditions. If the PC doesn’t meet these conditions, the suite may not finish successfully. Before you run any of Winstone 96’s suites, read the following list of caveats. (A similar list of caveats appears in Winstone 96’s README.WRI� XE "README.WRI" � file.)

1.	Winstone 96 requires an absolute minimum of 8MB of RAM to run. Winstone 96 may not run successfully on systems with only 8MB of RAM if those systems allocate memory for expanded memory (EMS), disk caches (for example, SMARTDRV), large device drivers, or similar things.

2.	Winstone 96 does not run under OS/2® or Windows NT™.

3.	When Winstone 96 is running, you should not click the PC’s mouse buttons or press any keys on the keyboard. Clicking a mouse button or pressing keys on the keyboard can affect Winstone 96’s scores.

3.	You can use the following command line options to disable Winstone 96’s automatic detection of some disclosure fields. .� XE "Winstone 96:Command line options" �� XE "Command line options" �

The NOCPUCHECK � XE "NOCPUCHECK" � � XE "Winstone 96:NOCPUCHECK" �option prevents Winstone 96 from detecting the CPU type and speed and the FPU type.

The NOVIDCHECK � XE "NOVIDCHECK" � � XE "Winstone 96:NOVIDCHECK" �option prevents Winstone 96 from detecting the display refresh rate, VESA support, and graphics adapter types.

The NOREGCHECK � XE "NOREGCHECK" �� XE "Winstone 96:NOREGCHECK" �option prevents Winstone 96 from gathering information from the Windows 95 or Windows NT registry.

The NOSYSCHECK � XE "NOSYSCHECK" � � XE "WinBench 96:NOSYSCHECK" �option disables nearly all detection.

You should use these options if Winstone 96 fails during initialization. The NOVIDCHECK option is useful if display corruption occurs after Winstone 96 initializes.

4.	� XE "Winstone 96:Tests:Interrupting" �� XE "Tests:Interrupting" �� XE "Interrupting a test" �If you need to interrupt a suite, choose the Cancel button when Winstone 96 installs an application’s files. If you need to stop a test run immediately, press Ctrl-Alt-Del to quit Winstone 96, and then restart Windows.

IMPORTANT NOTE!�When you exit Winstone 96, it automatically restores the system files on the PC. If anything happens and you need to interrupt Winstone 96 during the test run, or if Winstone 96 halts, stops, or hangs the PC and you must exit Winstone 96 in any way other than clicking the Exit button, Winstone 96 includes a cleanup program � XE "Winstone 96:Cleanup program" �that will automatically run when you restart Windows and that will restore the PC’s system files to their pretest state.

If you interrupt a Winstone 96 test run using Ctrl-Alt-Del, you should exit Windows, reboot the PC, and restart Windows so Winstone 96’s cleanup program can restore the PC’s system files to their pretest state. You should always let Winstone 96 clean up after a test run.

5.	� XE "Winstone 96:Screen savers" �� XE "Screen savers" �Hardware-based screen savers can cause Winstone 96 to abort and can thus affect Winstone 96’s scores. You should disable hardware-based screen savers before you run Winstone 96.

6.	If you’re testing Winstone 96 on notebook or green computers, you should disable any power-saving features.� XE "Winstone 96:Notebooks" �� XE "Winstone 96:Green computers" �

7.	System software that redefines function keys will affect Winstone 96. For example, the NetWare® 3.1 driver lets you map the NetWare Pop-Up Menu to a function key. When Winstone 96 runs an application that uses the same function key, the NetWare Pop-Up Menu overrides that application’s use of that key. This overriding causes problems for the Winstone 96 script for that application. So, you should disable any system software function keys before you run Winstone 96.� XE "Winstone 96:NetWare Pop-Up Menu" �� XE "NetWare Pop-Up Menu" �

8.	Winstone 96’s copy of Adobe™ PageMaker� XE "PageMaker" �� XE "Adobe PageMaker" �� XE "Winstone 96:Adobe PageMaker NCD" �� XE "Winstone 96:Running:On a network" �™ 5.0a for Windows allows only five copies of itself to be running on PCs on a NetWare network at the same time. This restriction is because of Adobe PageMaker for Windows 5.0a’s Network Copy Detection (NCD) mechanism. If you need to run Winstone 96 on more than five PCs on the same NetWare network, make sure no more than five are running the Winstone 96 Adobe PageMaker for Windows script at the same time. Should Winstone 96 attempt to run its Adobe PageMaker for Windows script on more than five PCs at the same time, Adobe PageMaker for Windows will exit with no warning message.

To alleviate this limitation somewhat, Adobe PageMaker for Windows 5.0a is the first application Winstone 96 runs. If you need to run Winstone 96 on more than five PCs on a NetWare network, you can initially start Winstone 96 on up to five of those PCs. Once any of those PCs has finished the Adobe PageMaker for Windows script and has moved to the next script, you can then start Winstone 96 on another PC. You can continue this process until you have tested all the machines you wish to test. (Adobe PageMaker 5.0a is the only Winstone 96 application with a user limit.)

NOTE:	You can avoid the NCD limitation entirely simply by installing Winstone 96 on the PC’s hard disk and running Winstone 96 when the PC is not logged into the NetWare network.

Before you run Winstone 96 on any PC attached to a NetWare network, you must first prepare the NetWare server for Adobe PageMaker’s NCD mechanism. To configure the NetWare server to run Winstone 96 correctly, you must:

A.	Load the Winstone 96 CD-ROM into the server’s CD-ROM drive or install Winstone 96 on the server’s hard disk.

B.	Log onto the NetWare server as SUPERVISOR from any PC on the network.

C.	Use the Windows File Manager to change to the Winstone 96 directory \ZDBENCH\WS96\APPS on the CD-ROM.

D.	Execute the file WINBUMPS.EXE in that directory.

E.	Enable the NCD mechanism in the WINBUMPS.EXE program by selecting Enable Preferred from the Server menu. You can confirm the setting by using Check Enabled from that same menu.

F.	Exit the WINBUMPS.EXE program.

Once you have prepared the NetWare server, you can begin installing Winstone 96 on PCs you want to test.

9.	Winstone 96 applications create temporary files and stores these files in the directory the TEMP environment variable specifies. The AUTOEXEC.BAT� XE "AUTOEXEC.BAT" � file typically sets that variable.

If you specify a TEMP directory that isn’t on the same drive as the Winstone 96 work directory, you must make sure that TEMP directory has at least 2MB of free space.

Otherwise, Winstone applications may fail with various file-allocation error messages. You should note if you haven’t configured a swap file for Windows, Windows will also allocate swap space in the TEMP directory.

10.	If you get GPFs or odd graphics behavior when you run Winstone 96, try changing to a VGA driver. If Winstone 96 runs to completion with a VGA driver, the incompatibility may be with the driver that came with the graphics board. You should check with the board vendor to see if a newer version of the driver is available.

11.	You may experience problems if you try to run Lotus Notes and Winstone 96 at the same time. When you run both programs at the same time, Notes may generate a Stack Fault and the Winstone 96 Check program will report a stack overflow. If you want to run Winstone 96, make sure Notes (and any other application) is not running.

	Also, if you run Notes with Winstone 96 and Notes crashes, the placement of the Lotus Notes SmartIcons may change to "Floating." You can correct this problem later by choosing the Tools | SmartIcons menu option in Notes and then changing the position setting in the SmartIcons dialog box.

12.	When you run Winstone 96 with Windows 95, make sure you map the network drives to logical DOS drives. Even though Windows 95 doesn’t need this mapping, Winstone 96 does.

Changing the base or work directory� XE "Changing the base or work directory" �� XE "Base directory:Changing" �� XE "Work directory:Changing" �� XE "Winstone 96:Changing the base or work directory" �

Before you run a Winstone 96 suite, you can change the base or work directory it uses. For example, you may have Winstone 96 installed on the PC’s local drive and on a network drive. Before you run a suite, you might want to change the base directory from the local drive to the network drive.

You determined the location of Winstone 96’s base and work directories when you installed Winstone 96. For example, if you are running Winstone 96 from the CD�ROM, the base directory is on the CD-ROM. The work directory points to the drive and subdirectory on the PC where Winstone 96 installs and runs the application files.

� XE "Settings:Changing" �� XE "Winstone 96:Changing settings" �To change the base or work directories:

1.	Choose Settings... from the Edit menu in Winstone 96’s main window.

Winstone 96 displays its Settings dialog box.

2.	Type the appropriate drive and path name in the corresponding text box.

If you’re uncertain about the drive and path name, put the cursor in the appropriate text box and use the Browse button to see a directory listing. (The Browse button brings up a standard file-browsing dialog box for Windows.)

NOTE:	The base directory must be a CD-ROM drive accessible by the PC unless you’ve installed the Winstone 96 files from the CD-ROM on the PC’s hard disk or on a file server’s hard disk.

3.	Choose OK to enter the changed directories and return to the main window.

End of Chapter

�Chapter 8: �Using the Configuration Information Window

When you run a suite, Winstone 96’s configuration check makes sure the PC meets a minimum set of requirements and then reports any areas that may cause the test to fail in the Configuration Information window. This chapter explains how to use that window.

NOTE:	Winstone 96 gives you the option of turning off its configuration check, so no matter what, you’ll never see the Configuration Information window. (We don’t recommend turning off this check; however, there may be an occasion where you can safely disable the check.) For information on how to disable the check, see page � PAGEREF _Ref327694563 �41�.

Sections in this chapter

� REF _Ref337877820 \* MERGEFORMAT �The different sections of the Configuration Information window�

� REF _Ref337877828 \* MERGEFORMAT �Handling Potential Problems�

� REF _Ref333740497 \* MERGEFORMAT �Understanding the Optimization Tips�

� REF _Ref327694797 \* MERGEFORMAT �Using a Custom Configuration File�

� REF _Ref327694563 \* MERGEFORMAT �Disabling Winstone 96’s configuration check�

�The different sections of the Configuration Information window

Before each test run, Winstone 96 checks the PC for potential problems. If it finds a problem, it displays the Configuration Information window.

This window has three sections:

Potential Problems

Optimization Tips

Custom Configuration File

When Winstone 96 displays this window, the section that contains any warnings will be on top. For example, if Winstone 96 doesn’t find any potential problems with the PC’s setup and configuration, but instead, finds a setting in the PC’s system files that differs from the pre-set list of optimization tips, it will display the Optimization Tips section first. (You can look at the other sections if you’d like. Just click on the button at the top of the window that corresponds to the section you wish to view.)

In the top left corner of the Configuration Information window, you’ll find the Options drop�down menu. You can use this menu to tell Winstone 96 what areas to check before running tests (for example, you can have Winstone 96 check potential problems and nothing else) and to load or unload a custom configuration file.

�Handling Potential Problems

The following chart explains briefly what to do if Winstone 96 warns you of problems that may cause a test to fail.

Potential Problem:�Solution:��Low system resources�Winstone 96 requires at least 60% of memory in the GDI and USER heap free for its applications. Close any other applications before continuing with the test run.��Swap file too small�Winstone 96 requires a total of 14MB of memory, of which at least 8MB must be physical RAM.��Not enough free disk space�Winstone 96 needs a minimum of 40MB of free disk space for its work directory. You can:

•	Change the work directory to another disk drive on the test PC that has enough free disk space.

•	Free disk space by deleting files and/or applications from the test PC’s hard disk.��Not enough free TEMP space�Winstone 96 needs at least 2MB of available space in a TEMP directory. You can:

•	Make sure the TEMP directory is on the same drive as the Winstone 96 work directory.

•	Make sure the TEMP directory is empty.

•	Increase the amount of space for the TEMP directory by putting the directory on a drive that has adequate space or by deleting files and/or applications to increase the available space on the drive where TEMP is located.��Missing VSHARE device driver�On Windows 3.1 and Windows for Workgroups 3.11, Winstone 96 requires VSHARE. If the VSHARE driver isn’t installed, you can reinstall Winstone 96 and when the program asks if you want to install the VSHARE.386 driver, choose Yes.��Missing display fonts�If the PC is missing any of the fonts Winstone 96 needs to successfully run its tests, the Configuration Information window lists the missing fonts. You’ll need to install these fonts before continuing. (To see a list of fonts installed on the test PC, select Fonts from the Windows Control Panel program group.)��Quit other applications�Running Winstone 96 while you have other applications running in the background can affect a PC’s scores. Winstone 96 lists all other applications that are running, but will not automatically terminate these other applications. You should quit all other applications before running a Winstone 96 test.��Understanding the Optimization Tips

When Winstone 96 performs its configuration check, it notes areas where the PC differs from a pre-set list of optimization tips. For example, when you run Winstone 96, the load= option in the [Windows] section of the PC’s WIN.INI file should be empty. So, if load= entry isn’t empty, Winstone 96 lists this difference on the Optimization Tips page.

For information on why a certain setting may cause problems for Winstone 96, highlight the setting in the Configuration Information window and Winstone 96 displays an explanation at the bottom of the window.

Using a Custom Configuration File

In addition to comparing the PC to a list of pre-set optimization tips, you can also use a custom configuration file. Then, when Winstone 96 performs its configuration check, it will compare the pre-defined settings in the custom configuration file with the settings the test PC uses. If you’re testing multiple PCs, you can use a custom configuration file to assure that each PC matches the custom settings.

Winstone 96 includes a sample configuration file (SAMPLE.CFG) in the \ZDBENCH\WS96\UI directory on the CD-ROM.

To create a custom configuration file, first copy the SAMPLE.CFG file to another file name (for example, CUSTOM.CFG). Then, edit the custom file so it contains the settings you want. (For information on the different settings the SAMPLE.CFG file can contain, see Appendix B, “� REF AppendixBCustomConfigFile \* MERGEFORMAT �The Custom Configuration File�” beginning on page � PAGEREF AppendixBCustomConfigFile �153�.)

After you’ve edited the custom file and before you run any Winstone 96 tests, go to each PC you want to test and follow the steps below:

1.	Select Run | Configuration Information... from the Winstone 96 main window.

2.	Select Option | Load custom configuration file... from the Configuration Information window.

Winstone 96 displays the Load Custom Configuration File dialog box.

3.	Enter the directory and file name of the custom file.

4.	Select OK.

After you load the custom file, Winstone 96 continues to check differences between the custom file and the PC under test for the remainder of the current session and in future sessions on that PC until you unload the file.

To unload a custom configuration file:

1.	Select Run | Configuration Information... from the Winstone 96 main window.

2.	Select Options | Unload custom configuration file from Configuration Information window.

Disabling Winstone 96’s configuration check

You may want to disable the configuration check if you’re running Winstone 96 on the same PC over and over again without changing that PC’s configuration. Once Winstone 96 performs the check and you’re sure the PC is set up correctly, you can then disable the check. You can also tell Winstone 96 to perform only certain portions of its check. For example, you could have the program check for Potential Problems but not check for Optimization Tips.

NOTE:	If you change the PC’s configuration at all, you should enable the configuration check. The check is a good way to be certain Winstone 96 will complete the test without problems.

To disable one portion or all of the check:

1.	Select Options | Check before running tests from the Configuration Information window.

2.	From the sub-menu Winstone 96 displays, select those areas you want the program to check. For example, if you only want Winstone 96 to look for potential problems, select Potential Problems from the list. Winstone 96 marks each selection with a check mark.

If you don’t select any of the items in this list, Winstone 96 doesn’t perform its configuration check.

Until you change these options, Winstone 96 will perform the configuration checks you select for the current session and for future sessions.

End of Chapter

�Chapter 9: �Quick Start—Running the Main Suite and Saving Results

This chapter leads you through the process of running Winstone 96’s main suite, getting an overall score for the PC, and saving that score to a database.

Sections in this chapter

� REF _Ref296758027 \* MERGEFORMAT �The fast version�

� REF _Ref304978815 \* MERGEFORMAT �The detailed version�

The fast version

We’ve written this section with the assumption you’ve installed Winstone 96, it’s ready to run on the PC, and you understand a little about how the program works. If you get confused, the next section, “The detailed version,” explains in more detail the same steps we list here.

NOTE:	Before you run a suite, you should, at a minimum, restart Windows. For the most accurate scores, however, you should also defragment the PC’s hard disk, restart the PC, and then restart Windows.

To run the main suite:

1.	Choose Winstone 96 in the Ziff-Davis Benchmarks program group to open the main window.

NOTE:	If you haven’t previously licensed Winstone 96, you’ll have to read and agree to the license agreement before you can continue.

2.	Choose the Run button. (When you open the main window, Winstone 96 displays “Overall Winstone 96” in the list of names to the right of the Run button. So, choosing the Run button runs the main test.)

NOTE:	By default, Winstone 96 displays the Configuration Information window if there are problems that may cause the test to fail. If there are problems, you should select Cancel Test in this window and then correct the problems before continuing. (See Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�” beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37� for more information.)

	If you need to interrupt a suite, you can choose the Cancel button when Winstone 96 is installing an application’s files.

3.	When the suite finishes, choose the Save button from the Winstone 96 functions window.

Winstone 96 displays the Save to Database dialog box.

NOTE:	You must enter a Description for the test run before you can save results. If you haven’t entered a Description, Winstone 96 prompts you for that information before you can continue the save. It’s also a good idea to check the other fields in the Disclosure Questionnaire for accuracy. Once you’ve entered a Description and verified the other fields, choose the Continue with Save button.

4.	Choose the Save button in the Save to Database dialog box.

Winstone 96 saves the results to the current database using the Description you supplied, along with other information in the Disclosure.

NOTE:	You can change the destination database by choosing the Database button in this window.

The detailed version

This section describes the same steps as the previous section in greater detail.

NOTE:	Before you run a suite, you should, at a minimum, restart Windows. For the most accurate scores, however, you should also defragment the PC’s hard disk, restart the PC, and then restart Windows.

Step 1:  Start Winstone 96

Before you can run any suites, you need to open the main window. To do this, choose Winstone 96 in the Ziff-Davis Benchmarks program group.

NOTE:	If you haven’t previously licensed Winstone 96, you’ll have to read and agree to the license agreement before you can continue.

	If Winstone 96 fails during initialization, you can use the following command line options to disable Winstone 96’s automatic detection of some disclosure fields.

The NOCPUCHECK option prevents Winstone 96 from detecting the CPU type and speed and the FPU type.

The NOVIDCHECK option prevents Winstone 96 from detecting the display refresh rate, VESA support, and graphics adapter types. The NOVIDCHECK option is useful if display corruption occurs after Winstone 96 initializes.

The NOREGCHECK option prevents Winstone 96 from gathering information from the Windows 95 or Windows NT registry.

The NOSYSCHECK option disables nearly all detection.

Winstone 96 briefly displays its logo and copyright information before displaying the main window.

Step 2:  Run Winstone 96’s main suite

When you start Winstone 96, “Overall Winstone 96” is the active suite name in the list of names to the right of the Run button in the Functions window.

To run the main suite, choose the Run button.

NOTE:	By default, Winstone 96 displays the Configuration Information window if there are any areas that may cause the test to fail. If there are problems, you should select Cancel Test in this window and then correct the problems before continuing. (See Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�” beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37� for more information.)

If you need to interrupt a suite, you can choose the Cancel button when Winstone 96 is installing an application’s files (see page � PAGEREF _Ref333131680 �52� for more information).

Step 3:  Save the results

When a suite finishes, Winstone 96 automatically displays the score for that suite in the Chart of Results.

To save results:

1.	Choose the Save button from the Winstone 96 functions window.

Winstone 96 displays the Save to Database dialog box.

NOTE:	You can change the destination database by choosing the Database button in this window.

You must enter a Description for the test run before you can save results. If you haven’t entered a Description, Winstone 96 prompts you for that information before you can continue the save. It’s also a good idea to check the other fields in the Disclosure Questionnaire for accuracy.

If you’ve previously run Winstone 96 or one of our other PC benchmarks on the machine and if you installed these benchmarks in the default \ZDBENCH directory, Winstone 96 gives you the opportunity to use the same Disclosure information you entered before, including the test description. If you’re running the benchmark several times on the same machine, this keeps you from having to enter the same Disclosure information time and time again.

Once you’ve entered a Description and verified the other fields, choose the Continue with Save button from the Save to Database dialog box.

2.	Choose the Save button in the Save to Database dialog box.

Winstone 96 saves the results to the current database using the Description you supplied, along with other information in the Disclosure.

�Step 4:  Exit Winstone 96

You can exit Winstone 96 by:

Choosing the Exit button in the Functions window or using the key sequence Alt�x.

Choosing Exit from the File drop-down menu.

Choosing the Close command from the Control menu for the main window.

If you have unsaved scores when you exit, Winstone 96 asks you if you want to save those scores.

End of Chapter

�Chapter 10: �Running Winstone 96’s Suites

This chapter explains how to run all Winstone 96’s suites, what to do if you need to interrupt a suite, and how to save results. It also tells you how to run Winstone 96 in batch mode and demo mode and how to exit Winstone 96.

Sections in this chapter

� REF _Ref303677710 \* MERGEFORMAT �Running the main suite:  Getting an overall score�

� REF _Ref333131680 \* MERGEFORMAT �Interrupting a test run�

� REF _Ref334411341 \* MERGEFORMAT �Saving scores�

� REF _Ref299168241 \* MERGEFORMAT �What happened during a test run:  Check the WS96.INI file�

� REF _Ref333742898 \* MERGEFORMAT �Running a Category suite�

� REF _Ref333742903 \* MERGEFORMAT �Hands-free testing:  Running in batch mode�

� REF _Ref333742910 \* MERGEFORMAT �Seeing Winstone 96 in action:  Running demo mode�

� REF _Ref298312713 \* MERGEFORMAT �Exiting Winstone 96�

Running the main suite:  Getting an overall score

To run Winstone 96’s main suite and get an overall score:

1.	Choose Winstone 96 from the Ziff-Davis Benchmarks program group to open the main window.

NOTE:	If you haven’t previously licensed Winstone 96, you’ll have to read and agree to the license agreement before you can continue.

	If Winstone 96 fails during initialization, you can use the following command line options to disable Winstone 96’s automatic detection of some disclosure fields.

The NOCPUCHECK option prevents Winstone 96 from detecting the CPU type and speed and the FPU type.

The NOVIDCHECK option prevents Winstone 96 from detecting the display refresh rate, VESA support, and graphics adapter types. The NOVIDCHECK option is useful if display corruption occurs after Winstone 96 initializes.

The NOREGCHECK option prevents Winstone 96 from gathering information from the Windows 95 or Windows NT registry.

The NOSYSCHECK option disables nearly all detection.

2.	Choose the Run button. (When you open Winstone 96, it displays “Overall Winstone 96” in the list of suite names by default. So, choosing the Run button runs the main suite.)

NOTE:	Before you run a Winstone 96 suite, you can change the base or working directory (see page � PAGEREF _Ref298904158 �34�).

	By default, Winstone 96 displays the Configuration Information window if there are any areas that may cause the test to fail. If there are problems, you should select Cancel Test in this window and then correct the problems before continuing. (See Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�” beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37� for more information.)

How long it takes� XE "Main suite:How long it takes" �� XE "Overall Winstone 96:How long it takes" �

The time Winstone 96 takes to run its main suite varies based on the PC’s speed and configuration. Here are a few examples to give you an idea of how long it took to run this suite on machines in our research center. Faster machines will take less time, while slower machines will take more time.

This machine:�Took approximately this much time:��A typical Pentium 100 with 32MB of RAM�27 minutes��A typical Pentium 66 with 16MB of RAM�40 minutes��A typical 486DX2/66 with 16MB of RAM�1 hour��A typical 486SX/25 with 8MB of RAM�2 hours��What happens when you run it� XE "Main suite:What happens when you run it" �� XE "Overall Winstone 96:What happens when you run it" �

Winstone 96 measures a PC’s performance by running scripts that execute commands within Windows�based applications. As Winstone 96 runs a script for an application, dialog boxes and application windows appear and disappear on the PC’s screen. The dialog boxes inform you Winstone 96 is installing, setting up, or cleaning up application files. In the application windows, you’ll see the application performing actual functions. (For more information on what Winstone 96 does when you run it, see page � PAGEREF Chapter18WhattheSuitesDo �127�.)

Once you start a suite, the suite should run to completion without any further input from you. During the suite, neither Winstone 96 nor the applications it runs should generate error messages, halt before completing the suite, or require your input. If by chance Winstone 96 halts before completion due to an error, such as a General Protection Fault (GPF), it normally won’t produce a score. Should Winstone 96 produce a score after prematurely halting, that score is invalid. If you have problems running Winstone 96, see Part 6, “If You Have a Problem” beginning on page � PAGEREF Part6IfYouHaveaProblem �139�.

The following steps describe what happens when you run Winstone 96’s main suite.

1.	When you first choose the Run button, Winstone 96 iconizes the Functions window.

2.	Winstone 96 then makes backup copies of the Windows system files and places these files in a WS96BACK directory in the Windows directory on the test PC’s hard disk.

IMPORTANT NOTE!�When you exit Winstone 96, it automatically restores the system files on the PC. If anything happens and you need to interrupt Winstone 96 during the test run, or if Winstone 96 halts, stops, or hangs the PC and you must exit Winstone 96 in any way other than clicking the Exit button, Winstone 96’s cleanup program will automatically run when you restart Windows and will restore the PC’s system files to their original state. You should always let Winstone 96 clean up after a test run.

Once Winstone 96 has made the backup files, it then installs the system files it needs from the base directory. While Winstone 96 installs these files, it displays a status bar telling you how it’s doing.

3.	Winstone 96 then copies the application files for the first application to the work directory. While Winstone 96 installs the application files, it displays a status bar telling you how it’s doing.

NOTE:	When it installs each application, Winstone 96 also flushes Windows’ disk cache. Windows’ disk cache keeps the most recently used set of disk blocks in memory in case an application reuses them in the near future. Winstone 96 flushes this disk cache to force any data left in the cache to write to the hard disk.

	After Winstone 96 installs the application files, it compacts memory. This makes it easier to run a suite on machines with lower amounts of RAM.

4.	After it installs the application files, Winstone 96 executes the script for the first application.

NOTE:	For most of the applications, Winstone 96 starts its timer when the application’s first window appears on the PC’s screen. Winstone 96 takes one application from each category, however, and includes the application’s startup time in each application’s total time. These four applications are Borland Paradox, Lotus Ami Pro, Microsoft Excel, and Microsoft PowerPoint.

5.	While the script is executing, you see the application’s screens and windows appear and disappear on the PC’s screen. What you’re seeing is the application executing actual tasks.

6.	Once the script for the first application completes, Winstone 96 displays a dialog box telling you it’s deleting the application’s files from the work directory.

NOTE:	Winstone 96 stops its timer when an application completes the last command in a script and doesn’t include the time for cleaning up the work directory in computing its score.

7.	Winstone 96 repeats steps three through six for each application script in the suite.

NOTE:	When the suite finishes, Winstone 96 will restore the PC’s system files to their pretest state.

When a suite finishes, Winstone 96 automatically displays its scores in the Chart and Table of Results.

Interrupting a test run

If you need to interrupt a suite, choose the Cancel button when Winstone 96 installs an application’s files. If you need to stop a test run immediately, press Ctrl�Alt�Del to quit Winstone 96, and then restart Windows.

IMPORTANT NOTE!�If you interrupt a Winstone 96 test run using Ctrl-Alt-Del, you should exit Windows, reboot the PC, and restart Windows so Winstone 96’s cleanup program can restore the PC’s system files to their original state.

Saving scores

After Winstone 96 finishes a test suite, it automatically displays that suite’s scores in the Chart and Table of Results windows.

To save results:

1.	Choose the Save button from the Winstone 96 functions window.

Winstone 96 displays the Save to Database dialog box.

NOTE:	You must enter a Description for the test run before you can save results. If you haven’t entered a Description, Winstone 96 prompts you for that information before you can continue the save operation. It’s also a good idea to check the other fields in the Disclosure Questionnaire for accuracy. After you’ve entered a Description and verified the other fields, choose the Continue with Save button.

2.	Choose the Save button in the Save to Database dialog box.

Winstone 96 saves the results to the current database using the Description you supplied, along with other information in the Disclosure.

NOTE:	You can change the destination database by choosing the Database button in this window.

What happened during a test run:  Check the WS96.INI file

When you start Winstone 96, it creates a file in the PC’s Windows directory (probably \WINDOWS) called WS96.INI. The WS96.INI file is similar to other application .INI files.

The WS96.INI file stores information about the PC at the time of the test run that is relevant to Winstone 96 (for example, the path names for the base and working directories). The file also stores information about the PC’s status at the time of the test run (is there a default printer defined) as well as a list of the files Winstone 96 uses during a test run. You can thus use the WS96.INI file to determine what happened during a test run.

NOTE:	When you run a suite, Winstone 96 installs the application files it needs and then deletes these files as each application’s script finishes. The WS96.INI file lists application files Winstone 96 installed and deleted as “deleted.”

	If the PC already has a copy of a file Winstone 96 needs to install, Winstone 96 makes a backup of the original file, installs its own copy of the file, runs the suite, deletes the version of the file it installed, and then restores the original file. The WS96.INI file lists application files Winstone 96 backed up and restored as “restored.”

The WS96.INI file can have several different sections. The following chart provides a brief outline of the sections and the information you can find in those sections. (An example of a WS96.INI file follows this chart.)

This section:�Provides the:��Registration�Name and the organization name of the person who licensed the software and the version number for Winstone 96.��Fonts�Printer fonts the Winstone 96 applications use when printing.��Paths�Full path names for the PC’s disclosure information file, ERRORS.TXT file, and database directory.��USER:  Paths�Full path names for the base and work directories.��Configuration Information�Default values for the Configuration Information window and the full path name for a custom configuration file (if there is one).��System Status�Status of the PC’s system files Winstone 96 uses.��Printer�Printer information.��Setup Files�Status of files each Winstone 96 application uses during a test run. (The lines in this section of the file map to the remaining section in the file.)��The following is a sample WS96.INI file:� XE "WS96.INI file:Sample" �

[Registration]�UserName=Joe Q. User�UserOrg=Ziff-Davis�Version=Ziff-Davis' Winstone 96 Version 1.0

[Fonts]�PrintFaceName=Arial�PrintFontName=10�ChartFaceName=Arial

[Paths]�Errors.txt=c:\zdbench\errors.txt�Database=c:\zdbench\result96.zdb�Disclosure=c:\zdbench\disclose.ini

[USER: Paths]�Base Directory=f:\testing\zdbench\ws96�Work Directory=c:\zdbench\ws96\work

[Configuration Information]�Display Winstone problems before testing=yes�Display tips before testing=yes�Display Custom Configuration before testing=yes�Custom Configuration file=c:\zdbench\sample.cfg�Ignore these tasks=PROGMAN CLIPSRV NETDDE EXPLORER KERNEL32 MPREXE MSGSRV32 SPOOL32

[System Status]�win.ini=clean�reg.dat=clean�setup files=clean�default printer=clean�current=

[Printer]�32-bit Driver Added=no�Default=

[Setup files]�Windows system files=clean�registration information=clean�Borland dBase 5.0 for Windows=clean�Adobe PageMaker 5.0a for Windows=clean�Lotus 1-2-3 Release 5 for Windows=clean�Microsoft Access 2.0c for Windows=clean�Lotus Ami Pro Release 3.1 for Windows=clean�Corel Corporation CorelDRAW! 5.0E2=clean�Microsoft Excel 5.0c for Windows=clean�Borland Paradox 5.0 for Windows=clean�Microsoft PowerPoint 4.0c for Windows=clean�Novell Quattro Pro 6.01 for Windows=clean�Microsoft Word 6.0c for Windows=clean�Novell WordPerfect 6.1 for Windows=clean�Microsoft Works 3.0b for Windows=clean

[Windows system files]�C:\WIN95\SYSTEM\ws96t.dll=deleted�C:\WIN95\SYSTEM\hppcl.drv=deleted�C:\WIN95\SYSTEM\unidrv.dll=deleted�C:\WIN95\excomm31.drv=restored�C:\WIN95\SYSTEM\bivbx11.dll=deleted�C:\WIN95\SYSTEM\crole2ui.dll=restored�C:\WIN95\SYSTEM\nwcalls.dll=deleted�C:\WIN95\SYSTEM\COMPOBJ.DLL=restored�C:\WIN95\SYSTEM\OLE2.DLL=restored�C:\WIN95\SYSTEM\OLE2NLS.DLL=restored�C:\WIN95\SYSTEM\OLE2DISP.DLL=restored�C:\WIN95\SYSTEM\OLE2PROX.DLL=restored�C:\WIN95\SYSTEM\SDM.DLL=restored�C:\WIN95\SYSTEM\STDOLE.TLB=restored�C:\WIN95\SYSTEM\TYPELIB.DLL=restored�C:\WIN95\SYSTEM\TTEMBED.DLL=restored�C:\WIN95\SYSTEM\MSOFEN.DLL=restored�C:\WIN95\SYSTEM\VBA.DLL=restored�C:\WIN95\SYSTEM\VBAEN.DLL=restored�C:\WIN95\SYSTEM\VBAEN.OLB=restored�C:\WIN95\SYSTEM\DAO2016.DLL=restored�C:\WIN95\SYSTEM\MSABC200.DLL=restored�C:\WIN95\SYSTEM\MSAEXP20.DLL=restored�C:\WIN95\SYSTEM\MSAJT200.DLL=restored�C:\WIN95\SYSTEM\WKSOLE.DLL=restored�C:\WIN95\SYSTEM\MFCOLEUI.DLL=restored�C:\WIN95\SYSTEM\MAPI.GW=restored�C:\WIN95\SYSTEM\TTYTWIN.DRV=restored�C:\WIN95\SYSTEM\SHWIND20.DLL=restored�C:\WIN95\msapps=restored�c:\zdbench\new\mst=deleted

[registration information]�c:\zdbench\new\win.!ws=deleted�c:\zdbench\new\system.!ws=deleted

[Adobe PageMaker 5.0a for Windows]�c:\zdbench\new\pm5=deleted�C:\WIN95\panose.bin=restored�C:\WIN95\pxengwin.dll=restored�C:\WIN95\panose.dat=restored�C:\WIN95\chrexpc.tbl=restored�C:\WIN95\chrimpc.tbl=deleted�C:\WIN95\pcdlib.dll=restored�C:\WIN95\twain.dll=deleted�C:\WIN95\SYSTEM\ariblk.fot=deleted�C:\WIN95\SYSTEM\ariblk.ttf=deleted

[Lotus 1-2-3 Release 5 for Windows]�c:\zdbench\new\123r5w=deleted�C:\WIN95\lotus.ini=restored�C:\WIN95\123r5.ini=restored

[Microsoft Access 2.0c for Windows]�c:\zdbench\new\access20=deleted�C:\WIN95\msaccess.ini=deleted�C:\WIN95\msacc20.ini=deleted

[Lotus Ami Pro Release 3.1 for Windows]�c:\zdbench\new\amipro31=deleted�C:\WIN95\amidw.ini=deleted�C:\WIN95\amieqn.ini=deleted�C:\WIN95\amifont.ini=deleted�C:\WIN95\amiimage.ini=deleted�C:\WIN95\amiiwp.ini=deleted�C:\WIN95\amilabel.ini=deleted�C:\WIN95\amiow.ini=deleted�C:\WIN95\amiwp.ini=deleted�C:\WIN95\amipro.ini=deleted�C:\WIN95\amismart.ini=deleted�C:\WIN95\lotus.ini=restored�C:\WIN95\amienv.dll=deleted

[Corel Corporation CorelDRAW! 5.0E2]�c:\zdbench\new\corel50b=deleted

[Borland dBase 5.0 for Windows]�c:\zdbench\new\dbase50=deleted

�[Microsoft Excel 5.0c for Windows]�c:\zdbench\new\excel50=deleted�C:\WIN95\excel5.ini=deleted

[Borland Paradox 5.0 for Windows]�c:\zdbench\new\pdox50=deleted�C:\WIN95\pdoxwin.ini=deleted

[Microsoft PowerPoint 4.0c for Windows]�c:\zdbench\new\ppnt40c=deleted�C:\WIN95\powerpnt.ini=restored

[Novell Quattro Pro 6.01 for Windows]�c:\zdbench\new\qpw60=deleted�C:\WIN95\qpw.ini=deleted

[Microsoft Word 6.0c for Windows]�c:\zdbench\new\word60c=deleted�C:\WIN95\winword6.ini=deleted

[Novell WordPerfect 6.1 for Windows]�c:\zdbench\new\wpwin61=deleted�C:\WIN95\wpcset.bif=deleted�C:\WIN95\wtapi.ini=deleted�C:\WIN95\wtspelus.sup=deleted�C:\WIN95\wtspelus.qcs=deleted

[Microsoft Works 3.0b for Windows]�c:\zdbench\new\works30=deleted�C:\WIN95\msworks3.ini=deleted

Running a Category suite� XE "Winstone 96:Running a category suite" �� XE "Category suite:Running" �� XE "Category score:Running a category suite" �� XE "Running:A category suite" �

Winstone 96 includes four application category suites, and when you run the main suite, Winstone 96 reports the overall score as well as scores for each of these category suites. In addition to running the main suite, you can also run each of the category suites individually. Each category suite runs just the application scripts for the applications within that category.

�The following table tells you which application scripts Winstone 96 runs when you choose a particular category suite.

This suite:�Runs the scripts for:��Business Graphics/DTP�PageMaker�CorelDRAW!�PowerPoint��Database�Access for Windows�dBASE�Paradox for Windows�Works for Windows*��Spreadsheet�1-2-3 for Windows�Excel�Quattro Pro for Windows�Works for Windows*��Word Processing�Ami Pro�Word for Windows�WordPerfect for Windows�Works for Windows*��To run a category suite:

1.	Select the category suite name from the list of suite names to the right of the Run function button or select Run | Winstone 96 Category from the Winstone 96 main menu bar.

2.	Choose the Run button after you select the suite name.

After you choose the Run button, if Winstone 96 finds any circumstance that may cause the suite to fail, it displays the Configuration Information window and warns you about the potential problem(s). (See Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�” beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37� for more information.)

Winstone 96 does basically the same thing when you run an application category suite as when you run its main suite. The differences between a category suite and the main suite are:

Winstone 96 runs only those application scripts included in that category.

Winstone 96 computes a score for just that category.

A category score isn’t an overall score for the PC. (For more information, , see Chapter 18, “� REF Chapter19CalculatesScore \* MERGEFORMAT �How Winstone 96 Calculates Its Scores�” beginning on page � PAGEREF Chapter19CalculatesScore �131�.)

How long it takes to run the category suites� XE "Category suite:How long it takes to run one" �

The time Winstone 96 takes to run its category suites varies based on the PC’s speed and configuration. Here are a couple of examples to give you an idea of how long it took to run this suites on machines in our research center. Faster machines will take less time, while slower machines will take more time.

Machine A is a typical Pentium 66 with 16MB of RAM.

Machine B is a typical 486SX/25 with 8MB of RAM (Winstone 96’s base machine).

This category suite:�Machine A:�Machine B��Business Graphics/DTP�10 minutes�34 minutes 20 seconds��Database�12 minutes 36 seconds�40 minutes 30 seconds��Spreadsheet�10 minutes 30 seconds�35 minutes��Word Processing�14 minutes 14 seconds�47 minutes 35 seconds��NOTE:	The time it takes to run all four category suites won’t equal the time it takes to run the main suite. Winstone 96 runs the Microsoft Works script in each of three different categories. This means, if you run all the category suites, Winstone 96 runs the Microsoft Works script three times instead of the one time it would run the script if you ran the main suite. So, the total execution times for all the category suites will be longer than the total execution time for the main suite.

Hands-free testing:  Running in batch mode

You don’t have to sit at the PC and click the buttons to run Winstone 96’s suites. To make the best use of your time, you may decide to run Winstone 96 in batch mode. When you run Winstone 96 this way, it gets the information it needs to run the suites from a file called RUNWS.INI. This file supplies the environment settings, the names of the tests Winstone 96 will run, and the names for the database files it produces. Winstone 96 includes a prototype RUNWS.INI file in the \ZDBENCH\WS96\UI directory on the CD-ROM.

NOTE:	You can only use the Winstone 96 RUNWS.INI file with Winstone 96. Winstone 95 won’t accept this file format.

To run Winstone 96 in batch mode:

1.	Copy the RUNWS.INI prototype file to another file name (for example, MYFILE.INI).

2.	Edit the new file so it contains the information Winstone 96 needs.

You can use any text editor to modify this file. You can also use the StepN section(s) of this file to refer to files that define suites to run in that step. The \ZDBENCH\WS96\SUITES directory on the CD�ROM that includes Winstone 96 contains the following sample files you can use to refer to in the StepN section(s):

This file:�Runs this suite:��OVERALL.WSS�Overall Winstone 96��BG_DTP.WSS�Business Graphics/DTP��DB.WSS�Database��SS.WSS�Spreadsheet��WP.WSS�Word Processing��For complete information on the different sections of the RUNWS.INI file you can modify, see the next section, “� REF _Ref335710547 \* MERGEFORMAT �Modifying the RUNWS.INI file�” beginning on page � PAGEREF _Ref335710550 �62�.

3.	After you’ve edited and saved the new file, run Winstone 96 with the AUTO command option and specify the name of the new file.

For example, if MYFILE.INI is the edited copy of the prototype file, you’d use the following command line:

WS96 AUTO MYFILE.INI

How you execute Winstone 96 in batch mode depends on the Windows shell you’re using.

If you’re using Program Manager, select Run from the Program Manager File menu. Use the Browse feature to enter the Winstone 96 command line, and then add the AUTO option and the name of the .INI file to that command line.

If you’re using Explorer, select Run from the Start menu. Use the Browse feature to enter the Winstone 96 command line, and then add the AUTO option and the name of the .INI file to that command line.

If you want to automate this process so Winstone 96 runs in batch mode each time Windows starts, you can add the Winstone 96 icon with the AUTO command line option and the name of the .INI file to the Windows StartUp group.

The next section explains in detail the different parameters within the RUNWS.INI prototype file that you can modify.

Modifying the RUNWS.INI file� XE "Batch mode:Modifying RUNWS.INI" �� XE "Winstone 96:Modifying RUNWS.INI" �� XE "RUNWS.INI file" �

You need to modify the following information in RUNWS.INI:

Environment settings.

The path name of the suites you want to run.

Names of the results files you want to save (you can have up to three).

The sections that follow explain the fields in each of these sections of the RUNWS.INI file.

The [Environment] fields� XE "RUNWB.INI:[Environment] fields" �

Normally Winstone 96 remembers any changes you make to the environment settings using the Disclosure Questionnaire in the DISCLOSE.INI� XE "DISCLOSE.INI" � file. You can override the settings in the DISCLOSE.INI file by copying entries from the ChangedByUser or NotChangedByUser sections in that file to the [Environment] section of the RUNWS.INI and then modifying those entries.

In addition, you can use the following DOS environment variables to override some of the entries in DISCLOSE.INI.

Entry�Environment Variable��PIN�PIN��Variant1�VARIANT1��Variant2�VARIANT2��Variant3�VARIANT3��Variant4�VARIANT4��Variant5�VARIANT5��Project�PROJECT��Tester Name�TESTER��Tester Organization�TESTORG���The [Environment] section also contains options for Winstone 96’s Refresh Rate, Cursor Type, and Color Reproduction tests. These tests, with your help, can determine an appropriate value for the following fields. You can enable these tests by removing the semicolon (;) at the beginning of each line.

;Display Refresh Rate=Determine With Test�;Display Cursor Type=Determine With Test�;Display Color Reproduction=Determine With Test

The [Options] fields

The second part of the RUNWS.INI file contains the [Options] fields.

The first field lets you set whether Winstone 96 exits Windows when it finishes running the batch file. Setting ExitWindows to True means Winstone 96 will exit Windows and return to the DOS prompt when the suite finishes. The default value for this setting is False, so Winstone 96 normally exits and leaves Windows running.

ExitWindows=False

The next field lets you set whether Winstone 96 quits (closes its main window) when it finishes running in batch mode. Setting ExitBenchmark to True causes Winstone 96 to exit when it finishes the test(s). The default value is True.

ExitBenchmark=True

The final field is DemoMode. You can use this option to run Winstone 96’s demo mode in batch mode. Setting DemoMode to True causes Winstone 96 to run the suite specified in the first step in demo mode. The default value is False.

Winstone 96 won’t save any scores when it runs in demo mode, and it’ll ignore the ExitBenchmark and ExitWindows settings, as well as all sections named [StepN], where N is larger than 1.

DemoMode=False

The final fields in the [Options] section concerns the Custom Configuration window. Setting the following option to Yes causes Winstone 96 to check for potential problems.

Display Winstone problems before testing=no

Setting the following options to Yes causes Winstone 96 to check the Configuration Information. The default value for each option is No.

Display tips before testing=No�Display custom configuration before testing=No

If you enable the custom configuration above, you must supply the full path name of the custom configuration file in the next item.

Custom configuration file=pathname

The [Messages] field

The third section of the RUNWS.INI file contains the [Messages] field. This field contains a time-out value in seconds and a string Winstone 96 displays in a message box after it starts. This field is optional. A time-out value of 0 means Winstone 96 displays the message box until you close it.

NOTE:	Winstone 96 replaces tilde characters (~) with line breaks in the actual message box.

InitMessage=10,Winstone 96 is starting.

The [StepN] fields

The last section in the RUNWS.INI file is the [StepN] section. You can repeat this section as many times as you want, with N starting at 1 and increasing.

Each [StepN] section lists a file name. The file listed specifies which Winstone 96 suite to run, options Winstone 96 uses while running that suite, and the names of the database files to save. You can also specify comparison machines you wish to use in the Chart and Table of Results. This option is useful, however, only in the last StepN section.

The first field in each [StepN] section is the Suite= field. This field specifies the path name of the suite file that contains the suite to run and/or display. The prototype file list the OVERALL.WSS suite file as an example.

�The \ZDBENCH\WS96\SUITES directory on the CD�ROM that includes Winstone 96 contains the following sample files you can use to refer to in the StepN section(s):

This file:�Runs this suite:��OVERALL.WSS�Overall Winstone 96��BG_DTP.WSS�Business Graphics/DTP��DB.WSS�Database��SS.WSS�Spreadsheet��WP.WSS�Word Processing��With Winstone 96, you can only list one suite in each StepN file. For example, you can’t list three category suites in one StepN file.

The next fields let you supply a Description and Comments for the custom suite files you define in each StepN. Winstone 96 adds the information in these fields to your database file. (If you were running the suite interactively, you’d change these fields using the Disclosure Questionnaire.)

Description=Tester Must Supply�Comments=Tester Must Supply

The next field specifies whether you want Winstone 96 to clear its scores for one step before running another. If you set ClearResults to False, Winstone 96 won’t clear scores between each StepN. The default value is True, meaning Winstone 96 forgets all previous scores at the start of each step.

ClearResults=True

The next field lets you prevent Winstone 96 from running the suite specified in the step. If you set DontRunTests to True, Winstone 96 won’t run the suites listed in the file name specified by the File= option. You might find this option useful if you want to display scores from comparison machines without actually running the suites. The default value is False, meaning Winstone 96 will run the suite listed in the file specified by the File= option.

DontRunTests=False

�The next field, CompareN, lets you specify up to four comparison machine results files you wish to use in the Table and Chart of Results. These settings are all optional.

Compare1=exports\results1.txt�Compare2=exports\results2.txt�Compare3=exports\results3.txt�Compare4=exports\results4.txt

The next field lets you prevent Winstone 96 from displaying the current score(s) in the Chart of Results. If you set IncludeResults to False, Winstone 96 doesn’t display the current score(s). You must specify at least one comparison machine to exclude the current results from the Chart of Results. The default value is True, meaning Winstone 96 displays the current score(s) in the Chart of Results.

IncludeResults=True

The next fields, StartMessage and EndMessage, each contain a time�out value in seconds and a string Winstone 96 displays in a message box at the beginning and end of the step. Both messages are optional. If you set the time�out value to 0, Winstone 96 displays the message box until you close it. (Winstone 96 replaces any tilde characters (~) in the message with line breaks in the actual message box.)

StartMessage=10,Winstone 96 is about to start running the custom suite.�EndMessage=10,Winstone 96 has saved the results in the file RESULTS.TXT.

The next field lets you specify the path name of the database where you wish to save the results file for the step. If you want to save results in a database, uncomment the Database field and enter the path name of the database directory.

;Database=c:\zdbench\results

The final field in the StepN section tells Winstone 96 what to name the results file for that particular step. Using these fields, you can produce three types of result files or any subset of the results files you like.

TextFile=exports\results.txt�XLSFile=exports\results.xls�CSVFile=exports\results.csv

Seeing Winstone 96 in action:  Running demo mode� XE "Winstone 96:Running:Demo mode" �� XE "Demo mode" �� XE "Running:Demo mode" �

Once you install Winstone 96, you can run it in a demonstration mode. Demo mode offers a way to run Winstone 96 repeatedly without manual intervention. You may find demo mode useful if you want to show Winstone 96 to groups of people (for example, at a trade show or office gathering) or if you just want to see what the benchmark can do.

To run Winstone 96 in demo mode, select Demo Mode from the Run menu in the main window.

NOTE:	To run Winstone 96 in demo mode from batch mode, see the previous section, “� REF _Ref333742903 \* MERGEFORMAT �Hands-free testing:  Running in batch mode�” beginning on page � PAGEREF _Ref333742903 �60�.

When you run Winstone 96 in demo mode, it runs the suite currently selected in the list of suite names to the right of the Run function button, displays that suite’s score, and then runs the same suite over and over again. For example, if you have the Word Processing category suite selected, Winstone 96 runs just that suite for the demo.

Because running the same suite over and over again can cause the PC’s resources to get low, demo mode runs the selected suite five times, exits Winstone 96, restarts Windows to free resources, and restarts Winstone 96. Demo mode then continues to run the selected suite until you stop it.

NOTE:	If you normally enter a password to start Windows, you’ll have to enter the password when Winstone 96 restarts Windows.

You can stop demo mode in two ways:

Press any key or click a mouse button when Winstone 96 displays its Chart of Results.

Choose the Cancel button when Winstone 96 installs an application’s files.

NOTE:	Every time you start one of Winstone 96’s suites, even when you’re running the benchmark in demo mode, Winstone 96 automatically checks to make sure the PC meets its minimum requirements. If you haven’t disabled the configuration check, Winstone 96 automatically displays the Configuration Information window before running the suite. When you run Winstone 96 in demo mode, it only displays this window before it runs the suite the first time.

	For more information on this window, see Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�,” beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37�.

Exiting Winstone 96� XE "Exiting" �� XE "Winstone 96:Exiting" �

You can exit Winstone 96 from its main window by:

Choosing the Exit button or using the key sequence Alt�x.

Choosing Exit from the File drop-down menu.

Choosing the Close command from the Control menu for the main window.

End of Chapter

�Chapter 11: �What Do All These Buttons and Menus Do?

This chapter lists the standard conventions of the Winstone 96 user interface. It also describes each of Winstone 96’s menu items, function buttons, and icons and explains the basics of what happens when you choose one of these items.

Sections in this chapter

� REF _Ref298750635 \* MERGEFORMAT �Standard conventions Winstone 96 uses�

� REF _Ref298750676 \* MERGEFORMAT �Opening the main window�

� REF _Ref298751157 \* MERGEFORMAT �Using the menu bar�

� REF _Ref298751138 \* MERGEFORMAT �Using the Functions buttons�

� REF _Ref299438944 \* MERGEFORMAT �Using the icons in Winstone 96’s main window�

Standard conventions Winstone 96 uses� XE "Winstone 96:Standard Windows conventions" �

When you work with Winstone 96’s windows, screens, and menus, you can use some standard conventions for Windows with which you may already be familiar. For example:

Clicking and double-clicking (pressing a mouse button twice very quickly) to select items. Generally, if you click on an item, such as an icon or a name in a list, you’re selecting that item and Winstone 96 highlights it. If you double�click on an item, Winstone 96 takes an action associated with that item. For example, if you double-click on the Winstone 96 icon, the Winstone 96 main window appears.

Using drop-down menus from the main menu bar in a window. Winstone 96 presents some of its options as menu titles in the main menu bar. When you select one of these menu titles, such as File, a drop-down menu appears displaying the menu items available. In some cases, the drop-down menus duplicate actions you can perform using Winstone 96’s functions buttons. In most cases, the drop�down menus give you additional options, such as changing the test settings before you run a suite and getting information on how to contact us.

Resizing and moving windows. You can minimize, maximize, and resize most of Winstone 96’s windows, such as the Winstone 96 Chart and Table of Results, the same way you work with other windows now.

Using keyboard commands to select items instead of using the mouse. Press the Alt key and the underlined access character of the item you want to select. This item can be one of the Winstone 96 function buttons, a menu title, a menu item within a drop-down menu, or a button within a window.

Opening the main window� XE "Winstone 96:Opening the main window" �� XE "Main window:Opening" �� XE "Opening the main window" �

To open the main window, choose Winstone 96 in the Ziff�Davis Benchmarks program group.

NOTE:	The first time you start Winstone 96, you’ll need to license and register the software. The licensing information screens are pretty much self�explanatory.

	If Winstone 96 fails during initialization, you can use the following command line options to disable Winstone 96’s automatic detection of some disclosure fields.

The NOCPUCHECK option prevents Winstone 96 from detecting the CPU type and speed and the FPU type.

The NOVIDCHECK option prevents Winstone 96 from detecting the display refresh rate, VESA support, and graphics adapter types. The NOVIDCHECK option is useful if display corruption occurs after Winstone 96 initializes.

The NOREGCHECK option prevents Winstone 96 from gathering information from the Windows 95 or Windows NT registry.

The NOSYSCHECK option disables nearly all detection.

When you start Winstone 96, it briefly displays its logo and About box before displaying the main window.

Winstone 96’s main window essentially contains the following parts:

The main menu bar.

The Functions window.

Winstone 96’s icons.

The rest of this chapter explains what the different menus and buttons do when you choose them.

Using the menu bar

Winstone 96’s main menu bar contains several menu options.

NOTE:	The Chart menu option only displays when you have the Chart of Results open.

In some cases, you can perform the same actions using Winstone 96’s functions buttons. In most cases, you can use the menu bar options to perform tasks not defined in the Functions window, such as changing the test settings before you run a suite or starting demo mode.

The sections that follow explain each of the menu options from left to right as they appear on the menu bar.

The File menu� XE "Menu bar:File" �

If you choose File, you’ll see the following options in the drop-down menu.

Save...� XE "File:Save..." �

The Save... option in the File menu performs the same function as the Save button in the Functions window. When you choose this option, Winstone 96 displays the Save to Database dialog box. You can use this dialog box to save the current results to a database. You can also select another database using the Database... button in the Save to Database dialog box.

For more information on how to save results and use this window, see page � PAGEREF _Ref298743402 �96�.

Compare...� XE "File:Compare..." �

The Compare... option in the File menu performs the same function as the Compare function button. When you choose this option, Winstone 96 displays the Comparison Machines dialog box. You use this dialog box to select which results you want to display. You can select results from a database, or you can import files you exported in previous Winstone 96 sessions.

For information on how to view scores for different PCs, see the section “� REF _Ref298740614 \* MERGEFORMAT �Adding results to the display�” on page � PAGEREF _Ref298740632 �98�.

Export� XE "File:Export" �

When you choose Export from the File menu, Winstone 96 displays the Export submenu.

The following chart explains what kind of results files you can export.

You can export:�Which contains:�In this format:��Current Results�Results and Disclosure for the tests run in the current session�.TXT, .CSV, or .XLS��Chart of Results�Results the Chart of Results currently displays�.WMF��Table of Results�Results currently listed in the Table of Results�.TXT��Disclosure�Information currently listed in the Disclosure window�.TXT��Choosing any of the above options displays the Export Results to File dialog box. For more information on using this dialog box, see page � PAGEREF _Ref298744197 �102�.

Print Setup...� XE "File:Print Setup..." �

Choosing the Print Setup... option opens the Print Setup dialog box.

From this dialog box, you can change the printer, paper source, paper size orientation, number of copies you’d like to print, and other printer options. For more information on how to use a printer setup dialog box, consult the Windows operating system documentation.

Print� XE "File:Print" �

When you choose Print from the File menu, the Print submenu appears.

The Print submenu lets you select whether you want to print the Current Results, the Chart or Table of Results, or the Disclosure information. Winstone 96 prints the item you choose to the currently selected default printer.

For complete details on Winstone 96’s Print options, see page � PAGEREF _Ref298744939 �101�.

Merge Databases...� XE "File:Merge Databases..." �

When you choose Merge Databases... from the File menu, Winstone 96 displays the Merge Database dialog box. You use this dialog box to specify the target and source databases for two databases whose records you want to merge. For information on how to use this dialog box, see page � PAGEREF _Ref333895517 �101�.

Delete...� XE "File:Delete..." �

If you choose Delete... from the File menu, Winstone 96 displays the Delete Results from Database dialog box. Winstone 96 lets you delete individual records from its database of results. For information on how to use this dialog box, see page � PAGEREF _Ref299772795 �100�.

Exit� XE "File:Exit" �

Choosing the Exit option from the File menu performs the same function as choosing the Exit function button. When you choose Exit, Winstone 96 restores the PC’s pre-test environment, closes the main window, and quits the program.

NOTE:	If you haven’t yet saved the results, Winstone 96 warns you before it exits and gives you a chance to save those unsaved results.

The Edit menu� XE "Menu bar:Edit" �

If you choose Edit, you’ll see the following options in the drop-down menu.

Copy� XE "Edit:Copy" �

The Copy option lets you copy information from the active window to the clipboard. If you have the Chart or Table of Results or the Disclosure window open, the Copy option is active (you can select it). Otherwise, this menu option is dimmed (you can’t select it).

�Display� XE "Edit:Display" �

You can use the Display menu to change the way Winstone 96 displays its scores. When you select this option, Winstone 96 displays the following submenu:

The following chart explains each of the Display menu options.

Choosing this option:�Displays:��All Categories�Scores for the main suite and category suites.��Categories Run�Scores for the suites run during the current session.��Selected Categories�Scores for the suites as specified in the drop-down list of suites to the right of the Run function button. For example, if the drop-down list displays “Word Processing,” then Winstone 96 displays the score(s) for its Word Processing suite.��Clear Curren� XE "Edit:Clear Current Results" �t Results

Choosing the Clear Current Results option removes all the results for the current session from the display. If you’ve saved all the results for the current session, this option doesn’t delete those results from the database. It just removes the results from the Chart and Table of Results, so you don’t see them any more.

To delete results permanently from the results database, use the Delete... option from the File drop-down menu or consult the section “� REF _Ref298818419 \* MERGEFORMAT �Deleting results permanently from the database�” on page � PAGEREF _Ref298818428 �100� for complete information on this option.

Disclosure Questionnaire...

When you select Disclosure Questionnaire... from the Edit menu, Winstone 96 displays the Disclosure Questionnaire. From this window, you can edit the Disclosure information about the test PC. For more information, see page � PAGEREF _Ref298830710 �82�.

Settings...

When you select Settings... from the Edit menu, Winstone 96 displays its Test Settings dialog box. From the Test Settings dialog box, you can change the base and/or work directories Winstone 96 uses. For information on how to use this dialog box, see page � PAGEREF _Ref299166580 �34�.

The Run menu� XE "Menu bar:Run menu" �

If you choose Run in the menu bar, you’ll see the following options in the drop�down menu.

Configuration Information...

When you run a suite, Winstone 96’s configuration check makes sure the PC meets a minimum set of requirements and then reports any areas that may cause the test to fail in the Configuration Information window.

When you select Configuration Information... from the Run menu, Winstone 96 displays the Configuration Information window. For details on how to use this window, see Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�” beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37�.

Overall Winstone 96

If you want to run the main suite, select the Overall Winstone 96 option from the Run menu. For information on what the main suite does when you run it, see Chapter 18, “� REF Chapter18WhattheSuitesDo \* MERGEFORMAT �What the Suites Do�” beginning on page � PAGEREF Chapter18WhattheSuitesDo �127�.

Winstone 96 Category

When you select Winstone 96 Category from the Run menu, Winstone 96 displays the following submenu:

Demo Mode� XE "Run:Demo Mode" �

When you run Winstone 96 in demo mode, it runs the suite currently selected in the list of suite names to the right of the Run function button, displays that suite’s score, and then runs the same suite over and over again. For example, if you have the Word Processing category suite selected, Winstone 96 runs just that suite for the demo.

Because running the same suite over and over again can cause the PC’s resources to get low, demo mode runs the selected suite five times, exits Winstone 96, restarts Windows to free resources, and restarts Winstone 96. Demo mode then continues to run the selected suite until you stop it.

You can stop demo mode in two ways:

Press any key or click a mouse button when Winstone 96 displays its Chart of Results.

Choose the Cancel button when Winstone 96 installs an application’s files.

For more information on running demo mode, see page � PAGEREF _Ref333742910 �67�.

The Chart menu� XE "Menu bar:Chart" �� XE "Chart menu" �

Winstone 96 only displays the Chart menu when the Chart of Results is active. You can use the Chart menu to include or not include results from the current test run in the Chart’s display.

If you turn on Include Current Results from the Chart menu, Winstone 96 always includes the results from the current test run in its display. Include Current Results is turned on when there’s a check mark to the left of the menu option.

The Window menu� XE "Menu bar:Window" �

The Window menu lets you manipulate and arrange Winstone 96’s windows. If you choose Window in the menu bar, you’ll see the following options in the drop-down menu.

Arrange Windows� XE "Window menu:Arrange Windows" �

Choosing Arrange Windows layers Winstone 96’s open windows in a cascading manner, one on top of the other.

Arrange Icons� XE "Window menu:Arrange Icons" �

Choosing Arrange Icons lines up Winstone 96’s icons in the lower, left-hand corner of Winstone 96’s main window.

1-4

You can select the Winstone 96 window you want to make active from the list of windows numbered one through four.

The Help menu� XE "Menu bar:Help" �

If you choose Help from the menu bar, you’ll see the following options in the drop�down menu.

Contents� XE "Help menu:Contents" �

Choosing Contents displays the contents page for Winstone 96’s on-line help. Winstone 96’s help facility works like other Windows-based help tools. You use the mouse to select topics in the on-line help window, and Winstone 96 displays text explaining the topics you select.

Search for Help On...� XE "Help menu:Search for Help On..." �

Choosing Search for Help On... opens the Windows Search dialog box. You can use this box to look for specific topics in Winstone 96’s on-line help.

How to Use Help� XE "Help menu:How to use Help" �

If you choose How to Use Help, Windows displays information explaining how to use hypertext on-line help documents.

License� XE "Help menu:License" �

Choosing License displays Winstone 96’s license agreement.

Contacting ZDBOp� XE "Help menu:Contacting ZDBOp" �

If you choose Contacting ZDBOp, Winstone 96 displays the portion of its on-line help that tells you how to contact us if you have problems with or questions about the software.

About Winstone 96...� XE "Help menu:About Winstone 96..." �

Choosing About Winstone 96... displays our copyright information. From this window you can read the license agreement by choosing the License... button, and you can view the names of the people who worked on the software by choosing the Credits... button.

Using the Functions buttons

Winstone 96’s Functions window contains six functions buttons.

In some cases you can perform these same functions from Winstone 96’s drop-down menus in the main window’s menu bar.

The sections that follow explain each of these functions buttons.

The About Winstone 96... button� XE "About Winstone 96... button" �� XE "Functions window:About Winstone 96..." �

Choosing the About Winstone 96... button displays Winstone 96’s copyright information. From this window, you can view the license agreement by choosing the License... button, or you can read about the people who developed Winstone 96 by choosing the Credits... button.

The Run button� XE "Run button" �� XE "Functions window:Run" �

Choosing the Run button starts the suite listed in the box to the right of the button. For example, if the text box displays “Overall Winstone 96,” when you choose Run, Winstone 96 starts its main suite.

NOTE:	To see the list of names, select the down arrow to the right of the box.

The Save... button� XE "Save... button" �� XE "Functions window:Save..." �

Choosing the Save... button displays the Save to Database dialog box. You use this dialog box to save the current results to Winstone 96’s database. You can also change the database using the Database... button. For complete information on how to save results to the database and how to use this dialog box, see page � PAGEREF _Ref298743402 �96�.

The Compare... button� XE "Compare... button" �� XE "Functions window:Compare..." �

Choosing the Compare... button displays Winstone 96’s Comparison Machines dialog box. You can use this dialog box to select results you want to display in the Chart and Table of Results. For complete information on how to add results to the display, see page � PAGEREF _Ref298815839 �98�.

The Help button� XE "Help button" �� XE "Functions window:Help" �

Choosing the Help button displays Winstone 96’s on-line help.

Winstone 96’s help facility works like other Windows-based help tools. You use the mouse to select topics in the on-line help window, and Winstone 96 displays text explaining the topics you select.

The Exit button� XE "Exit button" �� XE "Functions window:Exit" �

Choosing the Exit button closes Winstone 96’s main window and quits the program. If you have unsaved results, Winstone 96 first asks you if you want to save them. Winstone 96 also restores the PC’s environment to pre-test condition before exiting.

Using the icons in Winstone 96’s main window

When you start Winstone 96, it opens and iconizes three windows—the Disclosure, Chart of Results, and Table of Results windows. The sections that follow explain each of these windows.

Disclosure� XE "Disclosure:Icon" �

The Disclosure window displays information about the PC’s configuration. You can also view system information about comparison machines from the Disclosure window. For information on using and editing Disclosure information, see page � PAGEREF Chapter12WorkingwithDisclosure �81�.

To open this window, choose its icon or select the Disclosure option from the Window drop�down menu.

Chart of Results� XE "Chart of Results:Icon" �

The Chart of Results contains a bar-graph chart of Winstone 96 scores. You can change which suite scores Winstone 96 displays in the Chart of Results using the Edit | Display submenu.

Winstone 96 automatically displays the Chart of Results when it completes a suite. You can open this window by choosing its icon or selecting the Chart of Results option from the Window drop�down menu. You can iconize, maximize, and resize this window as you can other application windows.

For more information on how to interpret the graphs in the Chart of Results, see Chapter 14, “� REF Chapter14WhatNumsMean \* MERGEFORMAT �What Do All These Numbers Mean�,” beginning on page � PAGEREF Chapter14WhatNumsMean �103�.

Table of Results� XE "Table of Results:Icon" �

The Table of Results shows Winstone 96 scores in column format. You can change which suite scores Winstone 96 displays in the Table of Results using the Edit | Display submenu.

Winstone 96 doesn’t automatically display the Table of Results when it completes a suite. You can open this window by choosing its icon or selecting the Table of Results option from the Window drop�down menu. You can iconize, maximize, and resize this window as you can other application windows.

For more information on how to interpret the numbers in the Table of Results, see Chapter 14, “� REF Chapter14WhatNumsMean \* MERGEFORMAT �What Do All These Numbers Mean�,” beginning on page � PAGEREF Chapter14WhatNumsMean �103�.

End of Chapter

�Chapter 12: �Working with Disclosure Information

When you run a suite, Winstone 96 gathers information about the PC and stores that information in its Disclosure. This chapter explains how you can view, make changes to, and print Disclosure information.

Sections in this chapter

� REF _Ref298830697 \* MERGEFORMAT �Viewing Disclosure information�

� REF _Ref298830710 \* MERGEFORMAT �Editing information in the Disclosure Questionnaire�

� REF _Ref298830733 \* MERGEFORMAT �Printing Disclosure information�

Viewing Disclosure information� XE "Disclosure:Viewing information" �

When you start Winstone 96, it checks the PC’s configuration and stores the information it finds in the Disclosure. When you save a set of scores, Winstone 96 saves the disclosure information for that set of scores. If you publish results, you’ll need to include information in the Disclosure with the results you publish. (For information on what you must include when you publish results, see page � PAGEREF _Ref304267582 �119�.)

NOTE:	If you run and save several suites and save the results on the same PC with the exact same configuration, Winstone 96 only stores the PC’s configuration information once to conserve disk space.

If you want to add to or change information in the Disclosure, choose the Edit button. (The section “� REF _Ref298830710 \* MERGEFORMAT �Editing information in the Disclosure Questionnaire�” on page � PAGEREF _Ref298830710 �82� explains how to edit the different fields in the Disclosure Questionnaire.)

Viewing Disclosure information for the current displayed scores

To view the disclosure information for each set of scores currently displayed in the Chart and Table of Results, choose Window | Disclosure from Winstone 96’s main menu or choose the Disclosure icon from Winstone 96’s main window.

By default, Winstone 96 displays the disclosure information for the current set of scores first. Winstone 96 uses a drop�down list to display the Description for each set of scores you’re currently displaying.

Disclosure information for a PC will most likely cover more than one page of the Disclosure window. Use the scroll bars to view portions that don’t fit within the boundary of the window.

Viewing Disclosure information for other sets of scores

To look at disclosure information for another set of scores:

1.	Select the down arrow to the right of Current Results.

2.	Select the Description for the set of scores whose Disclosure information you wish to view.

Winstone 96 then changes the display to show the Disclosure information for that test run.

Editing information in the Disclosure Questionnaire

If you need to add to or change the Disclosure information Winstone 96 gathers about the PC, you can edit the Disclosure Questionnaire. To edit the questionnaire:

1.	Choose Edit | Disclosure Questionnaire from the Winstone 96 main menu bar.

Winstone 96 opens the Disclosure Questionnaire window.

2.	Select the group on the left-hand side of this window that corresponds to the area of the questionnaire you wish to edit.

When you select one of these groups, Winstone 96 changes the Disclosure Questionnaire window to display just the information about that group.

For example, if you want to edit the Description, select the button beside Description, and Winstone 96 changes the display in the window to the Description information.

3.	Choose the Update Disclosure button once you have the questionnaire the way you want it.

If at any point you wish to exit the Disclosure Questionnaire window without saving the changes and updating the disclosure, choose the Cancel button.

To learn more about the information in the Disclosure Questionnaire, read the sections that follow.

Description� XE "Disclosure:Description" �� XE "Description information" �

When you select the Description button, Winstone 96 displays the test description information.

NOTE:	Before you can save results, you’ll need to enter a test description.

To enter a test description, insert the cursor in the Description text box and type in the test description you want. The name you enter can be any combination of letters, numbers, symbols, and spaces. If you haven’t yet saved results, Winstone 96 uses the default “Current Results” for the test description.

NOTE:	Winstone 96 uses the test description you enter along with other identifiers, like a date and time stamp, as qualifiers for the results you save.

Display� XE "Disclosure:Display" �� XE "Display information" �

When you select the Display button, Winstone 96 changes the questionnaire to show the information about the PC’s display subsystem.

The Display information includes information on the PC’s graphics adapter make and model, BIOS version and date, and amount of DRAM and VRAM. Winstone 96 may not be able to determine all this information about the PC. You can use the Display window to add or correct the information about the PC’s display.

You can also run three different display tests from the Display window—Refresh Rate, Cursor Type, and Color Reproduction. The sections that follow explain how to run each of these tests.

Determining the refresh rate

You can use the Refresh Rate button in the Display window to determine the actual refresh rate of the PC’s graphics card. The refresh rate is the frequency at which the PC’s graphics adapter redraws the monitor’s display. Higher refresh rates reduce screen flicker but can decrease graphics drawing performance because of the time it takes to refresh the screen. Common refresh rates are 60, 72, and 86 (43 interlaced) Hertz. (Hertz (Hz) is a unit of measurement that here indicates the number of times a graphics adapter redraws the screen per second.)

NOTE:	To compare two graphics cards fairly, both should generally use the same refresh rate.

To determine the refresh rate for the PC’s display, follow the steps below.

1.	Select the Refresh Rate... button from the Display window.

Winstone 96 opens the Refresh Rate Detection window.

This window contains three sections—the instructions on the left�hand side, the list of keys in the upper-right corner, and the refresh rectangle in the lower�right corner.

NOTE:	If the current display mode is VGA register-level compatible, Winstone 96 automatically computes the refresh rate. You can then use the Refresh Rate Detection window to verify or refine the rate Winstone 96 computed. (Winstone 96 may be off by as much as a few Hz.)

When you first open the window, Winstone 96 attempts to calculate the refresh rate; so, the refresh rectangle is blank. You’ll see a message that says “Please Wait.” Winstone 96 then repeatedly redraws the refresh rectangle, first in black, and then in white, over and over again.

The Target value indicates the redraw rate of the rectangle Winstone 96 is attempting to achieve. The Rate value indicates the actual redraw rate of the rectangle.

You should wait until the Rate value settles to the Target value before proceeding. The Rate value will first rise to above 100 Hz and then settle to the Target value. It may take a few seconds before the Rate and Target values match.

When the Rate and Target values settle, one of two things has happened:  either Winstone 96 determined the refresh rate within a couple of Hz, or it has set the initial target rate to 60 or 72 Hz, depending on the size of the display. If the graphics adapter is operating in a VGA register�set compatible mode, Winstone 96 can determine the refresh rate of the display to within a couple of Hz.

NOTE:	The numbers below the Target and Rate values are for ZDBOp internal use.

2.	Use the keys listed above the refresh rectangle to adjust the refresh rate.

NOTE:	You shouldn’t move the mouse during this test. Instead, use the key sequences the window describes.

To determine the actual refresh rate of the display, adjust the redraw rate of the rectangle until a single, steady, thin diagonal line appears. The line will jump once per second, but it otherwise should not move.

You can use the number keys, 1 through 9, to set the Target rate to 10 through 90 Hz in increments of 10 Hz. You can use the function keys to decrease or increase the Target rate in increments of 10 Hz, 1 Hz, or .1 Hz.

F4:	decrease by 10 Hz�F5:	decrease by 1 Hz�F6:	decrease by .1 Hz�F7:	increase by .1 Hz�F8:	increase by 1 Hz�F9:	increase by 10 Hz

NOTE:	Wait a few seconds between keystrokes to allow the Rate value of the rectangle to match the Target value. Each time you select a key, Winstone 96 immediately adjusts the Target value. It then must adjust the Rate value of the rectangle’s display to match that target. Sometimes adjusting the rate can take a few seconds.

If the redraw rate is close to the actual refresh rate of the display, you need to refine the rate using the function keys. If the refresh rate is not close, you need to first use the number keys to narrow the rate and get it close.

If the initial Target rate Winstone 96 uses is close to the actual refresh rate of the display, you’ll see a thin black and white line on a flickering gray background in the refresh rectangle. The line will jump about once a second. Between jumps, it may be moving to the left or right or it may be steady.

To determine the actual refresh rate, you need to refine the Target rate using the function keys until the line is steady between jumps. First use the F5 and F8 keys to adjust the Target rate until you find two rates that are 1 Hz apart—one that moves the line to the left and one that moves the line to the right. Then, use the F6 and F7 keys to steady the line. If the line is moving to the right, use the F5 and F6 keys. If the line is moving to the left, use the F7 and F8 keys. Be sure to wait for the Rate value to settle to the Target value before pressing another key.

NOTE:	You may not be able to produce a completely steady diagonal line. In this case, reduce the line’s movement as much as possible.

If Winstone 96 does not pick an initial Target rate that is close to the actual refresh rate of the display, you’ll see black and white moving bands in the refresh rectangle. You need to hunt for a rate that produces a thin diagonal line (or at least thinner bands). Beginning with 1 and progressing in order, press each of the number keys from 1 to 9. Remember to wait for the Rate value to settle to the Target value before pressing another key.

Watch for a Target rate that produces a thin band or line in the refresh rectangle. After you’ve examined all of the rates (from 10 to 90 Hz), return to the rate that produced the thinnest band or line. Next, use the F5 and F8 keys to reduce the width of the band or line until you can see a thin black and white line on a gray flickering background. Then, use the F6 and F7 keys to steady the line. If the line is moving to the right, use F6. If the line is moving to the left, use F7. You can then refine the rate using the technique in the bullet item above.

3.	Press Enter once you’ve determined the correct refresh rate.

NOTE:	You can press Esc at any time to exit the window without adjusting the refresh rate.

Once you’ve determined the refresh rate, Winstone 96 displays the Interlaced Monitor Detection window.

Winstone 96 uses this window to determine whether the PC’s screen is an interlaced or a non�interlaced screen. A graphics adapter draws an interlaced screen in two steps. First, it draws the odd scan lines of the screen from top to bottom, and then it draws the even scan lines from top to bottom. A graphics adapter draws a non�interlaced screen completely from top to bottom before drawing it again.

So, if the PC’s screen is interlaced, the Refresh Rate test determines a rate twice the actual refresh rate. The Interlaced Monitor Detection window determines whether the PC’s screen is interlaced or non�interlaced and automatically corrects the Refresh Rate if the screen is interlaced.

The Interlaced Monitor Detection window contains three sections—the instructions on the left�hand side, the list of keys in the upper-right corner, and the rectangle in the lower-right corner.

When you first open the window, Winstone 96 attempts to match the redraw rate of the rectangle to the refresh rate you determined in the previous Refresh Rate Detection window. So, the rectangle is blank, and Winstone 96 displays a message that reads “Please Wait.” Winstone 96 then repeatedly redraws the refresh rectangle, first in black, and then in white, over and over again.

To use this window, follow the steps listed below.

1.	Wait until the Please Wait message disappears.

2.	Enter either “N” or “I” depending on the way the rectangle appears.

If the rectangle appears gray or consists of very thin, alternating black and white horizontal lines, select the letter “N” (for non�interlaced). Winstone 96 automatically enters the refresh rate in the Disclosure Questionnaire window.

NOTE:	If the PC has a non-interlaced screen, Winstone 96 displays the refresh rate in the Disclosure Questionnaire window in Hz without any other notation.

If the rectangle appears black and white or consists of two horizontal black and white bands, select the letter “I” (for interlaced). Winstone 96 automatically enters the refresh rate in the Disclosure Questionnaire window.

NOTE:	If the PC has an interlaced screen, Winstone 96 displays the refresh rate with the notation “(Interlaced)” to the right of the Hz value.

	Most monitors use horizontal scan lines. The above discussion applies to such monitors. Some monitors use vertical scan lines. These are typically monitors you can rotate between landscape and portrait orientations.

	Winstone 96 uses a heuristic test to determine if the PC’s monitor uses vertical or horizontal scan lines and modifies the Refresh Rate test appropriately. If Winstone 96 determines the monitor uses horizontal scan lines, it puts an “H” in the Refresh Rate text box. If it determines the monitor uses Vertical scan lines, it puts a “V” in the Refresh Rate text box.

	Winstone 96 won’t always make the correct scan line orientation determination. You can use the “H” and “V” keys to tell Winstone 96 that the monitor uses vertical or horizontal scan lines. These tests will work correctly only if Winstone 96 determines or is told the correct scan line orientation.

	The Refresh Rate and Interlace Detection tests appear a little different from the description above when testing with vertical scan lines. The diagonal line in the Refresh Rate test is rotated 90 degrees and moves up and down instead of left and right. The rectangle in the Interlace Detection dialog is also rotated by 90 degrees. The instructions in the dialog will reflect these differences.

Determining the cursor type� XE "Disclosure:Cursor Type" �� XE "Winstone 96:Cursor Type test" �� XE "Cursor Type" �

The Cursor Type test determines whether the graphics adapter supports a hardware or software cursor. If the PC’s graphics adapter does not have a hardware cursor, Windows must remove and redraw the cursor when application programs perform a paint operation near it. If the Windows graphics adapter has a hardware cursor, it can avoid this overhead.

To use this feature:

1.	Select the Cursor Type... button from the Display window.

Winstone 96 opens the Cursor Type Detection window.

2.	Place the mouse cursor over the colored rectangle on the left side of this window.

Winstone 96 continually redraws the rectangle using different colors.

3.	Answer the question in the Cursor Type Detection window.

If the cursor disappears or flashes when you place or move it over the colored rectangle, answer yes. The graphics adapter doesn’t have a hardware cursor, and Winstone 96 automatically enters Software in the Cursor Type field in the Display window.

If the cursor remains steady and doesn’t disappear or flash, answer no. The graphics adapter has a hardware cursor, and Winstone 96 automatically enters Hardware in the Cursor Type field in the Display window.

Determining the color reproduction information� XE "Color Reproduction" �� XE "Winstone 96:Color Reproduction test" �� XE "Disclosure:Color Reproduction" �

To determine the techniques the PC’s graphics device driver uses to render color on the display, choose the Color Reproduction... button from the Display window.

The Color Reproduction test determines if the PC’s video card is in a true-color mode or dithering mode.

If it’s in true-color mode, the test tells you how many shades of red, green, and blue are actually stored in the frame buffer.

If the card is in dithering mode, the test tells you how large the dither pattern is, the maximum number of colors used in a single dither pattern, how many shades of red, green, and blue the pattern will support, and whether the pattern matches the pattern the VGA device driver uses.

You may want to use the Color Reproduction test if you’re comparing different video cards and want to be certain they all use the same color reproduction method.

When the test completes, Winstone 96 adds the color reproduction information to the Disclosure Questionnaire.

NOTE:	Winstone 96 displays this information in the text box to the right of the Color Reproduction... button. You may not, however, be able to read all the information in the box. To view all the information, use the right-arrow key to scroll the information horizontally or choose the Disclosure icon and look for “Display Color Reproduction” in the Disclosure information.

CPU/Memory� XE "Disclosure:CPU and Memory" �� XE "CPU and Memory information" �

To display information about the PC’s CPU and memory, select CPU/Memory from the Disclosure Questionnaire window.

First, Winstone 96 displays information about the PC’s processor, its speed, the amount of off chip cache, and the amount of memory. Winstone 96 does the best it can to determine this information. It’s possible, however, Winstone 96 may not be able to narrow down the specific type of processor the PC uses. For example, Winstone 96 may be able to determine the processor is a 486, but it can’t tell if it’s a DX or SX. You can add to or correct the processor information by typing in the correct information.

NOTE:	Winstone 96 can’t determine the size of the off-chip processor cache.

Next, Winstone 96 displays information about the PC’s coprocessor. If it can, it determines the coprocessor type.

Finally, Winstone 96 lists the type of bus the PC uses.

If Winstone 96 can’t determine some of these values, it enters either “Unknown” or a question mark (?) in the field it can’t determine.

NOTE:	Winstone 96 can’t detect a VESA Local Bus.

Disk� XE "Disk information" �� XE "Disclosure:Disk" �

When you select the Disk group from the Disclosure Questionnaire window, Winstone 96 changes the display to show information about the PC’s disk drives.

This window contains information about the PC’s hard disk, hard disk controller, operating system software cache, and Windows software cache.

NOTE:	Winstone 96 only detects the SMARTDrive OS Software Cache. If the PC uses other types of caches, Winstone 96 won’t automatically detect those.

If Winstone 96 can’t determine some of these values, it enters either “Unknown” or a question mark (?) in the field it can’t determine. To add to or change any of this information, just type in the information in the correct field.

Multimedia

When you select the Multimedia group from the Disclosure Questionnaire window, Winstone 96 changes the display to show information about the PC’s CD-ROM drive(s), controller, and software cache as well as information on the PC’s sound adapter.

If Winstone 96 can’t determine some of these values, it enters either “Unknown” or a question mark (?) in the field it can’t determine. To add to or change any of this information, just type in the information in the correct field.

Computer� XE "Computer information" �� XE "Disclosure:Computer" �

When you select Computer, Winstone 96 changes the display to show general information about the PC.

In this window, Winstone 96 displays information about the PC’s make and model, the BIOS manufacturer, power management, and the PC’s name.

The Computer window also includes an area where you can enter notes about the PC or about a particular test run.

If Winstone 96 can’t determine these values, it enters “Unknown” in the field it can’t determine. To add to or change any of this information, just type in the information in the correct field. (In most cases, you’ll need to enter the information for the PC in the Computer window, because it’s difficult for Winstone 96 to determine this type of information.)

Software� XE "Software information" �� XE "Disclosure:Software" �

When you select Software, Winstone 96 changes the display to show information about the operating system and Windows software installed on the PC and any emulation software used to allow Windows to run on non-PC hardware platforms.

To add to or change this information, type the new information in the appropriate fields.

Tester Info� XE "Tester Info" �� XE "Disclosure:Tester Info" �

When you select Tester Info, Winstone 96 changes the display to show the project identification number (PIN), project name, and variants for the test run.

When our labs run Winstone 96, they use project identification numbers (PINs), project names, and variants to help identify different Winstone 96 test runs on the same machine. The Tester Info section of the Disclosure Questionnaire lets you enter a PIN and up to five variants, as well as a project name. You can use any combination of letters, numbers, or symbols. Variants can be a maximum of three characters, PINs a maximum of seven, and project names a maximum of ten.

This window also lets you change the tester’s name and the organization if you choose to do so. (You entered the tester name and organization when you licensed Winstone 96. There may be a case, however, where the person running the test isn’t the same person who licensed the software.)

Printing Disclosure information� XE "Disclosure:Printing" �� XE "Printing:Disclosure information" �

To print Disclosure information:

1.	Select Print from the File menu in the main window.

2.	From the Print submenu, select the Disclosure... option.

When you print the Disclosure information, Winstone 96 prints the information currently displayed in the Disclosure window.

NOTE:	If you’re displaying results for several different types of machines, you can print disclosure information for each of them. To specify the set of comparison results for which you want to print the Disclosure, change the Description listed above the Disclosure information in the Disclosure window and then select Print from the File menu.

End of Chapter

�Part 4: �Analyzing Results

Chapter 13:	� REF Chapter13UsingResultsDatabase \* MERGEFORMAT �Using the Results Database��Explains how to save, view, print, and merge results.

Chapter 14:	� REF Chapter14WhatNumsMean \* MERGEFORMAT �What Do All These Numbers Mean��Discusses what Winstone 96’s scores mean about a PC’s performance.

Chapter 15:	� REF Chapter15WhatCanAffectResults \* MERGEFORMAT �What Can Affect Results��Discusses different areas of a PC’s setup and configuration that can affect Winstone 96’s scores.

Chapter 16:	� REF Chapter16Publishing \* MERGEFORMAT �Publishing Results��Explains what information you need to include if you publish Winstone 96’s scores.

�Chapter 13: �Using the Results Database

This chapter explains in detail how to use the common results database. It also explains how you can export results to file formats other than .DBF.

NOTE:	Consult Appendix A, “� REF AppendixADatabaseFiles \* MERGEFORMAT �The Database Files�” beginning on page � PAGEREF AppendixADatabaseFiles �149� for details about the database files.

Sections in this chapter

� REF _Ref302352875 \* MERGEFORMAT �Facts about the database�

� REF _Ref298743402 \* MERGEFORMAT �Saving results�

� REF _Ref333808477 \* MERGEFORMAT �Viewing scores�

� REF _Ref333808492 \* MERGEFORMAT �Deleting results permanently from the database�

� REF _Ref333808494 \* MERGEFORMAT �Printing results�

� REF _Ref333895517 \* MERGEFORMAT �Merging results into one database�

� REF _Ref298744197 \* MERGEFORMAT �Exporting results�

Facts about the database� XE "Database:Facts about the database" �

Winstone 96 saves scores and disclosure information in a database format it shares with WinBench 96. You use results stored in a database as comparison machines in the Chart and Table of Results windows.

Winstone 96 stores results in a database directory. The database directory typically has an extension of .ZDB. The database directory contains many dBASE(�compatible tables and indexes.

When you’re working with database files:

Always treat a database directory as a single object.

Always move, copy, or delete the entire directory.

Never move, copy, delete, or rename the files in a database directory.

Never use a dBASE-compatible database management system to edit the database directory. Doing so may break the relationship between the files and the benchmark, and you’ll lose the results.

NOTE:	You can merge the contents of one database into another using the Merge Databases... option from the File drop-down menu. Winstone 96 copies all results from the source database to the target database. (For more information, see page � PAGEREF _Ref333895517 �101�.)

Winstone 96 stores results in a database using a key consisting of the Description, Variant1-5, PIN, and Project fields of the Disclosure. You can store many sets of results using the same key. Winstone 96 distinguishes the results by a unique time stamp.

NOTE:	Many of the fields of the disclosure that uniquely identify a machine configuration and that should not normally change from run to run must be the same when saving results using an already existing key. For example, the Processor field and Processor RAM fields must be identical for all results stored using the same key. If these fields don’t match the fields already in the database with the same key, you’ll receive a warning message.

If you installed Winstone 96 in a subdirectory of \ZDBENCH, the setup program creates a database directory called \ZDBENCH\RESULT96.ZDB. Winstone 96 shares this database directory with WinBench 96 if you also installed that benchmarks in its default \ZDBENCH directory.

If you didn’t install Winstone 96 under a common \ZDBENCH directory, it creates the RESULT96.ZDB database directory in the directory where you installed the program files. Winstone 96 can’t then share the database with WinBench 96.

The remainder of this chapter explains how to save, view, and print results, as well as how to merge and export them.

Saving results

After Winstone 96 finishes a test suite, it automatically displays that suite’s scores in the Chart and Table of Results windows.

To save results to a database:

1.	Choose either the Save function button or the Save... option from the File drop-down menu.

Either of these actions displays the Save to Database dialog box.

This dialog box displays the directory name for the database directory and some basic information about the test PC taken from the Disclosure Questionnaire.

NOTE:	The more information you add to the Disclosure Questionnaire, the more information Winstone 96 displays in this dialog box. For example, if you define a PIN number or variants to the questionnaire, Winstone 96 will display that information in the Save to Database dialog box. (For more details on how to edit the Disclosure Questionnaire, see page � PAGEREF _Ref298830710 �82�.)

2.	Choose the Save button in the Save to Database dialog box.

Winstone 96 saves its scores to the database directory using the Description you supplied in the Disclosure Questionnaire.

NOTE	You can also export results to other file formats. For more information, see page � PAGEREF _Ref298744197 �102�.

Changing the database directory

If you want to save results to a different database directory:

1.	Choose either the Save function button or the Save... option from the File drop-down menu to open the Save to Database dialog box.

2.	Choose the Database... button in the Save in this dialog box.

Winstone 96 then displays its Select a Database dialog box.� XE "Database:Selecting another database" �

3.	Select the database directory where you wish to save the PC’s scores. (You can change the drive or directory if you need to do so.)

4.	Choose the OK button.

Viewing scores

You can view scores saved to a database from the Chart and Table of Results. You can also view Winstone 96 scores for other PCs whose records you’ve merged into the database.

After you run a suite, Winstone 96 automatically displays the score for that suite in the Chart of Results. The Chart of Results shows the name of the suite and its score in a horizontal bar graph. When you add scores to the display, Winstone 96 displays those results in the Chart of Results also.

The Table of Results also contains scores for the current suite. Winstone 96 doesn’t, however, automatically display this table. Instead, you’ll find an icon for the Table of Results in the lower, left-hand corner of the main window. To open the Table of Results window, choose this icon.

While the Chart of Results displays scores in a graph, the Table of Results displays scores in column format. The first column lists the name of the suite. Each column thereafter lists the corresponding score for each comparison machine in the display. The last column displays the units for the score (with Winstone 96 it’s always Winstone 96 units).

For example, if you’ve added two sets of results to the display, there will be five columns in the Table of Results—one for the suite name, one for the current score(s), one each for the two sets of comparison results, and the final units column.

The sections that follow explain how to add and remove scores from the Chart and Table of Results displays.

Adding results to the display

� XE "Database:Adding scores to the display" �� XE "Comparison machines:Adding to the display" �� XE "Database:Comparing scores" �� XE "Chart of Results:Adding scores to the display" �� XE "Table of Results:Adding scores to the display" �� XE "Scores:Adding to the display" �� XE "Winstone 96:Adding scores to the display" �� XE "Winstone 96:Comparing machines" �� XE "Adding scores to the display" �Winstone 96 automatically displays a PC’s current scores in the Chart and Table of Results. You only need to add scores to these windows if you want to view scores other than the current scores. You can display up to five sets of comparison results in the Chart and Table of Results.

Remember, Winstone 96 doesn’t automatically display the Table of Results. If you want to view the Table of Results, you’ll have to open the window manually by choosing its icon or by selecting the Table of Results option from the Window menu.

To add Winstone 96 scores to the Chart and Table of Results, choose the Compare... button in the Functions window. Winstone 96 displays the Comparison Machines dialog box.

From the Comparison Machines dialog box, you can add results from:

A database by choosing the Add from Database... button.

An exported file by choosing the Import from File... button. (For more information on how to export results, see page � PAGEREF _Ref298744197 �102�.)

Adding results from a database� XE "Viewing scores:Adding from a database" �� XE "Scores:Adding from a database" �

To add results from a database:

1.	Choose the Add from Database... button.

Winstone 96 displays the Select Results from Database dialog box.

Winstone 96 lists the directory name of the current database and the names of all the records in that database. Each record represents a set of results. (If you want to change the database, choose the Database... button and select a different database.)

2.	Select the set of results you wish to add to the display.

3.	Choose OK.

Importing results from a file� XE "Importing scores from a file" �� XE "Scores:Importing from a file" �� XE "Viewing scores:Importing scores from a file" �� XE "Winstone 96:Importing scores from a file" �

To import results from a file:

1.	Choose the Import from File... button.

Winstone 96 displays the Import Results from File dialog box.

2.	Select the name of the file you wish to import in the File Name text box.

You can change the drive and directory if you need to do so.

3.	After you’ve entered the name, choose OK.

Winstone 96 adds the results from the file into the Chart and Table of Results displays.

Removing results from the display

� XE "Removing results from the display" �� XE "Comparison machines:Removing results from the display" �� XE "Chart of Results:Removing results from the display" �� XE "Table of Results:Removing results from the display" �� XE "Winstone 96:Removing results from the display" �If you’d like to remove a set of results from the Chart and Table of Results:

1.	Open the Comparison Machines dialog box by choosing the Compare... button in Winstone 96’s Functions window.

This dialog box lists all the results currently displayed in the Chart and Table of Results. (You can display up to five sets of comparison results.)

2.	Select the set of results you’d like to remove from the display.

3.	Choose Remove.

Winstone 96 removes that set of results from the Chart and Table of Results. It doesn’t, however, permanently delete those results from the database. The next section tells you how to permanently remove results records from the database.

Deleting results permanently from the database� XE "Deleting results records" �� XE "Database:Deleting records permanently" �� XE "Results:Deleting" �� XE "Winstone 96:Deleting results" �

To permanently delete a set of results from the database:

1.	Select Delete... from the File menu in the main menu bar.

Winstone 96 displays its Delete Results from Database dialog box.

When you open this dialog box, Winstone 96 automatically displays all the records in the current database in the Filtered Records section of the box. (To change the database, choose the Database... button.)

You can use the Record Selection Filter section of the dialog box to locate a specific record in the list or to narrow the list to make the record easier to find. You can also change the database by choosing the Database... button.

For example, if you know the record you want to delete is for a PC with a 486 CPU with a 66 MHz processor speed, you can enter that information in the appropriate fields, choose Apply Filter, and Winstone 96 displays only the records for 486 CPUs with a 66 MHz processor speed. Then, select the record you want to delete, and choose Delete. Using the Record Selection Filter can cut the total list of records down to a size where finding the one record you want to delete is an easier task.

2.	Select the record or records you wish to delete.

To select more than one record, hold down the Shift key then click on the additional record name(s).

3.	Choose OK.

Winstone 96 prompts you with a warning asking if you’re sure you want to delete the selected record. Choose Yes, and Winstone 96 removes that entry from its database.

Printing results� XE "Database:Printing results" �� XE "Results:Printing" �� XE "Printing:Results" �� XE "Winstone 96:Printing results" �

You can print the current results, the Chart and Table of Results, and the Disclosure Questionnaire using the Print option from the File menu.

If you want to print . . .�Then choose . . .��The results and Disclosure information for tests run during the current session.�Current results.��The current contents of the Chart of Results and/or the Table of Results.�Chart of Results and/or Table of Results.��Disclosure information.�Disclosure. (Winstone 96 prints the Disclosure information for the current results. If you want to print Disclosure information for other sets of comparison results, change the Description listed at the top of the Disclosure window before selecting Print from the File menu.)��When you choose one of these options, Winstone 96 prints to the currently selected default printer.

Merging results into one database� XE "Database:Merging results" �� XE "Result:Merging" �� XE "Winstone 96:Merging results" �� XE "Merging results" �

To merge databases:

1.	Select Merge Databases... from the File menu in the main menu bar.

Winstone 96 displays its Merge Databases dialog box.

2.	Specify a target and source database.

When you merge two databases, you specify a target database and a source database. The target database is the database to which you wish to add results. The source database contains the records you wish to add to the target database.

3.	Choose Merge.

Winstone 96 adds all the records from the source database to the target database. To view these records, you need to add them to the display (see page � PAGEREF _Ref299779478 �98�).

NOTE:	Depending on the number of records in the source database, it may take a while to merge the records from one database to another.

Exporting results� XE "Winstone 96:Exporting results to a file" �� XE "Exporting results" �� XE "Database:Exporting results" �� XE "Results:Exporting" �

In addition to saving results to a database, you can export results to an ASCII text file (.TXT), a Lotus 1-2-3 spreadsheet (.CSV), an Excel spreadsheet (.XLS), or a Windows Metafile (.WMF) for use in other applications.

To export results:

1.	Select Export from the File menu.

You can export:�Which contains:�To this format:��Current Results�Results and Disclosure for the tests run in the current session�.TXT, .CSV, or .XLS��Chart of Results�Results the Chart of Results currently displays�.WMF��Table of Results�Results currently listed in the Table of Results�.TXT��Disclosure�The information currently listed in the Disclosure window�.TXT��Choosing any of the above options from the Export submenu displays the Export Results to File dialog box.

2.	Enter the name of the file in the File Name dialog box. (You can change the drive and directories using the Drives and Directories portions of this dialog box.)

3.	Choose OK.

Winstone 96 saves the results to the file name and format you specified.

End of Chapter

�Chapter 14: �What Do All These Numbers Mean?

This chapter explains how to read and interpret the Chart and Table of Results. It also explains what the score for Winstone 96’s main suite means about a PC’s overall performance and what you can do with that score.

Sections in this chapter

� REF _Ref335795293 \* MERGEFORMAT �Bigger means better:  Comparing Winstone 96 scores�

� REF _Ref335795251 \* MERGEFORMAT �The units Winstone 96 uses�

� REF _Ref333810796 \* MERGEFORMAT �What Winstone 96’s scores mean about a PC’s performance�

� REF _Ref333810798 \* MERGEFORMAT �Making sure a comparison is valid�

� REF _Ref333811314 \* MERGEFORMAT �Finding comparison scores�

Bigger means better:  Comparing Winstone 96 scores � XE "Chart of Results:Reading" �� XE "Table of Results:Reading" �

When you first look at Winstone 96’s Chart of Results, the numbers may seem a little overwhelming. The most important thing to remember, however, is with Winstone 96, bigger numbers mean better performance.

�To make it easier to understand a PC’s scores, Winstone 96 has a base machine. The base machine receives a score of 10.0 Winstone 96 units on the overall suite. The same base machine receives a score of 1.0 Winstone 96 units on each category suite. (For statistics on the base machine, see page � PAGEREF FactsAboutBaseMachine �106�.)

So, if a PC scores 20.0 Winstone 96 units on the main suite, it’s two times as fast as the base machine at executing the main suite. Or, if a PC scores 5.0 Winstone 96 units on the main suite, the base machine is twice as fast as that PC at executing the main suite.

You can carry this over to Winstone 96 scores for any two machines. For example, if Machine A scores 20.0 Winstone 96 units on the main suite and Machine B scores 40.0 Winstone 96 units on the main suite, then Machine B is twice as fast as Machine A at executing the “Overall Winstone 96” suite.

For the category suites, if a PC scores 2.0 Winstone 96 units on a category suite, it’s five times faster at executing that category suite than the base machine. Likewise, if a PC scores 0.5 on a category suite, that machine is half as fast as the base machine at executing that suite.

The units Winstone 96 uses� XE "Winstone 96:Units" �� XE "Units" �

Winstone 96 reports its results in arbitrary units. It’s a relative score:  it’s only meaningful when you compare it to other Winstone 96 scores. So, the score isn’t pixels per second, or bytes per second, or any other type of measurement.

The base machine’s overall score is set at 10.0 Winstone 96 units, and each of the category suites is set at 1.0 Winstone 96 units. Winstone 96 sets these scores this way as a basis for comparison.

Just remember, the base machine is a basis for understanding a PC’s performance at a glance. Faster PCs have larger numbers than the base machine, while slower PCs have smaller numbers than the base machine.

What Winstone 96’s scores mean about a PC’s performance

Winstone 96 runs today’s top-selling Windows-based applications. Each application Winstone 96 runs performs tasks the way typical users would perform tasks in the application. This approach lets Winstone 96 reflect the center of the software market.

Winstone 96’s scores generally represent how a PC performs these tasks when running these Windows-based applications. Winstone 96 gives you an accurate and repeatable measurement of how a PC runs applications under Windows.

Making sure a comparison is valid

Once you’ve run Winstone 96, you’ll want to use its scores to judge a PC’s performance. You should, however, remember a few very important details before you begin making any comparisons:

1.	IMPORTANT!  You can’t meaningfully compare the most current release’s scores with scores from previous versions of Winstone. Each new version of Winstone includes substantial changes, and those changes affect scores. So, you should always compare scores from the same version of Winstone.

2.	Winstone 96’s scores are relative scores. A relative score is an arbitrary unit that is meaningless until you compare it with other similar scores. So, to understand what a Winstone 96 Unit Score of 40.0 means about a PC, you’ll need to compare that score to Winstone 96 scores for other PCs. (For more details, see the section “� REF _Ref335795251 \* MERGEFORMAT �The units Winstone 96 uses�” on page � PAGEREF _Ref335795251 �104�.)

3.	If you’re trying to determine which of two PCs outperforms the other, keep in mind that a PC’s hardware and software setup affects its performance. To find out about a PC’s system information at the time you ran Winstone 96, you can view its Disclosure information (for more details, see page � PAGEREF _Ref298830697 �81�).

Finding comparison scores

Once you run Winstone 96 and have a score for the PC, you have several options for places to find comparison scores. This section explains where to find Winstone 96 scores to use for comparison.

The base machine� XE "Base machine:Using for comparison" �� XE "Winstone 96:Base machine" �

You can gauge the overall performance of a PC by comparing its Winstone 96 scores to the scores of the base machine.

The base machine receives a score of 10.0 Winstone 96 units on the overall suite. The same base machine receives a score of 1.0 Winstone 96 units on each category suite.

The base machine for Winstone 96 is a Dell® PC with a 25-MHz Intel® 486SX CPU running Microsoft Windows version 3.1 in enhanced mode. The following chart provides configuration information about the base machine.

�Facts about the base machine� XE "Base machine:The vital statistics" ���PC Manufacturer�DELL��Model�NETPLEX 425s/P (25-MHz 486SX)��BIOS manufacturer�Phoenix Technologies Ltd.��BIOS version�1.10 A01��Bus type�ISA��DMA Controller�yes��Memory�8MB��Memory management software�HIMEM.SYS version 3.10��Video�Super VGA (800x600, 16 colors)��Controller�on motherboard��Video Manufacturer�Cirrus Logic��Video BIOS�CL-GD540 x 1542 x VGA BIOS version 1.20��Hard Disk�162MB��Controller type�IDE��Hardware caching�no��Software caching�SMARTDRV.EXE version 5.0 (defaults to 512KB while running Windows)��Swap file for Windows�19,679KB (permanent)��Mouse�Genius Mouse Systems, model: Jx mouse��LPT ports�LPT1: (I/O address = 03BC)��COM ports�COM1: (I/O address = 03F8), COM2: (I/O address = 02F8)��MS-DOS�Version 6.2��Windows�Version 3.1��Network�Novell® NetWare® Shell version 3.26��Checking Ziff-Davis publications� XE "Ziff-Davis:Publications" �

A good way to determine how a PC compares to other PCs is to check published Winstone 96 results in Ziff-Davis publications. Many ZD publications provide PC reviews that include Winstone 96 performance scores. You can find published results in “First Looks™” articles, comparative reviews, and other stories in such Ziff-Davis publications as:

United States

Computer Life™�Computer Gaming World™�Computer Shopper®�Family PC™�Inter@ctive Week™�PC/Computing®�PC Magazine®�PC Week®�Windows® Sources™�ZD Internet Life™

United Kingdom

Computer Life™�PC Direct®�PC Magazine®

France

PC Direct®�PC Expert®

Germany

PC Direkt®�PC Professionell®

Mexico

PC/Computing® en Español

People’s Republic of China

PC Magazine®�PC/Computing®

You can also find articles about Ziff-Davis benchmarks on Computer Library’s Computer Select® CD�ROM, a database of computer-related product information.

�Using on-line services� XE "ZD Net" �� XE "Ziff-Davis:Benchmark forum" �

If you have a modem and some sort of communications software, you can access Ziff�Davis’ on-line services:

ZD Net™/CompuServe( Edition (GO ZDNET)

ZD Net/World Wide Web Edition (http://www.zdnet.com)

Using the ZD Net forum, you can discuss benchmark results with other testers and with ZD’s benchmark developers.

End of Chapter

�Chapter 15: �What Can Affect Results

This chapter lists some of the many factors about a PC’s configuration that can influence a benchmark’s results for a PC.

Sections in this chapter

� REF _Ref299443068 \* MERGEFORMAT �What this chapter covers�

� REF _Ref336154279 \* MERGEFORMAT �Our benchmarks work with subsystems, not individual components�

� REF _Ref336249894 \* MERGEFORMAT �The graphics subsystem�

� REF _Ref299443206 \* MERGEFORMAT �The disk subsystem�

� REF _Ref336249900 \* MERGEFORMAT �The processor subsystem�

� REF _Ref337538218 \* MERGEFORMAT �Testing tips�

What this chapter covers

Many factors, both hardware and software, can affect a benchmark’s results. For example, a PC’s CPU speed obviously affects results. Perhaps less obvious is that if a PC has a fragmented disk, its results may often be lower than if you reformat or defragment the disk before you run each test.

�There are also facets of a computer’s architecture you may not normally consider that can affect results. For example, some PCs in the ZDBOp research center showed improved performance if we replaced single SIMMs with multiple SIMMs. One PC ran tests faster with four 4MB 72-bit SIMMs instead of one 16MB 72-bit SIMM.

Understanding the configuration of a PC is very important when you begin to analyze a benchmark’s results. For information on how Winstone 96 determines a PC’s configuration and how to view those statistics, see page � PAGEREF Chapter12WorkingwithDisclosure �81�.

This chapter contains as much useful information as is practical. It can’t, however, cover everything there is to know about PCs and how they work.

So, this chapter specifically serves as a starting point. It briefly explains each of a PC’s main subsystems, the components of that subsystem, how it interacts with other subsystems, and how all this can affect a benchmark’s results.

Our benchmarks work with subsystems, not individual components

Although Winstone 96 measures the performance of the entire system, not the performance of individual subsystems and components, the performance of an individual subsystem can affect the PC’s overall performance and thus, Winstone 96’s scores. As we see it, a PC has four basic subsystems:  graphics, disk, processor, and CD-ROM.

The next sections discuss each individual subsystem, enumerating the components in each subsystem, and describes factors about those subsystems that may affect Winstone 96’s scores.

The graphics subsystem

A PC’s graphics subsystem includes the:

Monitor

Graphics adapter

Graphics driver

Bus used to carry information from the graphics adapter to and from the processor subsystem.

Factors about the graphics subsystem that can affect benchmark results include the:

Refresh rate, resolution, and color depth of the monitor.

More colors can slow down a PC’s performance. While higher resolutions can also slow down performance, they usually do so to a lesser extent. Although a higher refresh rate will reduce screen flicker, it will generally slow performance if the PC has a DRAM graphics adapter.

NOTE:	To compare two graphics cards fairly, both should generally use the same refresh rate. Winstone 96 includes a test that lets you determine or verify the monitor’s refresh rate (see page � PAGEREF _Ref299784387 �84� for more information).

Amount and type of graphics adapter RAM.

The graphics adapter card uses Dynamic RAM (DRAM) chips or Video RAM (VRAM) chips on the graphics adapter. VRAM chips have two access ports compared to a single access port for DRAM. VRAM is generally better than DRAM, although more expensive. VRAM allows faster access to the RAM by the CPU or graphics accelerator.

A local�bus architecture, which links the CPU with the graphics subsystem, can speed up drawing, because the PC doesn’t have to route the data through a slower expansion bus.

The disk subsystem

The disk subsystem includes the:

Hard disk

Disk controller

Disk device drivers

Any disk caches (hardware or software) you have installed

Bus used to carry information from the disk controller to and from the processor subsystem.

Factors about the disk subsystem that can affect a PC’s performance include:

Presence of a hardware disk cache and its size.

Presence of a software disk cache and its size.

Whether the software disk cache is caching writes.

Disk subsystem performance generally improves when caching writes.

Disk compression.

Operating system software.

How much free disk space is available on the hard disk.

Whether the hard disk is fragmented.

We recommend you defragment a PC’s hard disk each time you run any benchmark test. A fragmented hard disk can slow everything down. The hard disk becomes fragmented as you free space and then save files whose data doesn’t fit into one connected space on the hard disk.

Is 32-bit disk access turned on?

Is 32-bit file access turned on for Windows for Workgroups?

For Windows 95, does the PC use protected mode drivers to access the disk?

To find out if the PC uses any real mode drivers, look in the Performance tab of the System control panel.

Type of swap file and its size. A permanent swap file is better than a temporary one.

The processor subsystem

The components of the processor subsystem include the:

CPU

FPU

Memory (RAM)

External caches

Memory bus architecture, which is the pathway along which data shuttles between RAM and the CPU.

�Factors about the processing subsystem that can affect a benchmark’s results include:

The memory speed.

Whether the memory is interleaved.

The memory type (for example, EDO DRAM versus fast-page mode DRAM).

Amount of memory.

A general rule of thumb for Windows is the more RAM the better.

You can set aside some parts of RAM for disk caches, although this reduces the amount of RAM available to applications.

You also need to consider the speed and organization of the RAM, though this isn’t a critical factor. There’s no easy way, however, to determine these factors. The invoice or specification for the PC may list its RAM speed. Determining the RAM’s organization may be more difficult. (It may be interleaved, allowing for faster sequential access by the CPU. Whether the memory is 16-, 32-, or 64-bits wide will also affect performance.)

The CPU model and clock speed.

Some PCs also have a TURBO button on the front of the machine. If the PC has a TURBO button, you want to keep it turned on.

Any internal or external CPU RAM caches, their organizations (for example, direct-mapped or set-associative), whether they are write through or write back, and whether they are enabled.

If the cache is set associative instead of direct mapped, the CPU’s access time to data may be better. Also, whether the cache supports write back or write through processing can affect the speed at which the CPU can write data to memory. (With write back cache, the CPU writes data into cache first and then into memory later, thus speeding up the writes. With write through cache, the CPU writes data directly to cache and memory, causing writes to be slower.)

Whether the PC has a math coprocessor.

A math coprocessor helps speed certain mathematical calculations (such as those in spreadsheets) in 8088, 8086, 80286, 80386, and 80486 SX CPU’s. 80486 DX and Pentium CPUs have the coprocessor circuitry built in.

Testing tips

Background tasks

Halt any minimized or background tasks before you run Winstone 96. Ideally, you should disable all such tasks and clear system memory, including any caches other than SMARTDrive and the file cache (if you’re running Windows for Workgroups), by rebooting the PC.

NOTE:	Winstone 96 will report any background tasks that are running when you start a suite. Winstone 96 won’t, however, automatically terminate those tasks nor will it halt its tests because those tasks are running.

Disk subsystem

For best performance, the hard disk partition on which you run Winstone 96 should contain as much contiguous free disk space as possible. You should defragment the hard disk with a defragmentation tool before you run each test.

With some older ST-506 or ESDI hard disks, you may improve Winstone 96’s scores by performing a low-level initialization first and adjusting the disk-sector interleave factor for optimal performance.

When you use SMARTDrive or any other disk-cache software of your choice, you should set the disk cache for optimal performance based on the amount of physical memory in the PC. You should also turn on write caching for the drive you’re testing. 

NOTE:	Remember, disk-cache software can compete with Windows for available system RAM. Also, remember to check that SMARTDrive has completed all write-caching before you run off the PC.

Disk compression programs may actually slow system performance.

Turn on 32-bit disk access.

If you’re running Windows for Workgroups 3.11, turn on 32-bit file access. Remember, you’ll need to restart Windows after changing this setting to reset the PC’s SMARTDrive settings.

�DOS

Before you install DOS on the PC, you may wish to check the user’s manual for optimization information relevant to the PC’s processor and other resources.

If the PC is running Novell DOS 7, you should add SHARE.EXE to the AUTOEXEC.BAT file with the following parameters:

SHARE.EXE /l:500 /f:5100

Network client software

If you plan to run Winstone 96 from a base directory on a file server, you should check the network operating system’s user’s manual for any information on optimizing system performance when using a network.

Background tasks, such as network activity, can influence Winstone 96’s results. A typical network client spends some CPU time processing network data packets and interrupts even when applications on the client aren’t using the network. High volumes of such packets (such as network broadcasts) can reduce Winstone 96’s results by consuming system resources during the execution of a test suite.

If you run Winstone 96 across a network, try to do so in an isolated test network or when the volume of network traffic is low.

Processor subsystem

Before you run Winstone 96, you should make sure the PC’s CPU is running at the highest possible speed. If the PC has a TURBO button, make sure it’s turned on.

Physical memory (RAM)

Enable processor caches.

Maximize free memory before you execute Winstone 96.

Reduce memory usage by disabling processes such as automatic network connection utilities and application start-up utilities.

Allocate as much RAM as possible to extended memory. (Refer to the Microsoft Windows Users Guide for information on optimizing the memory caching system for Windows.)

VSHARE

We recommend you let the Winstone 96 setup program install VSHARE if you don’t already have it installed on the PC under test. We also recommend you use VSHARE rather than SHARE for better Winstone 96 results. If, however, the PC is running Novell DOS 7, you’ll need to use SHARE. (See the section “� REF _Ref337614536 \* MERGEFORMAT �DOS�” on page � PAGEREF _Ref334252369 �114� for more information.)

Windows

Before you install Windows on the PC, check the Microsoft Windows Users Guide for optimization guidelines appropriate to the PC’s processor and other resources.

Check the load= and run= statements in the WIN.INI file. You should ideally have no tasks other than Winstone 96 running when you run a suite.

Winstone 96 makes sure the following fonts are present before it runs a suite:

Arial (True Type)�Arial Bold (True Type)�Arial Bold Italic (True Type)�Arial Italic (True Type)�Times New Roman (True Type)�Times New Roman Bold (True Type)�Times New Roman Bold Italic (True Type)�Times New Roman Italic (True Type)�MS Sans Serif

For best performance, you should delete any other unnecessary fonts before you run Winstone 96.

Modes for Windows

You can run Winstone 96 in Windows in either standard or enhanced mode. If you don’t have at least 8MB of RAM, however, Winstone 96 may not run correctly in standard mode.

NOTE:	If you’re running Winstone 96 under Windows for Workgroups, you should enable 32-bit file access for improved scores.

�Work directory

Winstone 96 uses the path name for the work directory when it copies files from the base directory to the work directory. Long path names increase overhead, because DOS must search from the root of the PC’s drive through each subdirectory in the work directory path. Consequently, you should use as short a path name as you can for the work directory (such as C:\ZDBENCH\WS96\WORK).

End of Chapter

�Chapter 16: �Publishing Results

This chapter explains what the license agreement requires and what information you must therefore include with each result you publish.

Sections in this chapter

� REF _Ref297003163 \* MERGEFORMAT �What the license agreement requires�

� REF _Ref336759299 \* MERGEFORMAT �Rereading the license agreement�

What the license agreement requires

The Winstone 96 license agreement requires you to include certain information about a PC with any Winstone 96 results you publish. If you publish a PC’s Winstone 96 results, you would need to say something similar to:

Ziff-Davis’ Winstone® 96 Version 1.0 produced an overall score of X Winstone® 96 Version 1.0 units on its Overall Winstone 96 suite on WXY PC Corp. Model 466 with 66�MHz Intel 486DX2�66 CPU, 8MB of RAM, 64KB RAM cache, 200MB hard disk, IDE controller, and no hardware disk cache. The test PC used XYZ Corp. XYZ Video adapter with 2MB VRAM and XYZ.DRV version 1.1 driver and had a refresh rate of 72 Hz. The test PC also used MS-DOS 6.0, Microsoft Windows 3.1, SMARTDRV 2MB cache, a video resolution and color depth of 800 by 600 pixels with 256 colors, and disk compression utility ABC version 1.0 enabled. All products used in the test were shipping versions available to the general public, and the test and its results were not verified by Ziff-Davis.

Winstone® is a registered trademark of Ziff-Davis Publishing Company.

You can find most of this information in Winstone 96’s Disclosure window (see the section “� REF _Ref298830697 \* MERGEFORMAT �Viewing Disclosure information�” beginning on page � PAGEREF _Ref298830697 �81� for more information).

NOTE:	If you report Winstone 96 scores, you must always report the overall score in addition to any category scores.

Rereading the license agreement

To reread the Winstone 96 license agreement:

Choose License from the Help drop-down menu in the main window. Winstone 96 then displays the license agreement.

Look at the front of this manual.

Read the README.WRI file. There’s a Read Me icon in the Ziff-Davis Benchmarks program group.

End of Chapter

�Part 5: �Looking Under the Hood—�How Winstone 96 Works

Chapter 17:	� REF Chapter17HowWeDeveloped \* MERGEFORMAT �How We Developed Winstone 96’s Suites��Explains the design concepts behind Ziff-Davis’ Winstone 96 development.

Chapter 18:	� REF Chapter18WhattheSuitesDo \* MERGEFORMAT �What the Suites Do��Discusses in detail what the Winstone 96 suites do when you run them.

Chapter 19:	� REF Chapter19CalculatesScore \* MERGEFORMAT �How Winstone 96 Calculates Its Scores��Explains how Winstone 96 calculates its scores and provides an mathematical representation of the Winstone 96 formula.

�Chapter 17: �How We Developed Winstone 96’s Suites

Ziff-Davis understands that measuring system performance in an accurate and repeatable way is important to you. So, before we release a benchmark, we do our homework. We research current trends in the PC market, analyze new software and hardware that’s available, and figure out what is important to a typical user of that software and hardware.

This chapter explains why Winstone 96 measures performance the way it does.

Sections in this chapter

� REF _Ref333895861 \* MERGEFORMAT �Using a market-centered approach to research�

� REF _Ref336760094 \* MERGEFORMAT �Choosing the applications�

� REF _Ref336760096 \* MERGEFORMAT �Choosing what the application scripts do�

Using a market-centered approach to research� XE "Market-centered research" �

When we began researching today’s Windows PC market to determine what types of functions and tasks Winstone 96’s application scripts should perform, we used a “market�centered” approach. All Winstone 96’s suites specifically focus on the types of use best-selling applications actually receive on PCs today.

While Winstone 96 can’t duplicate the exact functions you perform on your PC with your applications, it does reflect the way typical users use top�selling applications. For example, instead of targeting our tests for particular groups of specialized users, such as engineers who spend all day running simulations and CAD programs, Winstone 96’s suites aim for users who use applications closer to the center of the sales market. This approach lets Winstone 96 reflect the center of the software market and provides a more realistic view of a PC’s performance.

Winstone 96 uses leading Windows-based applications to gauge PC performance under Windows and provides a good idea of how a PC will perform under Windows on a day-to-day basis.

Choosing the applications

To determine which applications to use in Winstone 96, we consulted with Computer Intelligence/InfoCorp (CII), a leading market research company. We chose the applications with the largest unit market shares by averaging actual application sales for 1995 to date with special projections for 1996 that CII prepared for use with Winstone 96. The result was the following set of 13 applications in four categories:

Business Graphics/DTP:	Adobe™ PageMaker™ 5.0a for Windows�Corel Corporation CorelDRAW!® 5.0E2�Microsoft PowerPoint® 4.0c for Windows

Database:	Borland® dBASE® 5.0 for Windows�Borland Paradox® 5.0 for Windows�Microsoft Access® 2.0c for Windows�Microsoft Works 3.0b for Windows

Spreadsheet:	Lotus® 1-2-3® Release 5 for Windows�Microsoft Excel 5.0c for Windows�Microsoft Works 3.0b for Windows�Novell® Quattro® Pro 6.01 for Windows

Word Processing:	Lotus Ami Pro® Release 3.1 for Windows�Microsoft Word 6.0c for Windows�Microsoft Works 3.0b for Windows�Novell WordPerfect® 6.1 for Windows

Notice that one application on this list, Microsoft Works, actually appears in three categories. To reflect the way people use this multifunction product, Winstone 96 spreads its effects across the Database, Spreadsheet, and Word Processing categories. (Forty percent of its weight goes to the Spreadsheet category, another forty percent to the Word Processing category, and the remaining twenty percent to Database.) 

Earlier versions of almost all of these applications were also in the Winstone 95 benchmark. The exception is dBASE, which makes its first appearance in Winstone with this new release.

Choosing what the application scripts do

One half of Winstone 96’s market-centered approach is the way we chose the applications it uses. The other half is the actions the benchmark’s scripts for those applications perform.

To find out what the scripts should do, we asked you:  ZDBOp commissioned an independent survey of application usage by ZD readers. Each of the nearly 4,000 randomly selected readers who responded filled out a detailed ten-page survey on everything from the sizes of the documents and files they use to how often they performed specific operations in different applications. The results of that survey, one of the largest ever done on application usage, determined the tasks each application’s Winstone 96 script performs.

End of Chapter

�Chapter 18: �What the Suites Do

To better understand Winstone 96’s scores for a PC, it helps to know what the suite that gave you those scores did when you ran it. This chapter explains what Winstone 96’s key suites do.

Sections in this chapter

� REF _Ref299789757 \* MERGEFORMAT �What’s a script and how does Winstone 96 use it?�

� REF _Ref303046474 \* MERGEFORMAT �What happens when you run a suite?�

� REF _Ref296421199 \* MERGEFORMAT �Why each application script is unique�

� REF _Ref296421280 \* MERGEFORMAT �What the main suite and category suites do�

What’s a script and how does Winstone 96 use it? � XE "Application scripts" �� XE "Winstone 96:Application scripts" �

A script is a file that contains a series of commands the PC can execute without interaction. There is a script for each application Winstone 96 runs during a suite. Winstone 96 calls a script and then that script sends commands to its application.

ZDBOp created Winstone 96’s scripts using Microsoft Test for Windows 3.0 (MS Test). MS Test is a general�purpose commercial scripting tool for Windows�based applications that lets you write, record, and play back user actions.

NOTE:	We compiled the scripts in Winstone 96. So, they don’t contain any source code, and you can’t modify them in any way.

�Each script repeats the same application tasks each time it runs. Because Winstone 96 uses scripts, you can get a thorough measurement of a PC’s performance with minimal impact on your schedule. With Winstone 96, you simply start a suite, and the scripts run the applications. When the last script completes, Winstone 96 calculates, returns, and displays its scores.

What happens when you run a suite?

Winstone 96 runs applications from four different product categories:

Business Graphics/Desktop Publishing

Database

Spreadsheet

Word Processing

Within each category, Winstone 96 runs several applications. Each script starts an application, executes commands within that application, and quits the application.

Essentially, when you run a suite, Winstone 96 does the following for each application within that suite:

Copies the necessary application files from a base directory into a work directory to run the suite. The base directory contains all the files Winstone 96 needs.

Sends commands to the application that perform tasks similar to tasks users of that application typically perform.

Sends an exit command to the application.

Deletes the application files from the work directory.

Winstone 96 repeats this process for each application.

�NOTE:	Winstone 96 doesn’t include the time for copying and deleting application files in computing its score.

	For most of the applications, Winstone 96 starts its timer when the application’s first window appears on the PC’s screen. Winstone 96 takes one application from each category, however, and includes the application’s loading time in each application’s total time. These four applications are Microsoft Excel, Lotus Ami Pro, Borland Paradox, and Microsoft PowerPoint.

	For information on how Winstone 96 computes its scores, see Chapter 19, “� REF Chapter19CalculatesScore \* MERGEFORMAT �How Winstone 96 Calculates Its Scores�” beginning on page � PAGEREF Chapter19CalculatesScore �131�.

Why each application script is unique

Winstone 96 is an application-based benchmark. Instead of just mimicking what applications do, it runs actual applications. When you run any of Winstone 96’s suites, the script for each application included in that suite sends commands to its application. What you see on the screen is the application performing those script commands.

NOTE:	Winstone 96 comes with all the application files you need to run it. Those applications we include with Winstone 96, however, aren’t complete. Winstone 96 contains only those files it needs to finish its suites. Doing anything with these application files other than letting Winstone 96 use them during its suites is expressly against the Winstone 96 license agreement.

While we grouped similar applications into categories (such as Word Processing or Database), the applications within a category don’t necessarily perform the exact same functions and tasks. The reason the scripts are different is simply because that’s not the way most people use those products.

Different applications provide users with different sets of tools, and the way users work with those tools is different for each application. Users also approach different tasks differently with different applications. So, Winstone 96’s scripts perform tasks within each application the way a real user would. Winstone 96 doesn’t try to force all the applications in any category to perform the same tasks in the same ways.

What the main suite and category suites do

To make testing a PC as convenient as possible and to give you the best way to get repeatable results, we’ve grouped Winstone 96’s application scripts into several suites. Each of these suites runs a defined group of scripts.

This way, you can run a suite and get scores just by choosing a few buttons. Once you’ve started a suite, that’s all you need to do. You don’t need to interact with Winstone 96; it’ll simply display its score(s) once the suite finishes.

Winstone 96 comes with one main suite and four category suites.

The following table tells you which application scripts Winstone 96 runs when you choose either its main suite or one of the category suites.

This suite:�Runs the scripts for:��Overall Winstone 96�All the application scripts one after the other��Business Graphics/DTP�PageMaker�CorelDRAW!�PowerPoint.��Database�Access for Windows�dBASE�Paradox for Windows�Works for Windows.��Spreadsheet�1-2-3 for Windows�Excel�Quattro Pro for Windows�Works for Windows.��Word Processing�Ami Pro�Word for Windows�WordPerfect for Windows�Works for Windows.��After Winstone 96 runs all the scripts for a suite, it computes a score for that suite. If you run the Overall Winstone 96 suite, you’ll also get scores for the category suites.

End of Chapter

�Chapter 19: �How Winstone 96 Calculates Its Scores

This chapter explains exactly how Winstone 96 computes its scores. It also provides a mathematical rendering of the formula.

Sections in this chapter

� REF _Ref296420421 \* MERGEFORMAT �How Winstone 96 computes a score�

� REF _Ref296420460 \* MERGEFORMAT �How Winstone 96 times the applications�

� REF _Ref296420478 \* MERGEFORMAT �How Winstone 96 goes from several numbers to one number�

� REF _Ref302365031 \* MERGEFORMAT �Why normalize the execution times to a base machine?�

� REF _Ref302365048 \* MERGEFORMAT �Why use weights to calculate scores?�

� REF _Ref298313808 \* MERGEFORMAT �What is the formula�

How Winstone 96 computes a score

Winstone 96 determines its scores by running actual Windows�based applications and performing functions within those applications. Winstone 96 uses scripts to execute the commands that perform those functions within each application.

A script is a file that contains a series of commands a PC can execute without human interaction. Winstone 96 calls a script and then that script sends the actual commands to its application.

NOTE:	We compiled the scripts included in Winstone 96. So, the scripts don’t contain source code, and you can’t modify them in any way.

How Winstone 96 times the applications

To reflect real application use, Winstone 96 times initialization on only four applications—one from each application category. Those four applications are:

Spreadsheet:	Microsoft Excel 5.0c�Word Processing:	Lotus Ami Pro Release 3.1�Database:	Borland Paradox 5.0�Business Graphics:	Microsoft PowerPoint 4.0c

For these application scripts, Winstone 96 starts the timer when the script executes the application’s .EXE file and includes this load time when it calculates the score. For the other nine applications, Winstone 96 starts the timer after the application’s main window has appeared on the screen and so, doesn’t include the load time when it calculates the score.

How Winstone 96 goes from several numbers to one number

When you run Winstone 96’s main suite or category suites, it computes an execution time for each application it runs. For example, when you run the main suite, Winstone 96 computes 13 execution times for the 13 applications. Winstone 96 then uses these execution times to calculate a final score for the suite.

To produce a final score, Winstone 96 first compares each application’s execution time for the base machine against each application’s execution time for the test PC to produce a number representing the relative speed of each application script. It then combines the relative speeds for all of the applications to produce the final score for the suite.

To break it down into steps:

1.	Winstone 96 computes the speed of each application on the test PC relative to the actual speed of each application on the base machine. It does this by dividing the time it takes an application to execute its script on the base machine by the corresponding time for the same application on the test PC. Winstone 96 computes a relative speed for each application script in the suite. (It doesn’t display these speeds.) For example, if you run the main suite, Winstone 96 would have 13 relative speeds at this point in its calculation.

�2.	Winstone 96 combines the relative speed for applications in a category suite using a weighted harmonic mean to produce a relative speed for the entire category. The weight assigned to an application is its unit market share in the category. The weights can be thought of as the amount of work assigned to an application within the category.

To compute the weighted harmonic mean, Winstone 96 divides the weight of each application (the workload) by the relative speed of that application to produce a workload execution time for the application. It then adds these times to form a total time for the category. Winstone 96 divides the total weight for applications in the category by the total time for the category to form a relative speed for the category. This speed is the category score.

NOTE:	The total of the weights of applications in the category is fixed at 1, because the weights add up to 1 within a category.

If you’re running one of the category suites, Winstone 96 stops its calculation here and displays the category’s score. If you’re running the main suite, Winstone 96 still needs to use the four category scores—one for each category—to produce a final score.

3.	Winstone 96 combines the scores for all four categories using a weighted harmonic mean to produce a score for the main suite. The weight assigned to a category is its unit market share. The weights can be thought of as the amount of work assigned to a category.

To compute the weighted harmonic mean, Winstone 96 divides the weight of each category (the workload) by the relative speed of the category (the category score) to produce a workload execution time for the main suite. Winstone 96 then adds these times to form a total time for all of the categories. Winstone 96 divides the total weight for all categories by the total time for the categories to form a relative speed. This speed is the final, main suite score.

NOTE:	The total weight for all the categories is fixed at 1, because the category weights add up to 1.

This score represents the overall performance of all of the applications in Winstone 96 on the test PC relative to the base machine.

The following sections explain in detail how Winstone 96 normalizes and weights its score. If you want to see a mathematical rendering of the formula, see the section “� REF _Ref296413904 \* MERGEFORMAT �The Winstone 96 formula�” on page � PAGEREF _Ref296413904 �136�.

Why normalize the execution times to a base machine?

To understand how Winstone 96 computes a score, you must first understand why Winstone 96 normalizes the individual application execution times against a base machine.

Winstone 96 could take the sum of the execution times for each application and simply use an arithmetic mean to get a single score. This score, however, wouldn’t produce a correct representation of a PC’s performance. An arithmetic mean assumes the numbers you average are directly related to each other. For example, you would use an arithmetic mean to find the average GRE scores for students admitted to University X, because all the scores reflect results of the same test.

Since Winstone 96 runs different scripts for each application and performs different functions within each of the applications, the execution times aren’t directly related. Further, if one script takes longer to execute than another and you use an arithmetic mean to compute the score, the results would be overly affected by that one script.

To remove any undue influence an application may have because the script for that application took longer to execute than the scripts of other applications, Winstone 96 normalizes the execution times for each application it runs. Winstone 96 normalizes the execution times by computing a ratio between the time it takes each application to execute its script on a PC and the corresponding time for the same application on the base machine.

As an example, suppose a PC took 100 seconds to run Application X. The normalized result for Application X would be:

�EMBED MSDraw   \* mergeformat���

In other words, Application X runs twice as fast on that PC as on the base machine. (With this formula, bigger numbers mean faster performance.)

Once Winstone 96 computes these ratios, these numbers represent how fast the scripts executed on the test PC as compared to the base machine. Although you now have comparable numbers, you still can’t just add the numbers to get a single score for the PC. If you averaged the numbers at this point, you’d get an incorrect representation of the PC’s performance. Averaging the numbers now would treat all applications as if they’re equal, and they’re not.

Winstone 96 lets the market decide the relative importance of the applications. So, Winstone 96 weights each application according to its unit market�share weights. The next section explains why and how Winstone 96 uses weights in calculating its scores.

Why use weights to calculate scores?

After Winstone 96 normalizes the execution times, it uses a weighted harmonic mean to calculate a single score. Winstone 96 weights each application by that application’s unit market share of its category and weights each category by that category’s unit market share of the total software market for Windows. (The categories are types of applications users run on Windows-based PCs, while the applications are top sellers in each category.)

Computer Intelligence/InfoCorp, a leading market research company, supplied the research data that determined the actual and projected unit market shares for the categories and the applications within the categories.

An application’s unit market share represents the percentage of units sold in its category. Winstone 96 uses this market share percentage when it weights the applications and categories.

Because Winstone 96 uses only the top selling Windows-based applications, these applications don’t represent the total sales in their categories. For example, in Category A the unit market share percentages might be:

Application X	47%�Application Y	23%�Application Z	20%

TOTAL	90%

As you can see, these percentages don’t add up to 100%. Nonetheless, the three applications represent the overwhelming majority of the sales for Category A. When calculating the category and overall scores, Winstone 96 scales the percentages for each application so they sum 100%. This scaling is necessary to make the calculations work correctly.

In the same manner, the four Winstone 96 categories don’t cover all software sales for Windows. They do, however, represent the overwhelming majority of such sales. Like the applications’ unit market shares, Winstone 96 scales the category numbers so they sum 100% to make the calculations work.

The next section provides a detailed, mathematical rendering of how Winstone 96 computes its score using a weighted harmonic mean.

What is the formula

The following mathematical interpretation describes how Winstone 96 computes a score. To understand the formula, you must first know some standard mathematical notation.

The formula uses the following shorthand math symbols:

�SYMBOL 83 \f "Symbol"�	The Greek letter “sigma” applies to a set of numbers and means “add all the numbers in the set.”

|  |	The symbol “set size” means the number of elements in the set.

The formula uses the following variables:

Ci	the application set for category i, where i is a number 1 through 4.

|Ci|	the number of applications in the category set Ci.

CWi	the market share weight for category i.

AWij	the market share weight for application j within category i.

Tij	the execution time of application j within category i on the test machine.

BTij	the execution time of application j within category i on the base machine.

ASij	the result for application j within category i.

CSi	the category score for category i.

WS	the overall score.

NOTE:	The application and category results Winstone 96 uses in its calculation are the weighted numbers it calculates for each application and each application category.

With these mathematical elements, you can better interpret the formula in the next section.

The Winstone 96 formula� XE "Winstone 96:The formula" �

Winstone 96 uses a unit market-share weight for each category, CWi, where 0 < CWi < 1. Because of the scaling discussed earlier, the market-share weights for all categories total 1. Winstone 96 uses a unit market-share weight for each application within each category i, AWij, where 0 < AWij �SYMBOL 163 \f "Symbol"� 1. Because of the scaling discussed earlier, the market share weights for all applications in each category total 1.

In mathematical notation:

�EMBED Equation ���

and for each category, i:

�EMBED Equation ���

Basically, Winstone 96 computes its score in several steps.

First Winstone 96 derives a number for each application, by computing a ratio between the application’s execution time on the base machine, BTij, and the corresponding time on the test machine, Tij. This score is ASij.

�EMBED Equation ���

Winstone 96 then uses a weighted harmonic mean to combine those application numbers to form a number for each category. For category i:

�EMBED Equation ���

NOTE:	If you’ve run a category suite, Winstone 96 stops at this point.

Winstone 96 uses a weighted harmonic mean to combine the category numbers to form a final number:

�EMBED Equation ���

End of Chapter

�Part 6: �If You Have a Problem

Chapter 20:	� REF Chapter20Troubleshooting \* MERGEFORMAT �Troubleshooting a Problem��Provides some guidelines for troubleshooting problems you may have with Winstone 96.

Chapter 21:	� REF Chapter21GettingHelp \* MERGEFORMAT �Getting Help��Explains how to get technical support.

�Chapter 20: �Troubleshooting a Problem

Normally, Winstone 96 runs without problems. Occasionally, however, you may encounter a problem when you install or run Winstone 96. This chapter gives you some basic information about what to do if you have problems with Winstone 96.

NOTE:	If you have a problem and can’t resolve it after reading this chapter, fill out a Problem Report Form and send it to Winstone 96 Technical Support as described in the next chapter, “� REF Chapter21GettingHelp \* MERGEFORMAT �Getting Help�,” beginning on page � PAGEREF Chapter21GettingHelp �147�. You can find a Problem Report From at the back of this manual, in the Winstone 96 on-line help, and on CompuServe in the ZD Benchmark forum.

Sections in this chapter

� REF _Ref299791524 \* MERGEFORMAT �Common problems�

� REF _Ref333896262 \* MERGEFORMAT �Running multiple sessions of Winstone 96 on a network�

� REF _Ref336760020 \* MERGEFORMAT �Winstone 96 error messages�

Common problems� XE "Winstone 96:Common problems" �� XE "Troubleshooting:Common problems" �� XE "Technical support:Common problems" �

Because Winstone 96 runs several different types of Windows-based applications, you may find you have trouble getting a suite to complete. If you do, something about the test PC or the applications on it is probably conflicting with the Winstone 96 application scripts. You can break down most Winstone 96 problems into three categories—application conflicts, resource shortages, and video driver bugs.

The sections that follow explain each of these categories and describe what you can do if you suspect the problem lies in one of these areas.

Application conflicts

Sometimes applications installed on a PC can conflict with Winstone 96’s applications. Unless the application is running, however, you shouldn’t have problems. You should double check the WIN.INI file and make sure the “run=” and “load=” statements are empty. The Winstone 96 configuration check will also warn you of any applications that are running when you start a suite in the Configuration Information window. (For more information on this window, see Chapter 8, “� REF Chapter8ConfigurationInfoWindow \* MERGEFORMAT �Using the Configuration Information Window�” beginning on page � PAGEREF Chapter8ConfigurationInfoWindow �37�.)

NOTE:	If you have trouble running Winstone 96 with SMARTDrive, use the /U switch. For example, if you list the SMARTDrive command in the PC’s AUTOEXEC.BAT file, make sure you use the /U switch with that command.

C:\DOS\SMARTDRV.EXE /U

	The /U switch keeps SMARTDrive from loading the module that allows for CD drive caching, even if you have a CD drive installed.

Video driver bugs

General protection faults (GPFs) in driver modules are usually due to bugs in the video driver. In addition, driver bugs can cause some applications to crash or hang.

If you suspect video driver bugs are causing Winstone 96’s problems, first try running Winstone 96 with a generic video driver for Windows. If you can run Winstone 96 successfully that way, then you need to consult the vendor who made the video driver card to get a more recent video driver.

If running Winstone 96 with a generic video driver for Windows doesn’t fix the problem, please contact us as described in the next chapter, “� REF Chapter21GettingHelp \* MERGEFORMAT �Getting Help�” beginning on page � PAGEREF Chapter21GettingHelp �147�.

Running Winstone 96 after a failure

If you have a problem with Winstone 96 and need to abort the test run, Winstone 96’s cleanup program will automatically restore the PC to its pretest state when you restart Windows. Once the Winstone 96 cleanup program runs, you can then restart Winstone 96 and run the test suite again.

Running multiple sessions of Winstone 96 on a network� XE "PageMaker and NetWare" �� XE "Winstone 96:PageMaker and NetWare" �

Winstone 96’s copy of Adobe™ PageMaker™ 5.0a for Windows allows only five copies of itself to be running on PCs on a NetWare network at the same time. This restriction is because of Adobe PageMaker for Windows 5.0a’s Network Copy Detection (NCD) mechanism.

If you need to run Winstone 96 on more than five PCs on the same NetWare network, make sure no more than five are running the Winstone 96 Adobe PageMaker for Windows script at the same time. Should Winstone 96 attempt to run its Adobe PageMaker for Windows script on more than five PCs at the same time, Adobe PageMaker for Windows will exit with no warning message.

To alleviate this limitation somewhat, Adobe PageMaker for Windows 5.0a is the first application Winstone 96 runs. If you need to run Winstone 96 on more than five PCs on a NetWare network, you can initially start Winstone 96 on up to five of those PCs. Once any of those PCs has finished the Adobe PageMaker for Windows script and has moved to the next script, you can then start Winstone 96 on another PC. You can continue this process until you have tested all the machines you wish to test. (Adobe PageMaker 5.0a is the only Winstone 96 application with a user limit.)

NOTE:	You can avoid the NCD limitation entirely simply by installing Winstone 96 on the PC’s hard disk and running Winstone 96 when the PC is not logged into the NetWare network.

Before you run Winstone 96 on any PC attached to a NetWare network, you must first prepare the NetWare server for Adobe PageMaker’s NCD mechanism. To configure the NetWare server to run Winstone 96 correctly, you must:

A.	Load the Winstone 96 CD-ROM into the server’s CD-ROM drive or install Winstone 96 on the server’s hard disk.

B.	Log onto the NetWare server as SUPERVISOR from any PC on the network.

C.	Use the Windows File Manager to change to the Winstone 96 directory \ZDBENCH\WS96\APPS on the CD-ROM.

D.	Execute the file WINBUMPS.EXE in that directory.

E.	Enable the NCD mechanism in the WINBUMPS.EXE program by selecting Enable Preferred from the Server menu. You can confirm the setting by using Check Enabled from that same menu.

F.	Exit the WINBUMPS.EXE program.

Once you have prepared the NetWare server, you can begin installing Winstone 96 on PCs you want to test.

Winstone 96 error messages

The following sections explain the different kinds of messages you may receive while running Winstone 96 and generally what may have happened if you see one of these types of messages. If you receive an error message, first follow the instructions on the screen. (Winstone 96 logs all its error messages in a file called ERRORS.TXT in the directory where you installed the benchmark, probably \ZDBENCH\WS96.)

If you continue to have problems, see the next chapter, “� REF Chapter21GettingHelp \* MERGEFORMAT �Getting Help�” beginning on page � PAGEREF Chapter21GettingHelp �147�.

Setup messages

If Winstone 96 has problems during installation, it will display an error message. The message that appears on the screen will explain what happened and what you should do to correct the problem. Problems that can generate a setup error message include a failed installation, an invalid disk drive or path name, or insufficient disk space.

Messages you can receive when using Winstone 96

If Winstone 96 encounters a problem when you open the main window, run a test suite, or use any of Winstone 96’s windows and dialog boxes, it will display an error message. The message that appears on the screen will explain what happened and what you should do to correct the problem. Problems that can generate an error message when you are running Winstone 96 include an invalid command line or directory, no test results to display, or saving unchanged results to the database a second time.

�Low system resources messages

Winstone 96 warns you if the test PC’s resources or memory are too low to run a suite. If you encounter one of these messages:

1.	Exit Winstone 96.

2.	Halt all other applications except Winstone 96.

3.	Restart Windows.

4.	Restart Winstone 96.

5.	Try running the suite again.

Database messages� XE "Database:Messages" �

If Winstone 96 encounters problems while you are working with database files, it will display an error message. The message that appears on the screen will explain what happened and what you should do to correct the problem. For example, if Winstone 96 cannot create a database file, it will display an error message.

Cannot find file messages

If Winstone 96 attempts to find a file that is not accessible, it will display an error message. If you receive one of these messages:

1.	Make sure the file exists.

2.	Make sure you have access to the file and its directory.

3.	Check to see if the file is write protected.

4.	Check to see if the file is corrupt.

Messages concerning paths

If a path Winstone 96 uses is invalid, it will display an error message. The message that appears on the screen will tell you what happened and what you should do to correct the problem. Problems that can generate a path error message include an invalid base or working path or path names that are too long.

Compatibility messages

If Winstone 96 encounters compatibility problems with a library or the operating system, it will issue an error message. In this case, you should:

1.	Make sure the test PC is using the correct version of the operating system.

2.	Reinstall Winstone 96 to assure the PC has the correct libraries.

NOTE:	Winstone 96 doesn’t support OS/2. If you try to run the software on this operating system, you’ll receive an error message.

Screen resolution and font size messages

If Winstone 96 has problems with the test PC’s screen resolution and font size, it will display an error message. The message that appears on the screen will tell you what happened and what you should do to correct the problem. For example, if the PC’s display is smaller than VGA, Winstone 96 will issue an error message.

Corrupt file messages

If Winstone 96’s files become corrupt, the benchmark will issue an error message. If you get one of these messages:

1.	Exit Windows and reboot the PC.

2.	Restart Windows.

3.	Uninstall Winstone 96

4.	Re-install Winstone 96.

5.	Don’t run other applications while running Winstone 96 except Winstone 96.

If you still have problems running Winstone 96, contact us as described in the next chapter.

End of Chapter

�Chapter 21: �Getting Help

This chapter tells you how to contact ZDBOp if you have problems with or questions about Winstone 96. It also explains how to order benchmark documentation and how to request benchmarks.

Sections in this chapter

� REF _Ref296397657 \* MERGEFORMAT �Submitting a problem report�

� REF _Ref296397666 \* MERGEFORMAT �Information we’d like from you�

� REF _Ref336761363 \* MERGEFORMAT �Requesting a benchmark�

Submitting a problem report� XE "Winstone 96:Submitting a problem report" �� XE "Problem report, submitting" �� XE "Technical support:Submitting a problem report" �

If you have problems with Winstone 96, you can report those problems using a Problem Report Form. You can find the Problem Report Form at the back of this manual and on ZD Net/CompuServe Edition in the ZD Benchmark forum.

To submit a report, you can:

Post the form on the ZD Benchmark forum on ZD Net/CompuServe Edition (GO ZDBENCH). Access to CompuServe is available for a fee.

Fax the form directly to Winstone 96 Technical Support (919�380�2879).

Mail the form to us at the following address:

Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, North Carolina 27560�Attn.: Winstone 96 Technical Support

Information we’d like from you

When you have a problem, it’s most helpful to us if you provide the following information:

Exactly what was Winstone 96 doing when the problem occurred (if you know)?

If there were any dialog boxes or messages on the screen, what were they?

When you started the suite, did Winstone 96 display its Warning dialog box? If so, which items in the box where checked.

Can you reproduce the problem?

Can you send us the PC’s Disclosure information?

Can you send us the contents of the Disclosure window and the ERRORS.TXT file? You can fax this information to us or you can include it in a message on ZD Net.

The Problem Report Form provides space for you to answer these questions. If you don’t want to send in a Problem Report Form, please include the above information in any faxes or communications you send to us.

Requesting a benchmark

If you’d like to request copies of Winstone 96 or other Ziff-Davis benchmarks, fill out the Benchmark Request Form at the back of this manual. Then, you can:

Fax it to our dedicated benchmark request fax number (919-380-2879)

Mail it to us at:

Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, North Carolina 27560�Attn.:  Distribution Coordinator

End of Chapter

�Appendix A: �The Database Files

� XE "Results:Database files" �Both WinBench 96 and Winstone 96 write their results to a common file format, .DBF. This commonality means the benchmarks now collect all results in one place (by default, \ZDBENCH\RESULT96.ZDB).

This appendix lists and describes all the database files Winstone 96 creates when you save results to the common database.

NOTE:	You can view the .DBF files Winstone 96 creates from any database application that accepts .DBF or spreadsheet files.

Sections in this appendix

� REF _Ref300459728 \* MERGEFORMAT �Database files Winstone 96 produces�

� REF _Ref303134043 \* MERGEFORMAT �Fields in the WST_DATA.DBF file�

Database files Winstone 96 produces

When you run a suite and save its score to the database, Winstone 96 creates several different types of files. Table A-1 lists all the files Winstone 96 creates when you save results. You’ll find all these files in a database directory.

NOTE:	Each results file has an accompanying index file in FoxPro format. The index files are there to speed up database searches. If you’re using FoxPro to view the .DBF files, then you can use the index files.

�Table A-1:  The files Winstone 96 creates

File�Purpose�Format��COMNSYS.DBF�Stores system information common to all benchmarks. Used to distinguish one machine from another.�dBase��COMNSYS.CDX�Index file for COMNSYS.DBF.�FoxPro��WST_SYS.DBF�Stores benchmark-specific information. Used to identify a set of results collected for the machine identified in COMNSYS.DBF.�dBase��WST_SYS.CDX�Index file for WST_SYS.DBF.�FoxPro��WST_SYS.FPT�Memo file associated with WST_SYS.DBF.�FoxPro��WST_DATA.DBF�Stores all Winstone 96 results.�dBase��WST_DATA.FPT�Memo file associated with WST_DATA.DBF.�FoxPro��WST_DATA.CDX�Index file for WST_DATA.DBF.�FoxPro��Fields in the WST_DATA.DBF file

Table A-2 lists the Winstone 96 result fields as defined in the WST_DATA.DBF results file.

NOTE:	The following list shows the fields as they appear in the results file. If you use a .DBF-compatible application to view this file, that application may show the fields in a different order.

Table A-2:  The WST_DATA.DBF field names

Result:�Result field name:��Description�DESCRIPT��Variant 1�VARIANT1��Variant 2�VARIANT2��Variant 3�VARIANT3��Variant 4�VARIANT4��Variant 5�VARIANT5��PIN�PIN��Project ID�PROJ_ID��Time stamp�TIME_STMP��Benchmark notes�NOTES���

Result:�Result field name:��Business graphics/desktop publishing category score�BG_DTP_CAT��Database category score�DB_CAT��Spreadsheet category score�SS_CAT��Word processing category score�WP_CAT��Overall Winstone score�WINSTONE��End of Appendix

�Appendix B: �The Custom Configuration File

You can use Winstone 96’s configuration check to compare the test PC’s setup and configuration to pre-defined settings in a custom configuration file.

This appendix explains how to create a custom configuration file, how Winstone 96 uses a custom configuration file, and summarizes the command set you can use to build the file. Following the list of available commands, you'll find examples you can modify for a custom file.

Sections in this appendix

� REF _Ref336154992 \* MERGEFORMAT �Creating a custom configuration file�

� REF _Ref336154995 \* MERGEFORMAT �How Winstone 96 uses a custom file�

� REF _Ref336154998 \* MERGEFORMAT �Comments�

� REF _Ref336154999 \* MERGEFORMAT �entry = lines�

� REF _Ref336155001 \* MERGEFORMAT �[section] lines�

� REF _Ref336155002 \* MERGEFORMAT �Functions�

� REF _Ref337613188 \* MERGEFORMAT �Expressions�

� REF _Ref336155009 \* MERGEFORMAT �Examples�

Creating a custom configuration file

Winstone 96 includes a prototype configuration file, SAMPLE.CFG, in the \ZDBENCH\WB96 directory on the CD�ROM.

To create a custom configuration file:

1.	Copy the SAMPLE.CFG file to another file name, such as CUSTOM.CFG.

2.	Edit the new file so it contains the configuration information you want Winstone 96 to check. (The section “� REF _Ref336140506 \* MERGEFORMAT �Functions�” beginning on page � PAGEREF _Ref336140508 �156� provides details on the list of available commands. For a few examples to use as guidelines when you edit the file, see page � PAGEREF _Ref334427900 �159�.)

Once you’ve edited and saved the custom file, you’ll need to load the file during the Winstone 96 session for Winstone 96 to use it during its configuration check (see page � PAGEREF _Ref327694797 �40� for more information).

How Winstone 96 uses a custom file

After you load a custom file, Winstone 96 compares the test PC’s system configuration with the settings in the custom file before each test run.

To increase the speed of execution, Winstone 96 parses the custom configuration file entirely within memory. Thus, a custom configuration file must be less than 64KB in size.

Winstone 96 executes the custom configuration file one line at a time. The file contains five elements:  Comments, Entry = lines, [section] lines, Functions, and Expressions.

The remainder of this appendix describes each of these elements.

Comments

Comments in a custom configuration file explain what each command in the file does. You enter comments in the file using two adjacent slashes (//) at the beginning of the line. The comment can start anywhere on a line and extends until the next new line. Winstone 96 treats double slashes enclosed within quotation marks (“ ”) as part of a literal string and not a comment.

Comments are for your use only; Winstone 96 ignores all text within a comment.

entry = lines

Winstone 96 uses entry = lines to retrieve information from the test PC’s environment variables, the benchmark’s disclosure fields, or the PC’s .INI files. You can specify where the entry = line looks for information by using the #focus( ) function described on page � PAGEREF _Ref336242591 �156�.

All entry = lines have the following general syntax:

entry = [FormatString,] VariableList

Where:

entry is the name of the environment variable, disclosure field, or .INI file entry whose value you want to retrieve. Winstone 96 scans the value of entry as a series of input fields.

FormatString defines a format specifier (similar to the C sscanf( ) function).

The FormatString option recognizes three format specifiers:  %d, %f, and %s. With these three format specifiers the parser can format integers (from -2,147,483,684 to 2,147,483,687), floating point numbers (from 1.7 x 10-308 to 1.7 x 10308), and strings.

You don’t have to specify a FormatString option. If the FormatString is missing, Winstone 96 stores the contents of entry in the one variable you specify. This is useful for reading entire strings, rather than formatting them one token at a time.

VariableList defines where you want Winstone 96 to store the formatted input.

The VariableList option can contain up to 32 variables, separated by commas. Variable names must be unique within the first 31 characters and must follow C rules for naming variables.

Variables are only valid until the next entry = line. The VariableList for each entry = line replaces the VariableList from the previous entry = line.

[section] lines

A [section] line specifies the section Winstone 96 uses when retrieving entries from an .INI file. You can use [section] lines only if the current focus is an .INI file; otherwise, Winstone 96 will issue an error message because it cannot find the .INI file. You can set the focus using the #focus( ) function (see page � PAGEREF _Ref336242622 �156�).

Functions

The following sections discuss the functions you can use to build a custom configuration file.

#if(expression)

You can use the #if(expression) function to check if certain conditions exist on the test PC. You can use the following BOOL operators in the #if function:

&&	numbers only�||	numbers only�==	numbers and strings�!=	numbers and strings�in	strings only�<	numbers and strings�<=	numbers and strings�>	numbers and strings�>=	numbers and strings

For information on variables you can use in the (expression) see the section “� REF _Ref337613188 \* MERGEFORMAT �Expressions�” on page � PAGEREF _Ref336143498 �157�.

#else

The #else function tells the benchmark what to do if the #if function is not true. The #else function is optional.

#endif

The #endif function marks the end of the #if function.

#focus(FOCUS)

�The #focus(FOCUS) function sets the system location where the benchmark retrieves configuration information.

Valid values for FOCUS are:

Disclosure	benchmark disclosure fields�Environment	environment variables�inifile	.INI file name

#text(FormatString[,VariableList])

The #text(FormatString[,VariableList]) function overrides the default text for the previous entry = line. Winstone 96 displays this text in the top portion of the Configuration Information window. The syntax rules for this function are the same as the C printf( ) function except that %d, %f, and %s are the only allowable format specifiers.

#note(FormatString[,VariableList])

The #note(FormatString[,VariableList]) function links a note to the previous entry = line. Winstone 96 displays this note in the Note section of the Configuration Information window when the tester selects the corresponding text message in top portion of that window.

The syntax rules for this function are the same as the C printf( ) function except that %d, %f, and %s are the only allowable format specifiers.

#notify(void)

The #notify(void) function notifies the benchmark of a conflict. When the benchmark receives a #notify function, it displays either a default text message or text specified in the #text function in the Configuration Information window. If the tester supplies a note, the benchmark displays this note in the Note text box.

�Expressions

The general syntax for an expression is:

A operator B

A and B can be any of the following:

A variable name.

A string or numeric constant.

One of the following pre-defined constants:

TRUE	1�FALSE	0�WIN16	TRUE if OS is 16-bit Windows.�WFWG	TRUE if OS is Windows for Workgroups.�WIN95	TRUE if OS is Windows 95.�WINNT	TRUE if OS is Windows NT.�DISKSPACE	Amount of free space on the working drive.�FREEMEM	Amount of free memory.�SYSTEMRAM	Amount of processor RAM.

Another expression.

The operator can be any one of the following:

<	less than�<=	less than or equal to�>	greater than�>=	greater than or equal to�==	equal to�!=	not equal to�&&	logical AND�||	logical OR�in	tests if A is a substring of B

Examples

This section provides examples you can build upon for a custom configuration file (see the SAMPLE.CFG file in the \ZDBENCH\WB96 directory).

Checking DOS environment variables

If you want Winstone 96’s system to check to verify DOS environment variables before it runs a test, you’d use settings similar to the following in the custom configuration file. (Lines beginning with double slashes, “//,” are comment lines.)

// Set the focus to the DOS environment variables.�#focus(Environment)�// Read the "TEMP" variable as a string and store the value�// in ENVVAR.�TEMP = envvar�// If ENVVAR is empty, set NOTE and call NOTIFY to update �// the Configuration Information Window.�#if (envvar != "")�#else�	#note(“You need to set the TEMP environment variable in the AUTOEXEC.BAT file. For example, ‘TEMP=C:\DOS’.”�	#notify()�#endif

Checking entries in WIN.INI

If you want Winstone 96’s system to check to verify entries in the PC’s WIN.INI file before it runs a test, you’d use settings similar to the following in the custom configuration file. (Lines beginning with double slashes, “//,” are comment lines.)

// Set the focus to the WIN.INI file.�#focus("win.ini")�// Set the topic to the [windows] section of the WIN.INI file.�[windows]�// Read the "run" entry in the [windows] section as a �// string and store the value in RUNVAR.�run = runvar�// If RUNVAR is not empty, set NOTE and call NOTIFY to �// update the Configuration Information Window.�#if (runvar != "")�	#note ("The 'run =' line in the WIN.INI file should be empty.")�	#notify()�#endif�// Read the "load" entry in the [windows] section as a �// string and store the value in LOADVAR.�load = loadvar�// If LOADVAR is not empty, set NOTE and call NOTIFY to �// update the Configuration Information Window.�#if (loadvar != "")�	#note ("The 'load =' line in the WIN.INI file should be empty.")�	#notify()�#endif

Checking entries in SYSTEM.INI

If you want Winstone 96’s system to check to verify entries in the PC’s SYSTEM.INI file before it runs a test, you’d use settings similar to the following in the custom configuration file. (Lines beginning with double slashes, “//,” are comment lines.)

// Set the focus to the SYSTEM.INI file.�#focus("system.ini")�// Set the topic to the [boot] section of the SYSTEM.INI �// file.�[boot]�// Read the "shell" entry in the [boot] section as a string �//and store the value in SHELLVAR.�shell = "%s", shellvar�// If SHELLVAR is not equal to "PROGMAN.EXE", set NOTE and �// call NOTIFY.�#if (shellvar != "progman.exe")�	#note("We've only tested Winstone 96 on systems running Windows PROGMAN.EXE as the shell program.")�	#notify()�#endif

End of Appendix
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Application scripts

See Scripts.

Base directory

The base directory is the directory that contains all the files Winstone 96 needs to run its application scripts. The base directory can be on the CD-ROM, on a networked file server, or on the hard disk of the PC you’re testing.

Base machine

You can gauge the overall performance of a PC by comparing its Winstone 96 scores to the scores of the base machine. The base machine for Winstone 96 is a Dell® PC with a 25�MHz Intel® 486SX CPU running Microsoft Windows version 3.1 in enhanced mode. For the vital statistics on the base machine, see page � PAGEREF FactsAboutBaseMachine �106�.

Batch mode

You don’t have to sit at the PC and click the buttons to run Winstone 96’s suites. To make the best use of your time, you may decide to run Winstone 96 in batch mode. When you run Winstone 96 this way, it gets the information it needs to run the suites from a file called RUNWS.INI. This file supplies the environment settings, the names of the tests Winstone 96 will run, and the names for the database files it produces. Winstone 96 includes a prototype RUNWS.INI file in the \ZDBENCH\WS96\UI directory on the CD-ROM.

�Category suite

When you run a category suite, Winstone 96 runs only the applications within that category. Winstone 96 has four category suites:

Database—the scripts for the database applications.

Business Graphics/DTP—the scripts for the business graphics and desktop publishing applications.

Spreadsheet—the scripts for the spreadsheet applications.

Word Processing—the scripts for the word processing applications.

Running any of these suites is fairly simple. Just select the suite name from the list of names in the Functions window and then choose the Run button. That’s all. Winstone 96 does the rest. When Winstone 96 finishes the suite, it automatically displays its scores in the Chart and Table of Results.

Chart of Results

When you run one of Winstone 96’s suites, it automatically displays its scores in the Chart of Results. Winstone 96 displays the name of the suite and a horizontal bar graph showing its score.

You can also add scores for other machines to the Chart of Results. If you do this, then Winstone 96 displays a horizontal bar graph for each machine in the chart. The Chart of Results groups scores together suite by suite. You can display up to five sets of comparison results in this chart.

Disclosure� XE "Disclosure" �

The Disclosure window displays information about a PC’s configuration. You can also view system information about comparison machines from the Disclosure window. To open this window, choose its icon from the Winstone 95 main window or the Disclosure option from the Window menu.

Disclosure Questionnaire� XE "Disclosure Questionnaire" �

When you need to edit Disclosure information, you use Winstone 96’s Disclosure Questionnaire window. This window lets you edit information about a PC’s configuration. To open this window, choose Disclosure Questionnaire... from the Edit menu in the Winstone 96 main menu bar.

Functions window

The Functions window is the portion of Winstone 96’s main window that contains the function buttons. The section “� REF _Ref298751138 \* MERGEFORMAT �Using the Functions buttons�” on page � PAGEREF _Ref298751138 �77� explains what a function button does when you choose it.

Main suite

Winstone 96’s main suite is called “Overall Winstone 96.” When you choose this suite, Winstone 96 runs all its application scripts.

Main window

Winstone 96’s main window is the window that appears when you start the program. The Functions window is inside the main window.

Profiling� XE "Profiling" �

Profiling is a means of monitoring an application as it executes and then recording the subsystem-level operations it performs.

Score

A score is a relative number and is unitless. It is thus meaningful only when you compare it to other scores. When you compare benchmark scores, higher scores mean better performance.

Scripts

Winstone 96’s scripts execute commands within each application Winstone 96 runs.

NOTE:	You don’t need to install the individual applications Winstone 96 uses during a suite. Everything you need, including the relevant portions of the applications, comes with Winstone 96.

Winstone 96 runs one script for each application it tests. When Winstone 96 runs a script, it:

Copies the necessary files for the application from a base directory into a work directory to run the suite. (The base directory contains all the Winstone 96 files.)

Starts the application and sends commands to the application that perform tasks similar to those typical users perform while running the application.

Sends an exit command to the application.

Deletes the application files from the work directory.

Source database

When you merge databases, you must pick a target and source database. The source database is the database from which you wish to get results records.

Suite

A group of Winstone 96 applications you can run by selecting the suite name from the list of suite names to the right of the Run function button. Winstone 96 has five suites:  Overall Winstone 96, Business Graphics/DTP, Database, Spreadsheet, and Word Processing.

Swapping

Windows isn’t limited to the amount of RAM in the PC. If the RAM is full and you ask Windows to load another program, it takes part of some application that isn’t presently running and moves it to the hard disk. If you access that part of the application again, Windows reloads it from the disk into memory. The process is called swapping and the file to which the memory is written is known as a swap file.

If, however, you find Windows swaps a lot of data, it’s a better idea to add more RAM than to increase the swap file size. The swap file, since it’s on the hard disk, will always be slower than RAM. A permanent swap file is better than a temporary one. In either case, it works best when there’s large amounts of contiguous free space on the hard disk. More RAM, though, will always be faster than a swap file.

Table of Results

When you run one of Winstone 96’s tests, it includes the result for that test in the Table of Results. Winstone 96 doesn’t, however, automatically display the Table of Results as it does the Chart of Results. To open this window, choose its icon in the Winstone 96 main window or the Table of Results option in the Window menu.

Information in the Table of Results is in a column format grouped into sets of results by test.

You can add up to five sets of comparison results to the Table of Results. If you do this, Winstone 96 displays the PC’s current results in the first column. Winstone 96 displays results for the comparison machines in the columns that follow the current results. You may need to use the scroll bars to view all the comparison results in the table.

Target database

When you merge databases, you must pick a target and source database. The target database is the database to which you want to add results.

WinBench 96

WinBench 96 is a subsystem-level benchmark that measures the performance of a PC’s graphics, disk, processor, video, and CD�ROM subsystems in a Windows-based environment. WinBench 96’s tests perform many of the same operations applications commonly execute. For WinBench 96, we profiled the same Windows-based applications Winstone 96 uses. These applications cover top-selling Windows product areas, including database, business graphics and desktop publishing, spreadsheet, and word processing.

NOTE:	WinBench 96 doesn’t run actual applications during its tests. Instead, the tests mimic the operations leading Windows-based applications perform.

WinBench 96 returns five main results that provide an overview of a PC’s graphics, disk, processor, and CD�ROM subsystems performance—the Graphics WinMark 96, Disk WinMark 96, the CPUmark�16��� and CPUmark�32�, and the CD-ROM WinMark 96. In addition, the benchmark includes full-motion video tests to measure the PC’s video subsystem performance.

Winstone 96

Winstone 96 is a benchmark that runs test suites of Windows-based applications. In developing Winstone 96’s suites, we did extensive research into which applications are leaders in today’s software market. We also did usability surveys and tests to determine how typical users work with these applications. The result of this research is an accurate and repeatable benchmark you can use to determine a PC’s overall performance when running today’s top-selling Windows�based applications.

Winstone 96 doesn’t mimic applications; it actually runs applications. When you choose one of Winstone 96’s test suites, it runs the application scripts associated with that suite. Each application script starts its application, performs tasks within that application, and exits the application. Winstone 96 times how long it takes each application script to complete and then computes a single, relative score for that test suite. You can compare a PC’s score with the scores of other PCs—higher scores mean faster overall performance.

Work directory

The work directory is the directory where Winstone 96 places the application files it needs while it’s executing a script. Winstone 96 copies the files it needs from the base directory into the work directory. Once the script completes, Winstone 96 deletes the application files from the work directory.

ZDBOp

The Ziff�Davis Benchmark Operation (ZDBOp) is a division of Ziff-Davis Publishing Company. Its mission is to research, develop, and support the publicly available, core benchmarks that all Ziff�Davis publications use.

End of Glossary��Index
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��BENCHMARK REQUEST FORM

Please check the boxes of the products you want:

___	PC Benchmarks CD-ROM containing Winstone® and WinBench® for desktop PCs running Windows®.

___	Server Benchmarks CD-ROM containing NetBench® for file servers and ServerBench® for client/servers (for x86-compatible processors).

___	Macintosh Benchmark CD-ROM containing MacBench® for Mac™ OS Systems.

Please send these products to:

Name: ____________________________________________________________________

Company: _________________________________________________________________

Address: __________________________________________________________________

City: ________________________________ State: _________________ Zip: ___________

Country: __________________________________________________________________

Telephone: ______________________________ FAX: _____________________________

We answer requests in the order we receive them. We ship all benchmarks via 3rd�class U.S Mail. Please allow 4-6 weeks for delivery. For faster shipment, provide your Federal Express account information below:

Your Federal Express account number: __________________________________________

Check one:	___ priority overnight 	___ standard overnight

Please return this form:

Fax to:	(919) 380-2879

or Mail to:	Distribution Coordinator�Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, NC 27560

�Problem Report Form

Information about you:

Name: ____________________________________________________________________

Address: __________________________________________________________________

Company: _________________________________________________________________

E-mail address: _____________________________________________________________

Phone: _______________________________  Fax: ________________________________

Benchmark you’re using: _____________________________________________________

A description of the PC:

Example:	WXY Corp. Model 486DX-66 with 8MB of RAM, 64 KB RAM cache, 200MB hard disk, IDE controller, no hardware disk cache, running Windows 3.1 and DOS 6.0

______________________________________________________________________________________________________________________________________________________________________________________________________________________________

Details of the problem:

What is the problem, and what did the benchmark do just before the problem occurred _____�____________________________________________________________________________________________________________________________________________________

What message was in the status bar at the bottom of the benchmark’s main window _______�__________________________________________________________________________

Can you reproduce the problem? ______

Could you please attach the contents of the benchmark’s Disclosure and the ERRORS.TXT file? (You can find the ERRORS.TXT file in the benchmark’s main directory.)

Other comments: ___________________________________________________________�__________________________________________________________________________

Please return this form:

Fax to:	(919) 380-2879

or Mail to:	Ziff-Davis Benchmark Operation�1001 Aviation Parkway, Suite 400�Morrisville, NC 27560
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*	To reflect the way most users work with Works for Windows, Works for Windows is part of three categories:  Database, Spreadsheet, and Word Processing. To make the performance of Works for Windows have the right amount of effect on each of those three categories, Winstone 96 spreads the weight for Works for Windows across those categories in the following way:  By putting 20% in the Database category, 40% in the Spreadsheet category, and 40% in the Word Processing category.

*	Winstone 96 backs up all system files before it makes changes to them.

*	We didn’t test Winstone 96 on earlier versions of these operating systems. So, we can’t guarantee it will run on them, or, if it does, that the results will be valid.

† 	The exact software and hardware requirements for a PC depend on how you choose to run Winstone 96. For information on the different ways to run Winstone 96, see the figure on the next page.

*	To reflect the way most users work with Works for Windows, Works for Windows is part of three categories:  Database, Spreadsheet, and Word Processing. To make the performance of Works for Windows have the right amount of effect on each of those three categories, Winstone 96 spreads the weight for Works for Windows across those categories in the following way:  By putting 20% in the Database category, 40% in the Spreadsheet category, and 40% in the Word Processing category.
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